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1.1 The PLACE Advanced Development Software
Welcome to the PLACE Advanced Development Software from
ICT, Inc. PLACE (PEEL Logic Architectural Compiler and
Editor) is an enhanced development package that offers complete support for ICT's family of PEEL (Programmable Electrically Erasable Logic) Arrays and Devices.
Below are the two main versions of the PLACE software.
PLACE "Standard Version"
This version of the PLACE software (if the word "Evaluation" is
not specified, the Standard Version is automatically assumed)
provides everything needed to implement complete designs
from architectural entry to the creation of a compiled and simulated JEDEC file for programming. Note that the PLACE Compiler (PLCOM.EXE) is copy-protected and has a limit of three
hard disk installations. The PLACE original disk #1 has an
additional copy-protect key which cannot be installed to the
hard disk. This additional key serves as a back-up.
PLACE "Evaluation Version"
The "Evaluation" version provides all features of the standard
version with the exception of the logic compiler for creating
JEDEC programming files. Complete designs can be entered
and saved allowing you to start designs immediately and see
how the PEEL Array architectures and PLACE software will suit
your logic design needs. Designs created can later be compiled
and simulated on the standard version.
PLACE features
Architectural Editor

PLACE incorporates an innovative architectural editor which
graphically illustrates and controls the architectures, logic
equations, state-diagram and truth-table entries, hence making

ICT, Inc.
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making the overall design easy to understand while allowing for
optimum utilization.
Logic Compiler (Standard version only)

The PLACE compiler performs logic transformation allowing
equations to be specified in most any fashion. The compiler
also features five levels of user-selectable logic reduction (including "auto-demorganization") making it possible to get more
logic into every design.
Logic Simulator

PLACE provides a multi-level logic simulator that lets the external and internal signals be fully simulated, analyzed and edited
via a graphically illustrated waveform display.
Documentation

PLACE designs can be documented through batch printing of
the logic design description, architecture and waveform displays.
Programmer Interface

Programming is supported by a direct interface to the ICT PEEL
Development System programmer, and by other popular
programmers via the serial communication port or by automatically executing the third-party programming software from
within PLACE.

1.2 About This Manual
The PLACE Software manual is organized in seven sections.
Before trying to design with the PLACE software, make sure
you read through the first three sections: "Introduction", "Installation" and "Getting Started". By doing so you will save yourself time.
After you have completed installing the PLACE software and
have become familiar with the basic operations, chapters 4 and
5 "Operation Reference Guide" and "PLACE Design Language
Reference Guide" can be referred to as you implement your
first designs. Documentation describing several application
examples are provided in chapter 6. These examples are also

1-2
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1.3 PEEL Device and PEEL Array support

included on diskette and will automatically be loaded during
installation.
While using this manual and the software you may need to
reference the PEEL Array product specifications. Please make
sure you have a copy of the ICT Data Book.
~

The software operations and features described in this manual
are referenced to PLACE Version 2.10. For additional information on new features and manual corrections, please refer to
the README.DOC file on PLACE disk #1.

1.3 PEEL Device and PEEL Array support
The devices supported in the PLACE software include:

PEEL Arrays
PA7024

PA7140

PA7128

PEEL Devices
PEEL18CV8
PEEL22CV10
PEEL20CG10

PEEL 173
PEEL22CV1 OA
PEEL22CV1 OZ

PEEL273
PEEL22CV1 OA+

Additional devices will be supported in future software versions.

1.4 Converting A PEEL File ".APL" to PLACE File ".PSF"
If you are a current user of the PEEL Device Development
Software (PDS), then your designs done in the APEEL language can be converted to the PLACE design language format
by using the APL2PSF (APL2PSF.EXE) utility. This allows the
PLACE enhanced features available for the PEEL Arrays to be
used to implement designs for the lower density PEEL devices.
The format for the APL2PSF utiltiy is:
APL2PSF

filename

The extension of the filename defaults to ".APL" if not
specified.

ICT, Inc.
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2.0 PLACE Installation
2.1 System Requirements
o IBM PC, XT, AT or compatible
o 512K RAM memory for most designs, 540K for very large designs
o Hercules, EGA or VGA
o A hard disk with 2.6 M-bytes of free disk space (1.6 M-bytes for
program storage and 1M-bytes for operational file storage)
o Microsoft mouse or compatible with driver
o DOS version 3.0 or greater
o (Optional) Expanded Memory Systems with drivers conforming to
the LIM EMS specification version 3.2 or greater

2.2 "Evaluation Version" Hard Disk Installation Procedure
,... Turn the computer on
,... Boot-up DOS 3.0 or greater
,... Install your mouse driver, otherwise PLACE will not boot-up
,... Insert the PLACE Evaluation Software Disk into drive A
,... Select drive A and type "INSTALL" followed by the [ENTER]
key. The install program will guide you to copy all files to a
selected directory on your hard disk. The default drive and
directory is C:\ ICTPLACE. You can enter an alternate drive
and directory by using the [Backspace] or cursor keys
,... Once completed, the program will return to the DOS prompt.
Type "INIT " followed by [ENTER] to initialize the software.
For subsequent use, type "PLACE" followed by [ENTER]
o (Optional) If you wish to enter PLACE from any directory you can do
this by adding the following to your AUTOEXEC.BAT file. Assuming
"ICTPLACE is the directory name and it is in drive C:, you would add
"C:\ICTPLACE" to the your DOS path and insert "SET
ICTPLACE=C:\ICTPLACE"
Ex:Path c:\;c:\DOS;c:\batch;C:\ICTPLACE
Set ICTPLACE=C:\ICTPLACE

ICT, Inc.
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2.3 "Standard Version" Hard Disk Installation Procedure

2.3 "Standard Version" Hard Disk Installation Procedure
The standard PLACE software is provided on multiple diskettes
identified by the disk number. To properly operate the software,
all files from the diskettes must be loaded on to the hard disk
via the following installation procedure.
Please note that disk #1 of the original PLACE software diskette incorporates copy protection. This copy protection allows up to three hard disk installations (note that an
additional un-installable copy-protection key (key disk) will
serve as a back-up). To move the software to a different computer, the un-install procedure must be executed to reinstate
the available number of installations onto the original disk #1.
Please remember if you intend to re-format your hard disk make
sure to un-install PLACE first. If this is not done the copy
protection installation will be lost.
~

The PLACE copy-protect key is made up of two files,
"EV21.SYS" and "EV22.SYS". These hidden system files which
reside in the root directory of the installed drive must not be
(manually) deleted because other application programs may
be utilizing the same copy-protection scheme. The un-install
procedure (section 2.5) should be used to remove the copyprotect key from the installed drive.

Types of Installation
The PLACE "Standard" Version hard disk installation software
provides several options for installing the copy protection key.
Note that each option specified below will copy all the files from
the original PLACE diskettes to the hard disk (the only difference is the type of installation for the copy-protection key).
If you are a first-time PLACE user, we recommend option #4
because it allows PLACE to be run in the most efficient
manner. If you run into a problem with the copy-protection key,
then you may want to try the other options.
• Option 1 : Evaluation Version

- Installs the PLACE Software (Evaluation Version), i.e.
the PLACE Compile operation is disabled.
- No PLACE copy-protect key installation.

2-2
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- The PLACE Install-count will not be decremented, thus
allowing unlimited installations.
• Option 2: Original Floppy Disk #1 as (Copy-Protected) Key Disk

- Installs the PLACE Software (Standard Version). Compile operation is enabled.
- No PLACE copy-protect key installation. Uses the copyprotect key from original disk #1.
- The PLACE Install-count will not be decremented.
- The major disadvantage with this option is the requirement of the original disk #1 to be in the floppy drive
during the PLACE operation changes (i.e. any time the
Compile operation is selected). The frequent access of
the floppy drive slows down the PLACE software. However, unlimited installations can be implemented with
this option.
• Option 3: New Floppy Disk as Key Disk

- Installs the PLACE Software (Standard Version). Compile operation is enabled.
- Installs the PLACE copy-protect key to a blank formatted floppy diskette (3.5/5.25" High or Double-Sided
Densities).
- The PLACE Install-count will be decremented by one.
- Like Option 2, the installed work disk must always be in
the floppy drive during the PLACE operation switching
processes.
- For advantages and disadvantages, refer to the descriptions in Option 2.
- If possible, use option 3 instead of option 2 because
option 2 is designed for use as a backup.
• Option 4: Install Key to Hard Disk

- Installs the PLACE Software (Standard Version). Compile operation is enabled.
- Installs the PLACE copy-protect key to the hard disk.
The hidden system files "EV21.SYS" and "EV22.SYS"

ICT, Inc.
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2.3 "Standard Version" Hard Disk Installation Procedure

which make up the copy-protect key will reside in the
root directory of the installed drive.
- The PLACE Install-count will be decremented by one.
Installation Procedure
- Turn the computer on.
- Boot-up DOS 3.0 or greater.
- Install your mouse driver, otherwise PLACE will not
boot-up.
- (Optional) - Upgrade for existing PLACE users only:
Un-install your current version of PLACE back to the
original disk. Insert original disk #1 into floppy drive A
and type "UNINSTAL" in the PLACE directory on the
hard disk. The un-install procedure removes the existing copy-protect key "EV21.SYS" and "EV22.SYS" from
the hard drive. It should be noted that the PLACE installation procedure will not be hindered if the key
is not removed first. The un-install process is used
merely to recover the Installation-count.
~

Reminder: Note that the copy-protect key files "EV21.SYS" and
"EV22.SYS" should not be manually deleted because you may
be using some other application programs that utilize the same
copy protection scheme.
- Insert the PLACE original disk #1 into drive A. Do not
write-protect this disk.
- At the A> prompt, type "INSTALL" followed by the
[ENTER] key. Note that you can abort the installation
any time by pressing Ctrl-Break. If you abort the installation procedure after the copy-protection key has been
installed to the hard disk, please make sure to
"UNINSTAL" it back to the PLACE original disk #1.
- Type in your company name and address, installation
date, and your name.
- Select your options. Enter the directory you want
PLACE to be installed to. Default drive and directory is
C:\ICTPLACE.

2-4
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- (Optional) - For existing PLACE users only:
If the PLACE installation program senses that the copyprotect key has already been installed on the target
hard drive, then a prompt will appear asking you
whether you want to use the existing key. If you
answered Yes, then the installation will proceed and
the install-count of the PLACE 2.0 will not be decremented. If the answer is. No, the installation procedure
is aborted.
- Once installation is completed, type "INIT" to initialize
the PLACE software. For subsequent use of the PLACE
software, type "PLACE" followed by the [ENTER] key.
CJ

(Optional) If you wish to run PLACE from any directory, you can do
this by adding the following to your AUTOEXEC.BAT file. Assumming "C:\ICTPLACE" is the installed directory, you would add
"C:\ICTPLACE" to your DOS path and insert "SET
ICTPLACE=C:\ICTPLACE".

2.4 Initializing the PLACE Software using "INIT"
After each PLACE installation, it is recommended to initialize
the PLACE software by typing "INIT" followed by the [ENTER]
key in the PLACE directory. The initialization procedure erases
the "PLACE.SAV" file which stores the set-up configurations of
the PLACE software. Once this file is erased, the PLACE
software during boot-up (i.e., by typing "PLACE" followed by
the [ENTER] key) sets all of the configuration variables except
for the color, graphic adapter (VGA only) and mouse type variables to the default conditions.
~

You can re-initialize PLACE any time you run into problems with
the software, or if you want to change the set-up configuration
variables.

VGA Graphic Adapter Option

If a VGA monitor is being used, the PLACE software can be set
to operate using the 640X350 (EGA) or 640X480 (VGA) resolution. In most cases, the VGA resolution is preferred because
the graphics are much cleaner and distinct. The EGA resolution
option is provided in case a problem is encountered using the
VGA resolution. If you are running PLACE for the first time, you

ICT, Inc.
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I

may want to experiment with both options before starting your
designs.

Color Type Option
This option allows the PLACE software to be displayed in 2
(monochrome) or 16-color mode. For Hercules monitors, always select the 2-color mode, i.e. answer "N" for No when
prompted for the color option.

Mouse Type Option
The PLACE software allows multiple mouse cursor types to be
displayed depending on the mode selected (e.g. Edit Eqn, Edit
Arch, Label, and etc.) in the Design operation. For instance, a
left-pointing arrow ("<-") mouse cursor indicates the current
mode is the "Edit Eqn" mode. Figure 2-1 illustrates the different
mouse cursor types found in the Design operation. In addition,
each of the PLACE operations has its own unique mouse cursor.
Standard (Default) cursor used for most functions
or modes.
Design Command Modes such as Label, Copy,
Swap, Erase, Allocate and LCC Re-Assign
modes.
Edit Equation mode.
This cursor indicates that the PLACE software is
set to a "pause" condition, usually for reading
error messages. Press any key or mouse button
to continue.
Figure 2-1, Multiple Mouse Cursor Types

~
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If you are experiencing mouse problems with the multiple cursor mode, it is recommended to select the single cursor type in
the initialization procedure.
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2.5 Un-installing the PLACE software
The un-install procedure allows the PLACE copy-protect key to
be removed from the installed (hard or floppy) drive. Note that
the copy-protect key need not be un-installed when installing an upgrade version with the same PLACE serial number
to the same hard drive. In this case, the same copy-protection
key will be used by the upgrade software. If the serial number
is different, then a new key will be installed. In the latter case,
both the installed and upgrade versions will be functional, i.e.
they both can be un-installed later.
Un-Install Procedure
- Change to the PLACE directory on the installed hard
disk. Example: C>CD\ICTPLACE
- Insert the PLACE original disk #1 of the installed version into drive A. Do not write-protect this diskette.
- Type "UNINSTAL" followed by the ENTER key at the
PLACE directory prompt on the hard disk.
Example: C:\ICTPLACE>UNINSTAL.
- Enter "A" when prompted for the target drive letter.
- If there are no error messages, then the PLACE copyprotect key has been un-installed successfully back to
the original diskette. The resulting PLACE software on
the hard disk is automatically converted to the Evaluation Version, i.e. all PLACE operations are functional
with the exception of the Compile operation.
Un-Install Errors
If an error occurred in the un-install procedure, please note
down the first four digits of the 12-digit error code. Below is an
example of an un-install error.
Security Error 7030-0000-0000

The following table lists the error codes for the un-install procedure.

ICT, Inc.
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Error No.

2.5 Un-installing the PLACE software

Description

7024 .......... Authorization code found, but not for the PLACE
program.
7032 .......... Un-install aborted - PLACE copy-protect key has not
been installed on the target diskette. Please make
sure the target diskette is the PLACE disk #1.
7043 .......... The source disk does not have the copy-protect key
for the current version of the PLACE software.
7061 .......... RESET is not allowed to be run from any disk other
than the PLACE disk #1.
7072 .......... RESET has been run unsuccessful for 1O times. It
can no longer be used on the PLACE disk #1.
Other Errors .... Call ICT Technical Support or Software Department
(408) 434-0678.
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3.0 Getting Started with PLACE
3.1 Entering the PLACE software
Once PLACE is properly installed (i.e. PLACE was initialized by
using "INIT"), it can be entered by typing "PLACE" while in the
ICTPLACE directory. Pressing the ENTER key twice after
typing "PLACE" will bypass the boot-up messages. If you wish
to enter PLACE from any directory, see section 2.2 or 2.3 on
"Hard Disk Installation Procedure". Before using the PLACE
software, please read through the following sections on "Using
the Mouse" and "Getting HELP".

3.2 Using the Mouse

I

The PLACE software and manual will commonly refer to several
mouse actions using the nomenclatures specified in Table 3-1.

Term
Click
Click-A
Click-LH
Click-RH
Click-MH

Mouse Action
press/release the left button of mouse.
press/release the right button of mouse.
press/hold the left button of the mouse
while moving the mouse.
press/hold the right button of the mouse
while moving the mouse.
press/hold the middle button of the mouse
while moving the mouse (3-button
mouse only).

Table 3-1, Nomenclatures for PLACE mouse actions
~

ICT, Inc.

Note that the default mouse cursor is a North-West pointing
Arrow. However, several cursor types (Figure 2-1) may appear
depending on whether option #1 of the mouse cursor types was
selected during the PLACE initialization procedure (section
2.4). or on the type of mode or function that was selected in the
PLACE software.
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"Click" - press/release left button
"Click" is used in all operations and modes to make a selection.
A selection can be made by moving the mouse cursor to the
desired item, and press/release the left button of the mouse. In
many cases this selected item will be highlighted. Items that
can be selected include pop-down and pop-up menu windows,
architectural elements in the design operation such as Logic
Control Cells (LCC), 1/0 Cells (IOC), Input Cells (INC), Global
Cells (GBC), test vector waveforms (Simulate operation) and
etc.
"Click-R" press/release right button
"Click-A" in most cases is used to exit, complete or return from
the current function being performed. In the Design operation,
Click-R is also used to toggle back and forth from the
default "Edit Architecture" mode to the "Edit Equation"
mode.
"Click-LH" or press/hold the left button while moving the mouse
Click-LH is used in both the Design and Simulate operations. In
the Design operation, it is used to scroll from_ one LCC/IOC to
another in the LCC/IOC screen. In the Simulate operation, it is
used for panning in the waveform screen as well as block
selection for the copy, move, and delete functions in the "Edit"
mode.
"Click-RH" and "Click-MH" or press/hold the left and right button
respectively while moving the mouse
For 3-button mouse systems, click-MH (click-RH for 2-button
mouse) is used to display the menu options in the PLACE text
editor utilized in the Design or Program operation. While holding the middle mouse button down (right button for 2-button
mouse), move the mouse cursor and click at the menu option.
Once the option is selected, the middle button can be released.
Mouse support in the PLACE Text Editor
Mouse is supported in the PLACE Text Editors which are used
within the Design, Compile and Program operations. To initiate
the mouse support, press the middle button (3-button mouse)
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3.3 Getting HELP

or right button (2 button mouse) of the mouse but don't release
the button. Move the mouse cursor to the top of the screen to
select the functions. Table 3-2 lists the mouse actions in the
text editor.

Function
Move the text cursor to the
mouse cursor
the top border area
Scroll 6 lines up
the bottom border area Scroll 6 lines down
the first line of the text Scroll 1 line up
the last line of the text Scroll 1 line down
(right button)
Exit editor (3-button)
Access mouse menu
(2-button)
(middle button)
Access mouse menu
(3-button mouse only)

Mouse Action
Click within the text area
Click at
Click at
Click at
Click at
Click-R

Click-M

Table 3-2, PLACE Text Editor Mouse Actions
Re-initializing the mouse in PLACE
In the event a mouse problem is encountered, press the [ESC]
key as many times as needed to exit the current mode or
function to return to the main screen of the operation (Design,
Compile, Simulate, Document and Program). Then, press the
[Alt]-M keys (simultaneously press the [Alternate] and character "M" keys) to re-initialize the mouse.

3.3 Getting HELP
The PLACE software incorporates an on-line HELP feature
which provides information and procedures for most PLACE
functions and modes. To get HELP information, just point the
mouse to the menu function or mode and simultaneously press
the [F1] key . Besides this on-line command HELP, a general
HELP menu is provided in the Utilities pop-down menu.

ICT, Inc.
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3.4 A Guided Tour through the PLACE software
To quicken the learning process, this section discusses some
basic procedures commonly used in the PLACE software. The
device used in this guided tour is the PA7024. So, some of the
terms used in this section may only be applicable to the PA7024
device (or the PEEL Array family of devices). For instance,
terms such as LCC (Logic Control Cell) and GBC (Global Cell)
pertain only to devices in the PEEL Array family.
~

If you are a first-time PLACE user, it is recommended that you
run the PLACE software while reading this section. By actually
performing the instructions (specified in italics), you will be
able to get a more complete understanding of the features,
modes or functions found in the PLACE software.
There are five main operations that can be performed with
PLACE; Design, Compile, Simulate, Document and Program.
When first entering PLACE, it will default to the Design Operation in the edit architecture mode ("Edit Arch"). The display will
show the PA7024 PEEL Array pin block diagram (Figure 3-1 ).

c::::::J

DODO
ODDO
0 0 0 0

~L--F--::1:-----.----1

DODO
DODD
Figure 3-1, The PA7024 Pin Block Diagram screen in the
Design Operation

3-4

ICT, Inc.

3.0 Getting Started with PLACE

3.4 A Guided Tour through the PLACE software

~

Note that PLACE automatically loads the ANEW template file
upon initial boot-up. In Figure 3-1, the PLACE software has
loaded the ANEW file (ANEW7024.PSF) for the PA7024 device.
There is an ANEW template file for each device supported by
the PLACE software. For instance, the ANEW7140.PSF file is
the template file for the PA7140 device. Each ANEW file contains the device's default cell configurations.
At the top of the screen, there are five pop-down menu options:
File, Design, Operations, Utilities and Options (available only
in the Design operation). Move the mouse cursor to the
"Operation" menu. A pop down window will appear showing the
five main operations (Figure 3-2). Note the menu option titled
"Design" to the left of the operation menu. This menu is called
the "command" menu. Each time a new operation is selected,
this command menu will change to allow the selection of commands specific for that operation. The command menu is also
used as an indicator for the current operation.

0

CLKL

1u·at 1on

'~'!'p't\ e • •

Simulate ..
Oooument ..

4

PrograM .•

DODO
ODDO
DODO
ODDO
DODO
6nd

Figure 3-2, The Operations pop-down menu

Move the mouse cursor to the "File" menu option and Click the
"Read" command. A list of the PLACE Source Files (.PSF) will
appear (Figure 3-3). The design examples provided with the
PLACE software include:

ICT, Inc.
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a Multiple-Application Design Example (PA7024, DEM01 A.PSF)
a Basic Gates (PA7024, GATES1 .PSF)
a Basic Registers and Latches (PA7024, REG1 .PSF)
a 8-Bit Counter with Hold, Reset and Preset (PA7024,
COUNTER1 .PSF)
a Bi-Directional 1/0 Port (PA7024, Bl_PORT1 .PSF)
a Bus Programmable Clock Generatormmer (PA7024, TIMER.PSF)
a Blackjack Machine Example (PA7024, JACK7024.PSF)
a Timer/Counter (PA7140, TC7140)
a 4-Bit State Machine with 8-Bit Counter Application (ST7128,
PA7128)
a Basic Gates (18CV8, V8GATES.PSF)
a Basic Registers and Latches (18CV8, V8REGS.PSF)
a Clock Divider and Address Decoder (18CV8, V8CLKADD.PSF)
a Bus Programmable 8-to-1 Multiplexer (18CV8, V8BUSMUX.PSF)
a 8-Bit Counter with Function Controls (18CV8, V8FCNTR.PSF)
a Change-of-state Input Port with Interrupt (18CV8, V8CPORT.PSF)
a Octal Synchronization Circuits (18CV8, V8SYNC.PSF)
a 16-to-4 Priority Encoder (173, PRl173.PSF)
a 8-Bit Up/Down Loadable Counter with Carry-out or Borrow-in
(PEEL22CV10, V1 OCNT8.PSF)
a 9-Bit Even/Odd Parity Generator/Checker (PEEL22CV1 OA,
PARV1 OA.PSF)
a 8-Bit Change-of-State Input Port with Interrupt (PEEL22CV1 OZ,
V1 OZPORT.PSF)
~
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As shown in Figure 3-3, there are two methods of making a
selection from the file menu window.
1. Click to highlight a file or directory, and then click at the
[OK] selector.
2. "Double Click" at the file or directory. The first click
highlights the selection, and the second click makes
selection.
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Current selected drive is
highlighted

CLKl

selects root
directory

llllllii_______

ID!llil!!llllli_ _ _

2961 K-byt;.:e.:.s-='"---..,..,..--=_,....-----,

"Double Click" to

select a file or pop
into a directory. First
click highlights the
selection. Second
click makes the

selects the
next higher
directory
selects th
subdirectory
TEST

Figure 3-3, Reading a demonstration
Click the DEM01A.PSF file. The PLACE Design operation will
once again be displayed, but this time with the DEM01 A
demonstration design file. For more detail information on the
demonstration example files refer to chapter 6 of this manual.
Once the file is loaded, move the mouse to the "Design" menu
option at the top of the screen (Figure 3-4). Click at the "Title"
command. A window will appear on the screen displaying the
title, designer and date of the design. The title of the design can

Figure 3-4, The "Design" command menu

ICT, Inc.
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now be entered by typing in the characters from the keyboard.
Click or press the [ENTER] key to move the cursor to the next
Title field. Click-R or press the [ESC] key to exit this mode.
Move the mouse cursor back to the "Design" menu option and
click the command listed as "Description". The screen will now
display the description of the design (Figure 3-5). Move the
mouse cursor into the displayed window and click the mouse
button. This procedure allows the design description to be
entered or modified by having the PLACE software automatically open the text editor and highlight the text. Press [ESC] to
exit the text editor.

PLACE Deinonstratlon Deslgn fol" PA702""

Thls de:s:l9n ex .. mple lniplements four •pplic•tlons in one PA7021.
GATES
REGS

COUNTER
PORT

Basio oo•binatorial functions: inoludim,;.1 ANO, OR, NOR, NANO, EXOR,
Inverter, 1 to 1 11ullC 1 and 4-bit oo•par1tol".
~r:!~s~·~~:!:~: !~~·~:!~Y!, 0 ~n Ts~"~a~~h f ~ ~~; '~~C:u~!~~g 1 ~~~~~~~~nt
a gated-latch <LATl>, a basio storage register CREGI>, a 2-bit
m•ohin• <S0,S1>, •nd • 1-blt shift re9ister <SHF"B-3).
An B-bl t down counter wl th Hold, Preset .. nd Reset.
An B-bit bi-directional l"'O port Yith 'lfgistered input.

•t•t•

~h~h~~~:h 1 ~p~~!' u~~~E!s ·~~p~~~E~~d~~~t ~~~t ;~f! 1 ~~~! 0 ~ ~~~~~~~ o~. a~! n~s~~·••
as outputs. The outputs of •ach applloatlon •re seleoted vla ei9ht + to l
auxes. Output •n•ble •nd dir-ectlon <in PORT 1111ode) •re selected bi,J CONTROL.

t!f.t!f.,t!f,.t!fu
Click in this window to enter text editor for
entering or modifying the description

Figure 3-5, The "Description" window
~

With a 3-button mouse, click-A exits the text editor and returns
to the previous screen. For the 2-button mouse system, clickRH (press and hold the mouse right button) to allow selection
of the text editor menu at the top of the screen. Then while the
right button is still held down, click at the "ESC" menu option to
exit the editor. Please refer to section 4-14 on "Text Editor
Commands" for more information.
From the pin block diagram screen move the mouse cursor to
the "Design" menu option and click the "Label" command.
Notice that the mouse cursor changes from a North-west pointing Arrow to a Hand cursor (the Hand cursor is available only if
option #1 of the mouse cursor type was selected during the
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PLACE initialization procedure). Now move the cursor to one
of the Logic Control Cells (LCCs), Input/Output Cells (IOCs), or
Input Cells (INCs - PA7140 only) and click the mouse button. A
window will appear displaying the current label (or name).
Figure 3-6 shows the 1/0 cell #2 was selected in the Label
mode. To change the label use the [BACKSPACE] key and type
in the new label followed by the [ENTER] key. The Label
command is used to define all IOCs, INCs and LCCs that are
used in a design.

l/OCell
selected for
labelling

Figure 3-6, The "Label" command forPin, INC, IOC and LCC
~

The architecture of the LCCs, IOCs or INCs can be configured
prior to labelling. However, labels must be specified before the
equations, state-diagrams or truth-tables can be entered.
Please refer to Chapter 4 "Operation Reference Guide" for
options on the "Label" command.

Click-R to exit the "Label" mode and return to the "Edit Arch"
mode. Now, move the cursor to one of the LC Cs. Note that both
the LCC and its interconnected IOC will be highlighted. Click
the mouse to bring up the associated "LCC and JOG Screen".
This screen displays a close-up view of the selected LCC and
its associated IOC configuration.
Select the configuration of the cells by clicking at any of the
"select indicators" (Figure 3-7). With the PA7024 device, over
4000 configurations can be selected by clicking at each of the

ICT, Inc.
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select indicators. Any time the mouse cursor is moved away
from a select indicator, the pop-up window is cleared. Click-LH
(press/hold left mouse button) and move the cursor left and
right or up and down. This allows panning from one cell to
another without returning to the pin block screen. Notice that
the miniature pin block diagram in the upper left corner displays
the current LCC/IOC location.
Global signals routed
from the Global Cell A

LCC name

LRT1
l!I

To Logic

Arrar..1
To Loglo
Array

Click in Sum
gates A, B, C
or D to display
the sum
equation

Select
Indicators

~.OE

•

PO~T

• ,...Control=

"Enable Outpu

PSF Text Display Window - Currently
displaying the sum D equation. Click in
this window to enter the text editor for
modifying the equation

LCC number
Click here to age up and down the
text in the window

Figure 3-7, Configuring the LCC and IOC Architecture
Move the cursor into the "D" OR or Sum-D gate (shown in
Figure 3-7) and click the mouse button. A window displaying
the equation for the selected OR gate will be opened. This
window will be referred to as PSF Text Display Window. The
size of the window can be increased or decreased by pressing
the [Up] or [Down] cursor key, and followed by the [ENTER] key
(refer to Chapter 4 "Operation Reference Guide" for more information on the PSF Text Display window). C/ick-R to close the
display window. To return to the pin block diagram screen,
click-R once again or press the [ESC] key.
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The Global Cell (GBC) configuration can be selected by the
same process, i.e. by clicking the select indicators in the cell
(Figure 3-8).

MOOE:l
MOOE:2

Bnd

El

Click gates to open PSF Text
Display window for displaying
' - - - - - - 1 equations. Click in the windowto edit.

mmmm•••••••

Figure 3-8, Configuring the Global Cell A (GBC) Architecture
~

There are multiple global cells in all PEEL Arrays. For instance,
the PA7024 device has two global cells which are called Global
Cell A and B. The default condition for the PA7024 (and all
PEEL Arrays) is the one global cell mode. The two global cell
mode can be selected by clicking at the "Global = 2" command
found in the "Design" menu window. With two global cells,
Global Cells A and B control global signals for all LCCs connected to the IOCs located on the left (pins 2 to 11) and right
side (pins 14 to 23) of the pin block diagram respectively.
Please refer to the PEEL Array data sheet for more information
on the global cells.

In the pin block screen, move the mouse cursor to the "Design"
Command pop-down menu again. Click the command listed as
"Edit Eqn" for edit equation. Notice that the mouse cursor has
changed to a "<-" (arrow) which is the Edit Equation cursor.
Move the cursor to one of the four inputs of any LCC and the
input wi/I be highlighted. Click to select the input equation. In
Figure 3-9, the PSF Text Display window displaying the sum-C
equation was selected from the third input of the LCC "QO".

ICT, Inc.

3 - 11

3.4 A Guided Tour through the PLACE software

3.0 Getting Started with PLACE

Sele an option
for opening an
additional PSF Text
Display window

Click "Allocated
Block" to edit
state-diagram

AND_I.COH =GATES• A• B •
REGS • 01 +

COUNTER •

QI

C • D •

[..._.._.,_.._.~........_

+

Figure 3-9, Selecting equations from the block diagram screen

Move the mouse cursor to the "Display" option located in the
upper right corner of the screen and click the mouse button.
This opens a window listing the options for opening an additional PSF Text Display window. Move the cursor to highlight the
"Macro Definition" option and click the mouse button. The PSF
Text Display window showing the macro definitions specified in
the design will appear (Figure 3-10).

DErINE
STROBE

= CSI S0J1

GATES
REGS

a

/l1ode2 •
,.Mode2 •

/Model 1

COUNTER •

•

Mod•l 1
Mod•2 • l"Model 1

PORT

11ode2 •

Model I

=

: ;:;: :; : : ;: .-: :,'t:':=.:~

;.:::.]La

•wh•n 1 I then B-bl t Counter

•when l 1 then Bi-di reotional Port

inside the

Figure 3-10, Selecting equations from the block diagram screen
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Move the cursor to the inside of the PSF Text Display window
and click the mouse button. This enters the text editor which is
used for editing boolean equations, state diagram and truth
table syntax. The selected equation will be highlighted (Figure
3-11 ). Note that equations can also be selected for the
LCC/IOC screen by moving the cursor to the one of the four
"Sum" inputs and clicking the mouse button (Figure 3-7). Equations for the Global Cell can also be selected this way (Figure
3-8). Once inside the editor, most of the standard Wordstar™
commands can be used (see Chapter 4 for the command reference information on the text editor). Click-R or press the [ESC]
key to return to the pin block diagram screen again.
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Figure 3-11, Inside the PLACE text editor
After returning from the text editor, the "Edit Eqn" mode is still
selected (indicated by the"<-" mouse cursor). C/ick-R and the
cursor will change back to the default "Edit Architecture" cursor. Click-A will toggle back and forth between Edit Equation
and Edit Architecture for quick access to both modes.
If you have followed the instructions up to this point you have
now familiarized yourself with the basic functions of the Design
operation in the PLACE software. Now, move the cursor to the
"File" menu option and click the "SaveAs" command. The file
window will appear (figure 3-12). Move the cursor to the box
named "NEW" and click the mouse button. Type in the name
"TEMP" or any other new name to save your modified file. If the
file extension is omitted, then it will be defaulted to ".PSF".
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Once your Design file is saved, select the File pop-down window again and read in the "GATES1.PSF" design example.

ANE:l.f7iil"ilil.PSF"
ANE:l.f610. PSF"
ANE:l.fUllll. PSF"
ANE:l.fUllZIA. PSF"
ANE:l.fU10P. PSF"
ANE:l.fUllZIZ.PSF"
ANE:l.fU8, PSF"
BI-PORT.PSI'"

COUNTE:Rl.PSF"

T!~fM':'B:E:ciu27a. PsF"
Bl'ITE:Sl. PSF"
..71'1CK71112-+. PS
..71'1CK71112-+. PSF"
Mfl6273.PS

L

D!EJ

Figure 3-12, Using "SaveAs" to save a new PLACE source file
Move the mouse cursor to the Operations pop-down window
and try selecting the other operations starting with Compile,
Simulate, Document, Program and back to Design. The
screens should look as displayed in Figures 3-13 through 3-16.
For more information on the commands and functions in the
five main operation, please refer to the "Operation Reference
Guide" in Chapter 4.
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Figure 3-13, The Compile Operation Screen (Standard version only)
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Figure 3-14, The Simulate Operation Main Screen
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Figure 3-15, The Simulate Operation "Edit" Screen
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Figure 3-17, The Program Operation Screen (PDS-1 Interface)

3.5 The PLACE Design Process
Starting a new design can be accomplished by selecting the
"New" command in the "File" menu option while in the Design
Operation. This command loads the ANEW file which clears all
of the pin and cell (INC, IOC and LCC) names. Note that when
a cell is cleared, it will be set to its default configuration. Once
this is done a new design can be entered. The following chart
lists the typical procedure for implementing a design using
PLACE. Please use this as a "road map" for implementing your
PLACE designs while referring to the Operation and Language
Reference Guides in Chapters 4 and 5 of this manual.
Design

1.
2.
3.
4.

ICT, Inc.

Select "New" from the "File" menu option.
Enter "Title" and "Description" from the "Design" menu option.
Label all the pins (IOCs and INCs) and LCC (node) names
to be used in the design by using the "Label" command.
Configure the architectures of the INCs, IOCs and LCCs for
the design. Use the "Copy" command to copy or dupli-
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5.

6.

7.

8.
9.

~

3.5 The PLACE Design Process

cate the INC, IOC or LCC configurations if needed. Use
the "Swap" command to move pins, INCs, IOCs and
LCCs for desired positioning.
For state-diagrams and truth-tables, use the "Allocate" command to allocate the labeled IOCs and/or LCCs for the
state machine and truth-table designs.
For boolean equation design entry, select the Edit Equation
("Edit Eqn") mode and enter the equations for each LCC
input. The equation entry can be done via the pin block
or LCC and IOC screen.
Edit or modify the architectures and equations until ready
to compile. Make sure to save the design through the
"File" menu option or by pressing "S (Ctrl-S).
If desired, use the "Swap" command again to reposition the
pin and cell locations.
Pull down the "Operation" menu and select the Compile
operation.

Through out the design process, it is a good practice to periodically save your design. You can do this with the "Save"
function in the "File" pop-down menu or hold the [Ctrl] key down
and press "S" ("S).

Compile (standard version only)

1.

2.

If coming directly from the Design operation (i.e., with the
design file loaded), select the "Compile" command menu
and click the "Run" command. If the design file was not
loaded prior to entering the Compile operation, then
"Read" the appropriate source (.PSF) file from the "File"
menu window.
If a compile error occurs, the compiler will indicate the error
with a message and locate the error in the displayed
source file. You may analyze the error and correct it within the compile operation (by clicking the "Editor" title bar
to enter the editor). You may also return to the Design
operation to correct the error. If the compilation is ok,
proceed to the Simulate operation.

Simulate

1.
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Enter the input pin waveforms using the "Edit" command.
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2.

3.

4.

5.
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Enter expected output wavforms for test verification or use
the "Capture" command in the "Simulate" menu window
to automatically generate the output waveforms.
After simulation, click at the "Status" command to check if
there are any simulation failures. Correct all simulation
failures either by changing the vectors, or by returning to
the Design operation and modifying the design.
Once properly simulated, append the vectors to the JEDEC
file using the "Append test vectors" command from the
"Simulate" menu window.
Save the ".CFG" simulation file using the "File" menu window. Like the design operation, periodically save your
simulation (.CFG) files by pressing "AS". It is recommended to save your first simulation vector file with the
".CFG" file extension. Any vector file can be saved with
the extension ".CFx", where xis an alphanumeric character.

Document

1.

2.
3.

4.
4.

In the Document operation, select the printer type and interface if you are running the PLACE Document operation
for the first-time.
Select the Batch or Single option.
Click in all the desired print options, such as pin block
diagram, PLCC package pinout, cell architectures, simulated waveforms and design texts (such as equations,
state-diagrams or truth-tables).
Once the options are selected, click the "Print" command to
send the documents to the printer.
Save your selections onto your hard disk. The filename will
consists of the root filename with extension ".PRT".

Program

1.

2.

ICT, Inc.

If a JEDEC file exists for your current design, then the
JEDEC file will automatically be loaded upon entering the
Program operation. If the JEDEC file does not exist, then
"Read" the JEDEC file via the "File" menu window.
Select the "Program" command for programming with the
ICT PDS-1 programmer or the "Transmit" command for
down-loading to a third-party programmer via the serial
communication port.
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4.0 Operation Reference Guide
In this section, the features in the PLACE software are discussed in more detail. Sections 4.1 to 4.3 detail the features or
functions that are similar in all PLACE operations. Then, the
features specific to each of the operation are discussed in the
following sections.

4.1 File Menu
The "File" menu option shown in Figure 4-1 provides options for
file maintenance, system information and screen dump to
IBM/Epson printer (additional printer support in Document
operation) via the parallel port. This file menu is similar in all
operations (i.e. Design, Compile, Simulate, Document and Program operations) with the exception of the type of file (see Table
4-1 for PLACE file types) that is read or saved.

II
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Figure 4-1, File Menu Option
New ........... When in Design operation "New" clears the file in memory
and allows device selection for starting a new design.
Loads "ANEWxxxx.PSF" (xxxx =device number) as a
template file. The PLACE software automatically
prevents your edited ANEW file from overwriting the
original file by prompting for a new file name during the
"Save" command.

ICT, Inc.
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Read .......... Allows a PSF source, simulation, documentation or JEDEC
file to be loaded from the current directory in the current
operation (e.g. loads PSF file in Design operation, CFG
in Simulate operation, and etc. - refer to the Table 4-1).
When selected, the File selection window will appear
(Figure 4-2):
- A file can be read by clicking the desired file name and
clicking the [OK] selector. For quick selection, you can
do a "double click", i.e. click twice on the same file
name (first click highlights the file, and the second
click selects the file).
- New drive is selected by clicking the drive letter at the
top of the directory window.
- New directory is selected by clicking the directory
name preceded by a"!", or clicking the"/ .. " (next
higher directory) or"!." (root directory). The selection
action is similar to selecting a file, i.e., click the [OK)
selector or "double click" the selection.
- New file mask can be changed by clicking the file mask
highlighted area and typing in the file mask. Use the
[Backspace] key, cursor keys or the mouse to move the
text cursor. Press the [ENTER) key or click the mouse
when completed. Default is "*.PS*". After the file is
read, the name will appear in the lower left corner of
the pin block screen.

Click to
select drive type

selects root
directory

Current selected drive is
highlighted

-ID!m!ll--lllllllllil_______

296-i K-by t;..;e==s-_,....,__,,,..,..,..~--,

selects the
next higher
directory
selects the
subdirectory
TEST

"Double Click" to
select a file or pop
into a directory.
First click highlights the
selection. Second
click makes the
selection

Selects
highlighted file

Figure 4-2, "Read" file selection screen
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Save .......... Saves the current file to disk. If the file is a new design
(i.e. an ANEW file), then a new file name will be
prompted for.
SaveAs ........ Allows a new file to be saved to the current directory and
disk. Click an existing file to over-write or click [New]
selector to enter a new file name (the "SaveAs" file selection screen is similar to that of the "Read" screen in Figure 4-2 with the exception of the (New] function).
Note that In the Simulate operation If the root name
of the CFG simulation file Is not changed, then the
file will stlll reference the same PSF design file. An
example Is shown below.
DEM01 A.CFG saved as DEM01 A.CF1 - both files
reference the DEM01A.PSF design during simulation.
DEM01 A.CFG saved as DEM01 B.CFG - these files
reference DEM01A.PSF and DEM01B.PSF design
respectively during simulation.
Print Screen .... Sends current screen to the IBM or Epson graphic printer.
For more printer support such as HP Laserjet and
Postscript printers, please refer to the Document operation.
Sys Info ........ Displays system information such as file name, current
directory, memory usage and etc.
User Info ....... (PLACE Standard version only) Displays information about
the user, such as company name and address, user's
name and date of installation.
Quit to DOS .... Quits PLACE program to DOS.

File Extension

Function

PSF

PLACE Source File (PSF) is the design source file
used by the Design and Compile operations.

PS

Back-up file for the PSF design file.

MAP

Output file from the PLACE Compiler. This file
provides detailed information of how the design
equations are mapped into the JEDEC file. This
information may be useful for design debugging.

RED

Output file from the PLACE Optimizer (prior to
fuse mapping) in the Compile operation. This file
contains the reduced or optimized equations in
the sum-of-product form. It maintains the PLACE
design format so that it can be read into the
Design operation for design verification and

Table 4-1, PLACE File Types
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debug, or into the Document operation for
documentation purposes. Note that the unused
equations are omitted, so you will get "Equations
not found" errors in the Design operation.
JED

Output JEDEC file from the PLACE Compiler and
is used by the Simulate and Program operations.

JE

Back-up for the JED file.

INT

Output file from the PLACE Compiler. This file
contains the IOC and LCC interconnects which
are used for the waveform display in the
Simulate operation.

CFG

Primary vector source file for the Simulate
operation. This file contains the data for vector
simulation and waveform display. The PLACE
Simulator simulates the vector in the CFG file
with reference to the PSF design file with the
same root file name. Hence, other file extensions
may be used for the vector source file instead of
CFG. However, we recommend using the CFG
extension for your primary source file
because all PLACE operations automatically
reference to the CFG file during the operation
switching process.

CF(n)

(Recommended ) Alternate vector source file for
the Simulate operation. The character "n" can be
any alphanumeric character except of course
"G". This file extension method is used for the
convenience of displaying all the vector files in
the directory pop-up window, i.e. with the file
mask *.CF*. Remember that the vector source
files with the same root file name reference the
same PSF design file. Example, the
DEM01 A.CFG and DEM01 A.CF1 are vector files
for the DEM01A.PSF design file.

PRT

Input file for the Document operation. This file
contains print selection tags for documenting the
design.

PR

Back-up for the PRT file.

PN1

Default file extension for the output file from the
PLACE Document operation (any file extension
can be used with the exception for those that are
specified in this table). The Document operation
has a "Print to file" option which directs the
screen capture data to this file. This file can then
be sent to the printer using the DOS Copy
command.

Table 4-1, PLACE File Types (Continued)
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4.2 Operation Menu
When an operation is selected from the "Operation" menu (Figure 4-3), the PLACE software automatically loads the proper
input file for the selected operation. For instance, the PSF file is
loaded for the Design and Compile operations, the CFG file for
the Simulate operation, the PRT file for the Document operation,
and JED (JEDEC) file for the Program operation.

CLK1

0

DODO
DODO
DODO
DODO

II

6nd

Figure 4-3, Operation Menu Option
Design ......... Selects Design operation for creating a PSF design source
file. The PSF file (if exists) will automatically be loaded.
Compile ........ Selects Compile operation for compiling the PSF design
source file to create a JED (JEDEC) file for simulation
and programming use. The PSF file (if exists) will automatically be loaded upon entering the Compile operation.
Simulate ....... Selects Simulate operation for creating a CFG vector
source file which can be edited and simulated to the JED
file. The CFG file (if exists) will automatically be loaded.
Document ...... Selects Document operation for documenting the design
via printing the graphic screens and text files. If it exists,
the PRT file will automatically be loaded. If the PRT file
does not exist, then the print selection tags will be set to
the default settings.
Program ....... Selects Program operation for programming a PEEL Array
or PEEL Device with the JED (JEDEC) file. The JED file
(if exists) will automatically be loaded.

ICT, Inc.
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4.3 Utilities Menu

CLK

Point mouse
cursor here and
press [F1] for
HELP

Point mouse
cursor here and
press [F1] for info
on IOC or LCC

c::::::J

DODO
DODD
ODO
DODD
DODD
Figure 4-4, Utilities Menu Option

Help ........... Provides general information on the Help instruction. For
individual Help per command, move the mouse to the
command in the menu window and press the [F1] key.
See Figure 4-4 for additional Help locations.
File Editor ...... Enter the file or text editor. To exit the editor press the
[Esc] key or click-A if using a 3-button mouse. Refer to
the "PLACE Text Editor" section in this chapter for more
information on the editor commands.
DOS Shell ...... Enters a DOS shell. This feature temporarily exits the
PLACE software. Type "EXIT" in the DOS shell to return
to the PLACE software. Upon returning from the DOS
shell, the previous set-up conditions will be restored.
This means that the previous settings and the edited file
is saved to disk and will be loaded automatically into the
PLACE software. If EMS is available, it will be used to
save the settings and file.
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4.4 Design Operation - Design Menu
The "Design" menu contains commands used for implementing
PEEL Array and PEEL Device designs. Note that some design
commands such as "LCC Re-assign" and "Global => 2" commands are only applicable to the PEEL Array designs. The two
cursor types used by some of the commands in the "Design"
menu are the "Left Arrow" and "Hand" cursors .
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Figure 4-5, Design Menu Option
~

In the PLACE software, all commands that are not applicable to
the selected device will be disabled.
Edit Eqn ....... Selects Edit Eqn mode (also selected by clicking-A in
the Edit Arch mode). This mode is identified by the left
arrow mouse cursor(<-) if a 3-button mouse is used. In
the "Edit Eqn" mode (also refer as "Select Sum Equation" mode), there are three ways of entering a logic
description.
1. Equation: Move the cursor to highlight the OR
(Sum) gate, and click to bring the sum equation
out. Note that the equations for each cell are
created by the label command. Hence, all cells
must be labeled prior to selecting their OR gates.
2. State diagram: Move the cursor into the state
diagram box without highlighting any of the OR
gates in the LCC selected for the state diagram
design. Then, click to open the window with the
state diagram syntax. The requirement for designing with the state diagram syntax is that the cells

ICT, Inc.
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3.

(LCCs and IOCs) must be allocated by using the
"Allocate" command.
Truth table: Click at the T(n) labels located at the
bottom of the LCC or IOC to open the window for
displaying the truth table design syntax. Like the
state diagram design, cells used in the truth table
design must first be allocated.

After opening the window to display the design syntax
(this window will be referred to as PSF Dlsplay window), move the cursor into the window and click to
open the text editor for entering and editing the design
syntax. Press the [Esc) key or click-A to exit editor.
Refer to section 4.28 for the text editor commands.
Indicates
"Select Sum Equation"
(Edit Eqn) mode

MC-RCG

CI ick inside theW_._!._.£t=bd---jtt;;;;J'!
"Allocated Block" uT
to edit statediagram

Select an option
for opening an
additional PSF Text
Display window.

Click inside
the window to
edit

Figure 4-6, Edit Equation Mode
Title ........... Allows a title, designer's name and date to be entered into
the source file.
Description ..... Opens a window to display the design description. The
window size can be adjusted by pressing the Up or
Down cursor keys followed by the ENTER key, or using
the "Display" menu (see section 4-6). Paging can be accomplished by clicking at the PgUp or PgDn markers, or
using the PgUp or PgDn keys. To enter the PLACE text
editor for editing, click inside the displayed window.
There is no limitation in terms of the type of characters
you can use for describing your design, just as long as
your description is specified within the reserved words
"DESCRIPTION" and "END_DESC". Note you can use
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the reserved word "DESCRIPTION" but not the word
"END_DESC".
Label .......... Enters the "Label" mode so that any LCC, IOC, INC or pin
can be labeled. After a LCC or IOC is labeled, the equations related to the labeled cell are automatically
generated in the source file (all equations equate to 0) .
The number and type (sum or product equations) of
equations generated depends on the device type and the
configuration of the cell (Table 4-2). In PEEL Arrays,
note that the equations are generated only If both the
LCC and Its associated IOC are previously unused or
unlabeled.
If the label for the LCC or IOC is deleted and its associated cell (IOC or LCC) is unused, then all the equations are automatically deleted.
Below is an example of the four equations generated for
a labeled PA7024 LCC (assume the label is "!TEST").

Example:
Cont1gurat1on
D-type flip-flop
Async. Preset
Async. Reset
Assigned IOC
is an 1/0 type

Equations generated
!TEST.D = O;
!TEST.AP = O;
!TEST.AR= O;
!TEST.OE= O;

I

Assume that the flip-flop's output of the LCC is
connected to the IOC.

PEEL Device

Number of equations per IOC

18CV8, 22CV1 O
22CV1 OZ, 22CG10,
22CV1 OA/A+,
173

1 sum equation, 1 product equation

273

2 sum equations

PEEL Array

Number of equations per LCC/IOC pair

PA7024, PA7140
PA7128

4 sum equations

Table 4-2, Number of Equations per IOC or LCC/IOC pair

ICT, Inc.
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Copy ........... Copies the selected LCC's, IOC's or INC's configuration into
another cell. This will not copy the equations. Select the
"Multiple" option in the Copy Type window for doing multiple copying (Figure 4-7), i.e. copying from one cell into
many cells. Select "Done" to complete the current "Multiple" copying set and to start another. The only restriction
in the "Copy" mode is that the source and target cells
must be of the same type, i.e. LCC to LCC, IOC to IOC
and INC to INC.
Swap .......... This mode allows swapping of LCCs, IOCs, INCs or pins to
reorganize your design. The functions of the cells do not
change. There are two restrictions when swapping the
two cells.
1. Both the source and target cells must be of the
same type, i.e. LCC with another LCC, IOC with
another IOC, and INC with another INC.
2. For PEEL Arrays, the swapping of IOCs or LCCs are
not permitted if the two global cell mode is used and
if one of the following is true: a) the cells that are
being swapped are IOCs which are located on the
opposite sides of the pin block diagram; orb) the
cells that are being swapped are LCCs which are
connected to IOCs that are located on the opposite
sides of the pin block diagram.
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Displays the source
and current target
cell
--.1::---

Figure 4-7, Copy Mode
Clear .......... Clears the LCC, IOC or INC. This sets a default
configuration to the cells and re-name the sum output
names to the new configuration. After clearing both the
LCC and its assigned IOC, then all the sum equations associated with this cell are deleted.
Allocate ........ Allocates the LCC or IOC for state-machine or truth table
design. Before the cell can be used for allocation, it must
first be labeled. This mode also allows a state-machine
or truth table design to be created, deleted or modified.
For state-machine design, the allocated cells will be surrounded by a border. For truth table design, the allocated cells will be indicated by "In" and "Tn" (inputs and
outputs respectively), where n ranges from 1 to 10. Note
that only the outputs of the truth table ("Tn") will be
marked after exiting the "Allocate" mode. See sections
4.10 and 4.11 for detailed descriptions of the state
diagram and truth table designs.
Macro ......... Displays the macro definitions in the PSF design file.
Macro definitions are text statements which succeed the
keyword "DEFINE" but precede one of the following
reserved words: STATE_DIAGRAM; TRUTH_TABLE; or
EQUATIONS. The size of the window follows the number
of lines set for the Option Display window option in the
"Display" menu (refer to section 4-12). The window size
can be adjusted by pressing the Up or Down cursor keys
followed by the ENTER key, or using the "Display" menu.
Paging can be accomplished by clicking at the PgUp or
PgDn markers, or using the Pg Up or PgDn keys. To

ICT, Inc.
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enter the PLACE text editor, click inside the displayed
window.

Auxiliary ........ Additional functions such as Security Bit, Signature and
Zero-Power options which are found in the Peel Arrays
and in some PEEL devices. Below is a brief description
of each function but you should refer to the ICT data
book for more information.
Security Bit - Setting this feature ON enables the
security bit to be programmed on the device (inserts the
"G1" field in the JED EC file). Once the security bit has
been programmed, the design programmed into the
device cannot be read back (except for the Signature
Word). All PEEL products provide the security bit feature
except for the PEEL 173 devices.
Signature Word - The Signature Word of the device allows a user ID to be stored in the device so that it can
be read back for design verification even after the
security bit has been programmed. Devices with the Signature Word (number of 8-bit bytes in parenthesis) are
PA7024 (8 bytes), PA7140 (2 bytes), PA7128 (1 byte),
PEEL22CV1 OZ (3 bytes), PEEL22CV1 OA+ (3 bytes), and
PEEL273 (2 bytes).

Example:

Signature

=

ABC [ENTER]
(converts the characters A, B, C
to the ASCII values 65, 66 and
67 respectively. Each character
requires an 8-bit byte)

Zero-Power - When the Zero-Power bit of the device is
set to ON, the device goes to "sleep" in which a low
standby current condition is entered. This feature is available only in the PEEL22CV10Z device. For more updated information on the current consumed, timing and
other restrictions, please refer to the PEEL22CV1 OZ
data sheet.

LCC Re-Assign .. (PEEL Arrays only) Allows the two internal and external outputs of the LCC to be separated and re-assigned. Below
lists the requirements for re-assigning the LCC.
1) The IOCs and LCCs of both source and target cells
must be labeled.
2) The internal and external LCC outputs must not be
sharing the same sum term, i.e they must be from
separate sum terms.
3) All sum terms must be used, i.e. the output equation
extensions must not contain the ".SUMx" extension where x = A .. D for sums A through D.
4) The source and target LCCs must have the same
configurations prior to the re-assignment. Use the
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"Copy" function to copy the configurations of the
LCC (and possibly the IOC too) from the source to
the target cell. All LCCs and IOCs can be re-configured later for your specific application requirements.

Example:
Figure 4-8 illustrates a typical example which requires
the LCC re-assignment feature. In this example, a
design modification is required to make the output "TESTOUT" synchronous with the clock "CK1 ". Currently, the
output "TESTOUT" is a combinatorial output. This output
would need to become a registered output in order to be
synchronous with the clock "CK1". The problem is that
the register in the LCC associated with this output is already being used for another function. The internal output "IN" for the LCC 3C can be duplicated by copying the
configuration of the LCC 3C into an empty LCC and
retyping the equations. However, a faster method is to
use the "LCC Re-Assign" command which separates the
output "IN" from the LCC 3C and re-assigns it to another
IOC with an unused LCC (LCC 4C or 58).
The procedure for re-assignning the internal output "IN"
in LCC 3C is as follows:
1) Change the configuration of the LCC 3C and IOC
"TESTIN" so that all the sum terms are used. In
this example, set the IOC "TESTIN" to an 1/0 type
instead of input only.
2) Label the LCC 4C which will be the target cell.
3) Copy the cell configurations, using the LCC 3C "IN"
and IOC "TESTIN" as the source cells. The target

lllllmll. .mil!I

The internal output "IN"
of LCC 3C needs to be

. . . . . . . . .m.!11.
configured as input only,
so its associated LCC
(LCC 4C) is unused

TCSTOUT

CARCOUT
9nd

A design modication requires that
TESTOUT be a registered output
~---t instead of a combinatorial output.

[T

Ki

Figure 4-8, A typical example for re-assignning the LCC
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4.4 Design Operation - Design Menu

cells will be the newly labeled LCC 4C and the
IOC "TESTOUT".
4) Select the "LCC Re-Assign" command and click the
source and target LCC (LCC 3C and 4C respectively).
5) Re-configure all the cells (both source and target
LCCs and IOCs) for their specific application requirements, i.e. IOC "TESTIN" to input only, IOC
"TESTOUT" to output only, and etc.
Global ......... Toggles between the one or two global cell mode. If two
global cells are used, swapping is not allowed with IOCs
that are located on the left and right sides of the device,
or with LCCs which are associated with IOCs that are located on the left and right sides of the device. This feature allows the device to be separated into two parts with
each part containing its own high speed clock. Please
refer to the ICT data book for more information on the
benefits of the one and two global cell modes.
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4.5 Design Operation - Pin Block Diagram Screen
The default function for the pin block diagram screen is the Edit
Architecture mode (Edit Arch). This mode is automatically set
when the PLACE software is initially entered. It allows selection
of the Logic Control Cells (LCCs), 1/0 Cells (IOCs), Input Cells
(INCs) or Global Cells (GBCs) for controlling cell configurations.
Global Cell (GBC)

c:::J

0000
2 0000
~-!"""""I" 3 0 0 0 0 ...--!=..1.-F'---t_
4 0000
0000
1

.,t::..___;._:.__;:._____.;

5

A

B

c

I

D

Figure 4-9, Pin Block Diagram of the PA7024

Figure 4-10, Pin Block Diagram of the PEEL22CV1 OA

ICT, Inc.
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4.5 Design Operation - Pin Block Diagram Screen

CLKI

Current pinout is
PLCC configuration.
Allows user to implement designs in DIP
or PLCC pinout
configuration.

oo~oo

DODO
DOD
Gnd

Figure 4-11, Pin Block Diagram of the PA7140
The PA7140 pin block diagram shown in Figure 4-11 illustrates
the PLCC pinout configuration. For the PA7140 device, the
PLCC pinout is the default configuration because this device is
available in the PLCC package only. As for devices with
availability in both the DIP and PLCC packages, the DIP (default
configuration) or PLCC pinout configuration can be set in the
"Options" menu. Refer to section 4-13 for more information on
the "Options" menu.
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4.6 Design Operation - LCC and ICC Screen
If a Logic Control Cell (LCC) or 1/0 Cell (IOC) is selected from
the pin block diagram screen, the screen zooms into the
selected cell for a close-up view of the cell configurations (Figure 4-11 ). Note that both the LCC and its currently connected
IOC are displayed. In this screen, selections can be accomplished by moving the mouse cursor to the "selectors" such
as the registers "rectangle", polarity "bubble", OR gates, or the
"Smile Face" selectors. Except for the OR gate, all of the above
selectors are highlighted when selected and are used for controlling the cell configurations.
Selecting any of the four OR gates will display its associated
equation. Move the cursor inside the equation window and click
to enter text editor. Click-R to return from editor, to complete the
selected mode or function, or to return to the block diagram
screen.

L~T1

II
To Logia
Rt"t"ay
To Logic
Plr'"r-ay

Click in Sum
gates A, B, C
or D to display the sum
equation

Select
Indicators

PSF Text Display Window - Currently ,....,....Lc=-c,,,_-n1-u-m.,..be_r_,
displaying the sum D equation. Click
inside this window to enter the text
Click here t
editor for modifying the equation

Figure 4-12, LCC and IOC screen of the PA7024
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Select Indicators in PEEL Arrays (PA7024, PA7140 and PA7128)
Below are the descriptions of the "select indicators" found in all
PEEL Arrays. Unless specified otherwise, all "select indicators"
are applicable for all the PEEL Array devices.
Clk (Clock) Select
/Global

Global
Sum-C

Sum-D

Inverted clock signal from the Global Cell A or B. If the two
global cell mode is used, then LCCs connected to IOCs on
the left and right sides of the pin block diagram are controlled by Global Cells A and B respectively. For one global cell
mode, all global signals are routed from Global Cell A.
Default configuration. Non-inverted clock signal from the
Global Cell A or 8.
Clock signal from the Sum-C gate. The Reset signal for the
LCC register will automatically be routed from the Global
Cell A or B if it was originally connected to the Sum-C gate.
Clock signal from the Sum-D gate. If the IOC connected to the
LCC is an 1/0 type, then the output will be disabled. If the
IOC is an output type, then it will remain as an output type
with only combinatorial feedback from the pin.

RT (Register Type) Control
Off

On

Default configuration. Sets the dynamic register control to
Off. This means that any signal on the RT line (RTA or RTB
equation in the PSF file) will not implement a dynamic
register change.
Sets the dynamic register control to On. A TRUE logic on the
RTA or RTB equation (in the PSF file) changes the type of
register in the LCC during normal operation. For instance, if
RT is "On" and Register Type is "D -> T", then the D-type
register will be changed to a T-type register when the logic
on the RTA equation is TRUE. For the one global cell
mode, the RTA equation controls the RT signals in all
LCCs. For the two global cell mode, the RTA and RTB equations control the RT signals of the LCCs which are connected to IOCs on the left and right sides of the pin block
diagram respectively.

Register Type
If RT is Off:
D

T

JK

4-20

Default configuration. D-type register. Reset and preset of
the register can be locally (through the sum B or C gate) or
globally (ResetA or PresetA equation) controlled.
T-type register. Reset and preset of the register can be
locally (through the sum B or C gate) or globally (ResetA or
PresetA equation) controlled.
JK register. Sum-A for the J-input, and Sum-B for the K-input.
Reset can be controlled locally or globally, but the preset
will automatically be set to global preset.

ICT, Inc.
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IF RT is On:

D ·> JK

JK-> D

Default configuration. D-type register when the RT signal is
FALSE, and T-type register when it is TRUE. Reset and
preset can be locally or globally controlled.
D-type register when the RT signal is FALSE, and JK-type
register when it is TRUE. For the JK-type register, Sum-A is
used for the J-input, and Sum-8 for the K-input. Reset can
be controlled locally or globally, but the preset will automatically be set to global preset.
T-type register when the RT signal is FALSE, and D-type
register when it is TRUE. Reset and preset can be locally
or globally controlled.
JK-type register when the RT signal is FALSE, and D-type
register when it is TRUE. For the JK-type register, Sum-A is
used for the J-input, and Sum-8 for the K-input. Reset can
be controlled locally or globally, but the preset will automatically be set to global preset.

~ Note that the Sum-8 gate cannot be used for both K-input and preset for the

register.

Preset and Reset for the LCC Register
The output of the LCC register is set to a HIGH signal when the
preset signal is TRUE. On the other hand, the output of the
register goes LOW if the reset signal is TRUE. If both the
preset and reset signals are TRUE, then the preset signal
takes precedence over the reset signal.
There is no dedicated MUX for controlling the preset or reset of
the LCC register. Both of these signals are indirectly controlled
by the "Clk Select", "Register Type", "Buried Output" and "Ext
Output" selections. The same Sum (OR) gate allocated for any
of the above configurations cannot be used for presetting
or resetting the LCC register. So, the PLACE software automatically switches the preset or reset to the global signal when
the local sum gate is used.
Buried Output (Internal Output of the LCC)
Reg-Q
Sum-A
Sum-B

Sum-C

ICT, Inc.

Default configuration Connects the output of the LCC
register to the internal or buried output of the LCC.
Connects the Sum-A gate to the internal or buried output of
the LCC.
Connects the Sum-8 gate to the internal or buried output of
the LCC. If the preset of the register is locally controlled
(through Sum-8), it will automatically be set to global
preset.
Connects the Sum-C gate to the internal or buried output of
the LCC. If the reset of the register is locally controlled
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(through Sum-C), it will automatically be set to global
preset.

Ext Output (External Output of the LCC to the IOC)
Reg-Q
Sum-A
Sum·B
Sum·C

Default configuration. Connects the output of the LCC
register to the external output of the LCC.
Connects the Sum-A gate to the external output of the LCC.
Connects the Sum-B gate to the external output of the LCC.
If the preset of the register is locally controlled (through
Sum-B), it will automatically be set to global preset.
Connects the Sum-C gate to the external output of the LCC.
If the reset of the register is locally controlled (through SumC), it will automatically be set to global preset.

OE (Output Enable) Select
1/0

Input
Output

Default configuration. Sets the IOC to 1/0 type. Sum-D is
used for the output enable control. If the LCC Clk Select is
set to Sum-D, the IOC changes from the 1/0 to input type
automatically.
Sets the IOC to input type. If Sum-D is not used for the LCC
clock, then it will be disabled.
Sets the IOC to output type. If Sum-D is used for the LCC
clock, then the Feedback Type will automatically be set to
combinational.

Feedback Type
In the normal configuration, whether the IOC is an 110, input or
output type, this multiplexer controls the path from the pin.
However in the PA7140 and PA7128 devices, the option "FB
Mux" allows the path to come from the Sum-D gate.
Com
Reg
Lat

Default configuration. Combinatorial path from the pin or
Sum-D.
Registered path from the pin or Sum-D. The clock for the
register can be directly from the CLK1 or CLK2 pin, or
PCLK product term.
Latched path from the pin or Sum-D. The latch trigger can be
directly from the CLK1 or CLK2 pin, or PCLK product term.

Out (Output) Polarity
Invert
Non-Invert

Inverts the output to the pin for active Low output.
Default configuration. Non-inverted output for active High
output.

FB Mux (PA7140 and PA7128 only)
Pin
Sum·D

4-22

Default configuration. Sets the feedback path to come from
the pin.
Sets the feedback path to come from the Sum-D gate. With
this configuration, the IOC automatically becomes an output pin with no feedback from the pin. This means that the
Sum-D signal will be buried. See Figure 4-13.
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Feedback Type MUX for
selecting combinatorial,
registered or latched
feedback.

~-+--+---ID

P

Qt--~-.

To Logic

Arr-a1a1

To LOQlC
Array

II

FB Mux which allows the sum-D to be buried and
fedback to the array. This feature is available only for
the "Output" configuration in the "OE Select" MUX.

Figure 4-13, LCC and IOC screen of the PA7140
Select Indicators in the PEEL Devices
Global signals
CLK

Click at AND
Aor Sum B
gate to
display the
equation

SP

Q!5

IOC name
To ANO
Ar,..ay

PSF Text Display Window - Currently displaying the
sum B equation. Click inside this window to enter the
text editor for modifying the equation

Figure 4-14, IOC screen of the PEEL22CV1 OA
Output Select (All devices except PEEL 173 and 273)
Com

ICT, Inc.

Default configuration. Sets the IOC to combinatorial output.
In the PEEL22CV10 and 22CV1 OA devices, the feedback
path is automatically set to come from the pin with this configuration. For other devices such as PEEL 18CV8 and
22CV1 OZ, the feedback path is controlled by the "Feedback
Type" MUX.
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Sets the IOC to registered output. In the PEEL22CV10 and
22CV1 OA devices, the feedback path is automatically set to
come from the Q of the register with this configuration. The
register is triggered on the rising-edge of the clock.

OE (Output Enable) Select
1/0

Output Enabled
Output Disabled

Default configuration. Sets the IOC to 110 type.
Depending on the device, a sum or product term controls
the output enable term.
Enables the output in the IOC.
Disables the output in the IOC.

Out (Output) Polarity
Invert
Non-invert

Default configuration. Inverts the output to get an active
Low output.
Buffers the active High output.

Feedback Select (18CV8, 20CG10, 22CV10Z and 22CV10A+)
Pin
Reg
Or

Feedback path from the pin.
_
Feedback path from the Q (PEEL 18CV8 only) or Q (all other
devices) of the register.
Feedback from the OR gate, i.e. prior to the register and
output buffer.

Global Asynchronous Reset and Synchronous Preset in PEEL
Devices (except PEEL173 and 273)
In all registered PEEL devices, the IOC (or macro cell) register
can be reset or preset using an internal reset or preset product
term. The PLACE software automatically assigns node numbers
for both product terms.
When the reset product term is TRUE, the output of the register
in the IOC (or Macrocell) is set to a LOW signal asynchronously.
For 20-pln devices, the asynchronous reset node number is
21, and for 24-pin devices the node number Is 25.
When the preset product term is TRUE, the output of the register
in the IOC changes to a HIGH signal (synchronously) with the
rising-edge of the clock signal. The node number for the
preset product term is 22 and 26 for the 20 and 24-pin
devices respectively.
When both the reset and preset signals are TRUE, then the
reset signal takes precedence over the preset signal.

4-24

ICT, Inc.

4.7 Design Operation - Input Cell (INC) for PA7140 and PA7128

4.0 Operation Reference Guide

4.7 Design Operation - Input Cell (INC) for PA7140 and
PA7128
In addition to the IOCs and LCCs, the PA7140 and PA7128 have
Input Cells (INCs). Each INC allows the input to be configured
as combinational, registered or latched input (Figure 4-15).
INC
screen

0
0

0

DODO
DODO
ODO

II

Gnd

Figure 4-15, INC screen of the PA7140
Input Type
Com
Reg
Lat

ICT, Inc.

Default configuration. Sets the input to be combinational.
Sets the input to be registered. The clock for the register is
controlled by the Global Cell C.
Sets the input to be latched. The trigger for the latch is
controlled by the Global Cell C.

4-25

4.0 Operation Reference Guide

4.8 Design Operation - Global Cell (GBC) for PEEL Arrays

4.8 Design Operation - Global Cell (GBC) for PEEL Arrays

Click gates to display equations. Click
inside window to edit equation.

Figure 4-16, Global Cell A screen of the PA7024
Global Cells A and B
In PEEL Arrays, the Global Cells (GBCs) A and B which are
located at the top of the pin block diagram are used to control
the global signals for the LCC and IOC. These global signals
include the clock for the LCC and IOC, and preset, reset and
register type control for the LCC.
After clicking the GBC to bring the Global Cell window up for
selection, click at the MUX "rectangle" to set the desired clock
selection for the LCCs and IOCs. The IOC clock polarity is
controlled by the "Clock Polarity" select indicator. Click at the
AND or OR (Sum) gates to display the global equations for
register-type, PCLK, global reset or preset. Move the cursor
inside the equation window and click the mouse to enter the text
editor. In the text editor , press the [Esc] key or click-A to return
to the global cell window. The same procedure can be used in
the one or two global cell mode.
In the one global cell mode, the Global Cell A controls the
global signals to all the LCCs and IOCs in the device (Global
Cell B is ignored). In the two global cell mode, Global Cell A
controls the global signals to the LCCs and its associated
IOCs that are located on the left side of the pin block
diagram. Global Cell B controls the global signals to the
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remaining LCCs and IOCs which are located on the right
side of the pin block diagram.
Global Signals
LCC Clock
IOC Clock

LCC Pre

LCC RT

LCC Res

This signal clocks the register in the LCCs. The signal comes
from one of the two dedicated clock pins, CLK1 or CLK2.
This signal clocks the register in the IOCs. In addition to the
two dedicated clock pins CLK1 and CLK2, the signal can
come from a product term PCLKA (GBC A) or PCLKB (GBC
8). The select indicator "Clock Polarity" allows the IOC
clock polarity to be changed. The default configuration is
"Pos" which means that the IOC register or latch is triggered on the rising-edge or HIGH signal. If the configuration is set to "Neg'', then the register or latch is triggered on
the falling-edge or LOW signal.
This sum (OR) term is the global preset for the LCC register.
The LCC register is preset to a HIGH signal when this sum
term is TRUE. This term takes precedence over the reset
term for the LCC register.
This product term is the global register-type change for the
LCC. Each LCC has the option ("RT Control") of enabling
the dynamic register-type change when this term is TRUE.
This sum (OR) term is the global reset for the LCC register.
The LCC register is reset to a LOW signal when this sum
term is TRUE.

Global Cell C (PA7140 and PA7128 only)
In addition to Global Cells A and B, the PA7140 and PA7128
have Global Cell C. This cell which is located at the bottom of
the pin block diagram controls the global clock signal for the
Input Cells (INCs).

CLKI

Click gate to display PCLKC equation.
Click inside window to edit equation.

Figure 4-17, Global Cell C screen of the PA7140

ICT, Inc.
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4.9 Design Operation - Entering Equations
One of the primary methods of entering the design equations is
via the "Edit Eqn" mode which was discussed in section 4.4.
Figures 4-18 and 4-19 shows the "Edit Eqn" mode for the
PA7Q24 and PEEL22CV1 QA devices respectively.
Indicates
"Select Sum Equation"
(Edit Eqn) mode

MODEl
MOOE2

2

Select an option
for opening an
additional PSF Text
Display window

D
E

Click inside
the window to
edit

F

Figure 4-18, "Edit Eqn" mode of the PA7Q24

Click RAND
gate for
asychronous
reset equation

Select an option
for opening an
additional PSF Text
Display window

gate for
sychronous
preset equation

Figure 4-19, "Edit Eqn" mode of the PEEL22CV1 QA
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4.9 Design Operation - Entering Equations

In addition to the "Edit Eqn" mode, equations can also be edited
via the LCC and IOC screen (or just IOC screen for the PEEL
devices). Refer to Figures 4-20 and 4-21.
LCC name
Preset A Reset A

Lfl'IT1

To Logic
At"t".ay

l!l

l!l----

1'-~~~---~ ~---+--~D

Click in Sum
gates A, B, C
or D to display the sum
equation

p

Q

l!l'---<::t>

Click here to page up and down
the texts in the window
l'!I

Lo io Control Cell 3A
A.OE• PORT• /Control=

"Enable Outpu

PSF Text Display Window - Currently
displaying the sum D equation. Click
inside this window to enter the text
editor for modifying the equation

LCC number

ber and name

Figure 4-20, Editing equations in the LCC and IOC screen of
the PA7024
Global signals
Displays
location of
IOC

CLK

SP

AC

Q5

IOC name
PSF Text Display Window - Currently displaying the
sum B equation. Click inside this window to enter the
text editor for modifying the equation

Figure 4-21, Editing equations in the IOC screen of the
PEEL22CV1 OA
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4.9 Design Operation - Entering Equations

For editing equations for the global signals in the PEEL Arrays,
please refer to section 4.8 on "Global Cells for PEEL Arrays".
After the cell (LCC or IOC) is labeled using the "Label" command
in the "Design" menu window, the PLACE software automatically
generates the equations. To edit or modify these equations, first,
click at the desired OR (sum) or AND (product) gate to bring the
equations out in PSF Text Display window (section 4.12). Then,
click inside the window to enter the text editor. When you are
done editing the equations, press the [Esc] key or click-A to
return to the previous screen. Whether the device is a PA7024,
PEEL22CV1 OA or any other device, the procedure for entering
the design equations remains the same.

4-30

ICT, Inc.

4.1 o Design Operation - State Diagram Designs

4.0 Operation Reference Guide

4.1 O Design Operation - State Diagram Designs
An alternate method of describing a logic design is the state
diagram design implementation. In this section, the procedure to
implement the state diagram designs is discussed. The syntax
for these state diagram designs are discussed in detail in chapter 5 on "PLACE Design Language".
The first step in the state diagram design is to label the cells to
be used as state variables for the state diagram. These cells will
be referred to as "State Cells". Then, configure each state cell
and use the "Copy" command to duplicate the configurations to
other state cells. Next, select the "Allocate" command (section
4.4) in the "Design" menu window to implement the state cell
assignments. Choose the "State Diagram" option in the "Design
Type" window. A window pops up allowing the options of adding
or erasing state diagrams (Figure 4-22).

I
SP

-®--

Figure 4-22, Adding a state diagram design
~

Note that the PEEL22CV1 OA device is used in the example
described in this section. The procedure of implementing the
state diagram design remains the same for all devices. In
addition to the IOCs, LCCs in the PEEL Arrays can also be
allocated as state cells.
Type in the label for the new state diagram. The syntax of the
label is similar to those used for labelling pins or cells (refer to

ICT, Inc.
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chapter 5 on "PLACE Design Language"). The next step is to
allocate the state cells as illustrated in Figure 4-23.

If an assigned cell is
selected again, then
i;;!!!C'!f~'"-L::L it will be removed
from the state cell
assignment list

Assigned state cells
for the state diagram
TEST. The state cells
S4 and SO are the
most and least significant bits
respectively

Click to allocate
the state cell
SP

-®--

Figure 4-23, Allocating state cells for a state-diagram design
After completing the state cell assignments (by pressing the
[Esc] key or click-A), a border surrounds the assigned state
cells to indicate the state diagram. Additional state diagrams are
differentiated by the line types in the borders.

llllllillD••••

Indicates that the
window displaying the
state-diagram design is ~mmm~
opened in the "Edit
Eqn" mode
.,,

a

Click inside the
window to enter the
text editor for entering or modifying the
state-diagram design
syntax

Click inside the
"allocated border"
to display the
state-diagram
design syntax

Figure 4-24, Entering design description for the state-diagram
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4.11 Design Operation - Truth table Designs
In truth table designs, the description of the logic design is in the
form of a truth table. This design method is most suitable for
random combinatorial logic applications.
Like the state diagram design procedure discussed in the previous section, the truth table design begins with allocating
labeled pins and cells. Figure 4-25 shows a new truth table
being labeled "DECODE" at the beginning of the truth table
"Allocate" command.

II

SP

--®--

Figure 4-25, Entering the label for a new truth-table design
After typing in the label, the next step is to select the inputs of
the truth table (Figure 4-26). A truth table input can be a pin,
INC, IOC, or LCC. Click at the "Output" option in the pop-up
window to complete the input selection and to start the output
selection. Press the [Esc] key or click-A to complete the output
selection.

~

ICT, Inc.

Note that during the input or output selection process, if you
click on a selected pin or cell, then it will be removed from the
input or output selection list.

4-33

4.11 Design Operation - Truth table Designs

4.0 Operation Reference Guide

Click to select the truthtable inputs which can
be a pin or an IOC (or
-:__J_~~i5;1'] an INC or a LCC in
PEEL Arrays)

Tl "DECODE:"

¥wr~·,
Done

Click at the
"Output" option
to complete the
input selection
and to start
selecting the
outputs

If you click at a
selected input again,
then it will be
removed from the
truth-table input list

,,,

SP

--®-

Figure 4-26, Selecting truth-table inputs
~

Press the [Esc] key or click-R during the input or output selection process to abort or complete the "Allocate" command. A
window will pop up to confirm implementing the changes made.
Pressing the [Esc] key or clicking-A when the "Implement changes?" window is popped up will return you to the previous mode
(input or output selection).

2

Currently selected
truth-table
outputs

9

ouT

Click the IOC
(or LCC in
PEEL Arrays) to
select the truthtable outputs

If the selected output is +---:+-.+r+--i
selected again, then it
will be removed from the sP
truth-table output list
P

Figure 4-27, Selecting truth-table outputs
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Indicates that the
displaying the •miDEl!!!lll
• • • • • • • window
truth-table design is ,..
opened in the "Edit
Eqn" mode

Click inside the
window to enter the
text editor for entering or modifying the
truth-table design
syntax

Click the T(n)
symbol
(n=1 .. 10) for
Truth-tables

Figure 4-28, To enter the truth-table design description
~

For more information on the syntax of the truth table design
description, please refer to chapter 5 on "PLACE Design Language".
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4.12 Design Operation - PSF Text Display Window
The PSF Text Display Windows are the windows which can be
opened to display the logic description of the current design,
such as equations, state diagrams, truth tables, macro definitions, and etc. The two types of windows in the PLACE software
are the Equation and Option Display windows. An Equation
Display window is opened by clicking the left mouse button on
any SUM or AND node (gate), state diagram block and truth
table marker (indicated by Tn where n = 1 to 10). This window is
always located at the bottom of the screen. Refer to Figures
4-29 through 4-31. On the other hand, the Option Display window is located at the top of the screen and is opened from the
"Display" menu. The "Display" menu is selectable in the "Edit
Eqn" mode, LCC/IOC screen for the PEEL Arrays, and roe
screen for PEEL Devices. See Figures 4-29 and 4-30.

•lliillim--ml

"Display" menu selectable
in the "Edit Eqn" mode ~~~~
and LCC/IOC screen

Opr 1 ons

Select Sum Equation
l!:'l!!'I

~

Options
00

"8't!~-~!·~rr~rt;r::
..· ~ew Equation
1.,Ji

l,Jl•w Sourc•

L1st1n~

Option Display Window= var
~quatlon Display ~lndow • 6

Figure 4-29, "Display" menu in "Edit Eqn" mode
Display Options
In the "Display" menu, there are several categories of the PSF
design file in which it can be selected for viewing. The list
includes Macro Definition, State Diagram, Truth table, Equation
and Source File. With or without the Equation Display window
opened, you can open this additional window by clicking at the
selected category (Figure 4-32).
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If the "Equation" or "Source File" option is selected, the window
opens by displaying the most recently displayed page. This
means that if you have previously opened the "Equation" or
"Source File" window and have paged up or down, then the next
time you select the same option the previous page will be
displayed.
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Figure 4-32, Both Equation and Option Display windows
opened
Sizing the Display Windows

There are two ways which you can size the display windows:

o The first method is by pressing the Up and Down cursor keys
followed by the [ENTER] key when the window is displayed. The
first cursor key pressed enters the sizing mode by outlining the
current window. Each subsequent cursor key moves the window
border up or down. Then, press the [ENTER] key to accept the
selected size. The maximum number of lines for each window is 19.

SYS_CLK
MODEL
MOOE2

Outline of new
window size
0
E
F"

Cit. T

= COUNTER
18

111

II!

!Q0;

Qi.AP "' COUNTER• A:
DILJ. COM

=

"Bit

1 of' Counter, B =HOLD

"Input fl preseu: Counter

GATES 111 (A + B + C + D + E + f" + G

+

H> +

Figure 4-33, Sizing the Equation Display window
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o The second method is to use the last two options in the "Display"
menu (Figure 4-29). Click at either option to advance the number of
lines for the window. This number will be used the next time the
window is opened. In addition, the selection "var" ("variable") is
available for both these optionsc. This selection (illustrated by
"Option Display Window= var" or "Equation Display Window= var")
allows the size of the window to be dependent on the type of design
syntax selected. The criteria for setting the "var" window size are:
• Equations (Equation Display Window only):
A set of equation will be displayed. This equation starts from the
selected SUM or AND gate label (e.g. 01 .D) and ends with any of the
following characters (in prioritized order):";","=", ''TEST_VECTORS"
or ASCII# 26 (End-of-File) character.
• State Diagrams:
A state diagram design group which begins and ends with the
keywords "STATE_DIAGRAM statename" and "END;" respectively.
• Truth Tables:
A truth table design group which begins and ends with the keywords
"TRUTH_TABLE" and "END;" respectively.
• Macro Definitions: The displayed text will succeed the keyword
"DEFINE" but precede "STATE_DIAGRAM statename",
"TRUTH_TABLE" or "EQUATIONS".

For the "Equations" and "Source File" options in the Options menu, the
"var" selection sets the window size to 19 lines (maximum number).
Paging Up and Down
The contents of the window can be paged up and down by
pressing the PgUp and PgDn keys respectively. It can also be
accomplished by clicking at the PgUp and PgDn markers in the
upper and lower right corner of the window (Figure 4-30).
Entering the PLACE Text Editor via the Display Window
Clicking the left button of the mouse within the Equation or
Option Display window opens the PLACE text editor for entering
or modifying the design syntax. In addition, the PLACE text
editor highlights the selected block and moves the text cursor to
the top of the block. The block that is highlighted depends on
which Display Window the text editor was opened from. If the
editor was opened via the Equation Display Window, then the
equation, state diagram or truth table block will be highlighted
depending on which design type was selected. If the Option
Display Window was used instead, then the block displayed on
the window will be highlighted in the text editor. To return to the
previous screen, press the ESC key.

JCT, Inc.
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Set Pinout to
DIP/PLCC ...... Allows the pin numbers in the pin block diagram and
LCC/IOC screen to show the pinout of DIP or PLCC package type. Figures 4-34 and 4-35 show the pinouts for
DIP and PLCC packages respectively. The default Is
the DIP plnout for all devices with the exception for
the PA7140 device which has PLCC plnout configuration only. The PLCC pinout configuration is available to
all devices except the PEEL 173 and PEEL273 devices.
PLCC Configuration
............... Displays the design in the actual PLCC package form
(Figure 4-36). Press the [Esc] key or click-A to return to
the previous screen. This command is applicable to all
devices except PEEL 173 and PEEL273.

Figure 4-34, "Options" menu and DIP pinout for the PA7024
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Figure 4-35, PLCC pinout for the PA7024
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Figure 4-36, PLCC package configuration for the PA7024
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There are three windows in the main screen of the Compile
Operation (Figure 4-37). Each of these windows provides a
specific function in regards to the compilation process of the
PLACE Source File (PSF).
Quick access tags for
Compile and Edit functions. Click here to
compile or to enter the text editor

--1.m--~mmiiiiiiiiiiiiijiiii~~iiiii!iDiiiiiiiiiiiiiiiiiWimiiiiiiiiiiiiiiiiii~~.j Error Message

"'

window

Compile window

.....
Figure 4-37, Compile Operation screen

Compile ........ This window displays the information regarding the status
of the compilation. The compilation of a PSF file is a
three step process: Parsing; Optimization; and Fusemapping.
Parsing - Checks the syntax of the PSF file and displays
the error in the Error Message window.
Optimization - Implements logic transformation (complex equations into sum-of-product form conversion) and
reduction to the parsed PSF file, and outputs the results
to a file with extension ".RED". The RED file is in the
PSF format, hence it can be read into the Design Operation for analysis of the reduced equations. After optimization is completed, the reduction level implemented is displayed. For instance in Figure 4-37, the "L 1" term in "Optimizing ... L1 OK" indicates that the reduction level L 1

ICT, Inc.
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was used for the GATES1 .PSF design, and the reduction
process was successful (as indicated by OK).
Fuse-mapping - This is the final step of the compilation
process. After successful optimizations, the reduced
equations are mapped into the device by outputing a
JEDEC file. In addition, the fuse-mapper outputs a
".MAP" file which contains the information on how each
equation is mapped in the JEDEC file.
Once the compilation is completed and successful, the
check sum of the JEDEC file and compilation time will be
displayed.

Error Message .. This window displays any error encountered during the
compilation process. Figure 4-38 shows an example of a
syntax error in which an unknown signal "M0DE2" was
encountered in the macro definition (the correct signal is
"Mode2"). Once an error is encountered the compilation
is aborted, and the text editor is opened automatically to
allow the highlighted error to be investigated or
analyzed. Note that the highlighted line sometimes does
not contain the error. This may be due to an incorrect format for comments in the previous lines. Please refer to
chapter 5 for more information on the Comment format.
Editor .......... The Editor window allows the text editor to be opened for
design edits or modifications. If a syntax error is found
during the compiling process, the editor opens and highlights the error line automatically. A full screen editor is
available via the "Utilities" menu.

--11.m--mm11m1iDl___!lillllli&linm_ _ _l!UllDlDll----• Errorwindow
Message
Double-line border
which indicates that
editor to
is active
(opened)
allow
~f,ijj~iji~tj~{i~~itJjlii~iji1-~-~-=-:~-=-=-~-L the
the syntax error to
be analyzed ·

Some common text edito
commands

While in the text editor,
click-MH (or click-A) to
isplay the menu options.

Figure 4-38, Encountering a compilation syntax error
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Figure 4-39, Compile menu
Run ........... Compiles currently selected PSF design file. If the
compilation process is successful, then a JEDEC ".JED"
file will be created. If a compilation error occurs, an error
message will be displayed in the Error Message window.
In addition, the editor will be opened and the line containing the error highlighted automatically. You can then
make the edits here or go back to the Design operation
to correct the source file. Please refer back to section
4.14 for more information on the compilation process.
Note: The compiler can be executed by clicking at
the "Compile" window heading.
Settings ........ Allows the selection of logic reduction level and product
term utilization as listed in Table 4-3.
The default option for the reduction level selection
Is "Auto 1-5". The "Auto" reduction levels refer to the
automatic increments of the reduction levels. For instance, the "Auto 1-5" means that the optimization
process starts with reduction level 1. If the design does
not fit the device after the completion of level 1, then it
proceeds to level 2. If the design still does not fit the
device, it proceeds to level 3 and so on until a fit occurs. Once the design achieves a device fit, the reduction level will be displayed in the Compile window
(Figure 4-37).
There are five reduction levels, ranging from no logic
reduction to group reduction with deMorganization of

ICT, Inc.
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outputs. The higher the level the better the utilization
but the optimization time will also be longer. So when
compiling a design for the first time, it is recommended
to use the "Auto 1-5" option. Then, note the level
needed (displayed in the Compile window) to successfully compile the design. For subsequent compilations,
select the single reduction level.
- "Utlllzatlon": This command allows the maximum number of product terms (in percentage) used during the
logic optimization process to be set. For instance in
the PA7024 device, if the product utilization is set as
"Utilization= 60 %",then 60% of 80 product terms (80
product terms is the maximum for the PA7024) will be
used during logic optimization. Hence, this command
allows you to estimate whether additional logic can be
implemented into the selected device. The default
product term utilization Is "Utilization = 1oo %".

Reduction Function
Level
Level 1

No reduction. Transforms equations to sum-of-products.

Level 2

Simple reduction. Combines duplicate product terms.

Level3

Pin reduction. Optimizes terms per individual equation.

Level4

Group reduction. Optimizes terms over all equations
which can be shared.

Level 5

Group with output polarity inversion reduction.
DeMorganizes Outputs (automatically inverts polarity) to
achieve best optimization of terms.

Auto 1-2

Optimizes from Level 1 to 2 until logic fits.

Auto 1-3

Optimizes from Level 1 to 3 until logic fits.

Auto 1-4

Optimizes from Level 1 to 4 until logic fits.

Auto 1-5

Optimizes from Level 1 to 5 until logic fits.

Utilization

Sets the maximum product terms which can be shared
to be used in the logic reduction or optimization
process. The number set is in percentage.

Table 4-3, "Settings" menu in the Compile menu window
Status ......... Displays the device utilization and use of architecture
after the design is compiled.
Create .MAP file . During the fuse-mapping process, a ".MAP" file can be
created in addition to the JEDEC file. This MAP file contains the detailed information regarding how each equation is mapped in the JEDEC file. The default condition
is ON.
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After successful compilation of a PSF design file, test-vectors
may be necessary to verify the design. In the Simulate operation, these test-vectors are displayed as waveform signals (Figure 4-40). The vectors are created using the "Edit" command.
Then, they are used to simulate (logically only) the function of
the design by retrieving the design's logic from the JEDEC file
which was created in the Compile operation. These vectors can
also be appended to the JEDEC file so that they can be used to
exercise the device after programming.

Click at the arrows to scroll one vector up,
down, left or right. Click-R at the arrows to
page up, down, left or right.
PL
P2
P3

SYS-CLK
MOOE:L
MODE:2
Note

p ..

P!5
P6
P7
PS
PS
PL0
PLL
P2L
P20
PLS
PLB
PL7
PL6
PL!5

"B
c

D
E:
F"
G
H

l'll'ID-I
OR_J

NANO_K
NDR-L
E:XOR_M

..

...
...
...
...

PL3

.

Cell assignment and
name column

.

. .

Click-LH at the "position block"
to jump to a specific vector
column and waveform row

Figure 4-40, Simulate waveform screen
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In the waveform display, each waveform row represents a signal from a pin or an internal node (e.g. a LCC, IOC or INC). The
external pins are indicated by "P" followed by the pin number.
LCC internal output is indicated by "L" with the cell assignment
coordinates. The prefix for the IOC or INC node (i.e. the output
of the IOC or INC register) is an "I" followed by the assigned pin
number. The IOC and INC nodes are differentiated by the as-
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signed pin numbers. For instance in the PA7140 device, pins
3-5, 19-21, 25-27 and 41-43 are assigned to IN Cs. The rest of
the pins except pins 2 and 24 (CLK pins) are assigned to IOCs.
For more information, please refer to the ICT data book.
Examples of the waveform pin and cell assignments, and labels
found in the TC7140.PSF design file of the PA7140 (the PA7140
device has all the cells, i.e. LCCs, IOCs and INCs) are:
P2
L3A
115
14

CLK
P2
C2
SELECT

=>
=>
=>
=>

pin 2 with label CLK
LCC 3A with label P2
IOC 15 with label C2
INC 4 with label SELECT

Scrolling and paging In the waveform display

As illustrated in Figure 4-40, scrolling and paging can be accomplished by clicking and clicking-A at the arrow markers
located on the right side of the screen. An additional method of
scrolling and paging is to use the left, right, up and down cursor
keys, and the [PgUp] and [PgDn] keys respectively.
Alternately, you can click-LH (click and hold the left mouse
button) at the "position block" to jump to another waveform
display section. Once you have selected the location, release
the left button to return to the normal screen mode.
Functions of the waveform signals

In the Simulate operation, the graphical image of each waveform
signal represents a specific function. For instance, the
waveform signal image 11_ which is represented by the test-vector C in the JEDEC file indicates a Low-High-Low input pulse.
This signal functions as a clock for triggering a register on the
rising or falling edge of the signal. Please refer to Tables 4-4 and
4-5 for additional information on other waveform signals.

~
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Figures 4-40 through 4-56 illustrated in this section were captured via a monochrome monitor. Refer to Table 4-5 for the
functions of the waveform signals in these figures.
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Color

Function

_J1.__

Blue

System Clock

.JL

Blue

Input High

l...__J"

Blue

Input Low

0

Blue

High Voltage Preload

p

><

Blue

Input or Output Don't Care

x

.JL

Yellow

Output High

H

l...__J"

Yellow

Output Low

L

Yellow

Output High Impedance

z

Red

Buried or Internal Signals
which cannot be modified

N/A

---

r-L

JEDEC Vector Symbol

c

Table 4-4, Waveform signal symbol table for a color monitor

Symbol

Llnewldth

Function

_J1.__

Normal

System Clock

.JL

Normal

Input High

l...__J"

Normal

Input Low

0

Normal

High Voltage Preload

p

><

Normal

Input or Output Don't Care

x

r-t.
1-..I

Thick

Output High

H

Thick

Output Low

L

Dotted

Output High Impedance

z

r-L

Center

Buried or Internal Signals
which cannot be modified

N/A

---

JEDEC Vector Symbol

c

Table 4-5, Waveform signal symbol table for a monochrome
monitor
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Figure 4-41, Simulate waveform screen
Simulate ....... Performs logic simulation of waveform vectors on external
signals, i.e. on the "P" waveform rows only. The
simulator compares the simulated signals with the current signals on the pins, and then mark the locations
with signals that do not match. These marked locations
are vector simulation errors (Figure 4-42 and 4-43). The
special symbols used indicate the type of simulation errors (Table 4-6). On the other hand, the signals for all internal nodes are not checked but are automatically captured during logic simulation.
During simulation, the design's logic is retrieved from the
JED EC file that has the same root name. For example,
the JEDEC file DEM01A.JED will be used during the vector simulation of DEM01 A.CFG.
Capture ........ Unlike the "Simulate" command, this command "captures"
the signal on all external outputs. With this command,
signals on the output pins need not be generated because the simulated signals are automatically inserted
by the simulator. In addition, the simulated signals are
also inserted into vector locations which contain the output Low "L", output High "H" and Don't Care "X" signals.
This means that if you have simulation errors on any of
these vector locations, they will be replaced by the simulated signals. See Figure 4-42.
~
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Please refer to Figure 4-44 for information on the "Simulate"
and "Capture" commands for asynchronous clock designs.
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Error Symbol Function
L
Indicates that a LOW signal is simulated on the pin at the
current vector location.

H

Indicates that a HIGH signal is simulated on the pin at the
current vector location.

z

Indicates that the pin is in a High Impedance condition at the
current vector location. An example is the insertion of
output signals ("L" or "H") on inputs.

C

Indicates that a signal contention condition exists at the
current vector location. An example is the insertion of input
signals ("O" or "1 ") on outputs.

U

Indicates that the signal at the current vector location is
unstable or in an indeterminate state. An example of an
application which causes this error is an oscillator. When
an unstable error occurs, the simulation process is aborted
and the pin number(s) reported.
Note that the PLACE Simulator will not flag an error if the
unstable output has a Don't Care symbol.

Table 4-6, Simulation error symbols for pins

High Impedance errors because output signals
were inserted. If "Capture" command is used,
then the High Impedance signals will be
inserted into both these vector locations.
No ta

P"I

PS
PS
P7
PS
pg

21

Signal contention simulated.
Since these are input signals,
they will not be replaced by the
simulated signals in the
"Capture" command.

PSO
PH

Don't Care signals will be
replaced by the simulated -k~.O.O<vi.IU-x>Q.<x>C.O.~><><><:><j;><'>-r'<>t=.t:+:;:-;j"T;;::':';-:~-;t;--,
signals in the "Capture"
command

Note

Note

Simulated signals will be
inserted for this output in the
"Capture" command

~:

Figure 4-42, Vector simulate errors
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Not• 12
Not• ll=~======~===================================!i
P9
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Pt2

DSC

Nata
Note
Not•
Not•
Not•
Not•
Not•
Note

In PEEL Devices, the unstable pin numbers will be referenced in the error message. However in PEEL Arrays, the
product term numbers are referenced because the internal outputs of the LCCs. In both cases, the ".MAP" file
generated by the compiler will be required to trace the unstable signal problem.

Part Number • PEEL 18CV8
Variable 9 = IN
Variable 12 = OSC
Variable 21 = AR
Variable 22 =

II

OSCV8.MAP flle

SP------~Unstab~~nOutputl

OSC on Pin12Product O = Pin9 • 1Pin12
Asynchronous Clear Product 73 = O
Synchronous Preset Product 72 = O

·

Assembly Completed ...

Figure 4-43, Unstable output simulation error example
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Figure 4-44, Test Vectors for asynchronous clock applications Sum or Product term clock

ICT, Inc.

4-52

4.0 Operation Reference Guide

4.17 Simulate Operation - Simulate Menu

Figure 4-44, Test Vectors for asynchronous clock applications Sum or Product term clock (Continued)
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Figure 4-45, PA7024 LCC Register Preload, and Product or
Sum Clock Application
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Figure 4-46, LCC Register Preload function
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Append test
vectors ......... This command converts the waveform vectors into the
JEDEC file test-vectors and appends them to the ".JED"
file. This allows the vectors to exercise the device on a
PLO programmer.
Status ......... Provides status information such as the maximum vector
columns available with the current system configuration
(more system RAM memory, more vector columns available), number of total vectors used, number of simulation e~rors, and the previous simulation time.
Simulate from
JEDEC ......... With this function, the PLACE Simulate waveforms can be
generated from the test vectors specified in the JEDEC
file. If an ICT PDS-1 programmer is present, this function
together with the "Capture" function in the "Test" menu
of the Program operation allow viewing of device vector
results via the waveform screen. Refer to Figure 4-47.
Capture from
JED EC ......... This command is similar to that of the
"Simulate from JEDEC" command except that the output
signal levels will be replaced by the simulated signal
levels.
Simulate
display ......... When the Simulate display is set to the ON condition, the
waveform vectors are displayed during the simulation or
capture process. If this command is set to the OFF condition, the waveform vectors will not be displayed during
simulation. Instead, each vector will be illustrated by a
"."for a vector which passes simulation, and a"*" for a
failed vector.
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4.18 Simulation Operation - Entering or Editing Waveforms
In the Simulate operation, the test vectors are entered or
modified via the "Edit" command. All other commands on the
right side of the screen (such as Note, Copy, and etc.) are
merely used for organizing the waveform screen. This means
that these commands do not affect the results of the vector
simulation. Please refer to section 4.19 for more information on
the waveform organization commands.
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Figure 4-48, "Edit" command in the Simulate operation
Note that only waveform signals for the external pins (inputs or
outputs) can be entered or edited. All internal node signals are
captured by the simulator and displayed for analysis.
Edit ............ Edits input or output vectors, or inserts the text into the
rows generated by the Note command. There are three
methods of entering or editing the waveform vectors.
1. Move the edit "box" cursor to a vector location and
click the mouse button. Continue clicking until the
desired waveform signal is displayed. Since there
are eight different signals possible, each vector is
selected again after every eight clicks.
2. Move the edit cursor to a vector location and press
the vector symbol keys such as C, 1, 0, P, H, L, X
or Z to select the type of waveform signal. For instance, pressing the key "C" will select the clock
signal for the current vector location. Refer to
Table 4-4 or 4-5 for the description of each
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waveform signal. Note that the vector symbols are
actually the standard symbols used in the test vector section of the JEDEC file.
Use the "Drag" command which will be described
later in this section.

Once the "Edit" command is selected, the advanced commands
for editing test vectors will appear at the top of the screen and
can be selected with the mouse. In addition, the previous block
of vectors selected via the BBegin and BEnd commands will be
displayed. Click-R to exit the "Edit" command.
Repeat ......... Repeat allows a single vector to be repeated by a specified
number. Click "Repeat" then move the edit cursor to a
vector location and click. This vector location will be the
starting location. Then, enter the number of vectors to
repeat and press Enter. All existing vectors following the
starting vector will be overwritten.

Pl
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1'3

PS
1'10
Pll

1'21
P20

Pl9
1'19
Pl;>
Pl6
Pl!5

Pl:3

Figure 4-49, "Repeat" command
The commands which begin with the letter "B" indicate that they
are block commands. Block commands are commands which
manipulate a block of test vector referred to as a "vector block"
(Figure 4-50).
BBegin ......... This command allows a vector location to be selected as
the beginning vector of the "vector block". If no current
block exists, then the PLACE software automatically
enters the "BEnd" command immediately after the selection of the beginning vector. If a block exists, then a new
beginning vector can be selected. The previous ending
vector will remain unchanged.
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BEnd .......... Allows the selection of an ending vector for the "vector
block". Like the "BBegin" command, a new ending vector
can be selected for a current "vector block". If a block
does not exist, then the selected ending vector is still applicable the next time a beginning vector is selected.
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IN-CLK t--,.~~~~~~-+-~~~~~~-+-~~~~~~.,.....-,

Figure 4-50, Vector block selected
~

The beginning and ending vectors of the "vector block" must
always be located on the upper-left and lower-right of the block
respectively. A block can have a single row or column. In this
case, the beginning vectors are the most-left or top vectors,
and the ending vectors are the most-right or bottom vectors. In
addition, beginning and ending vectors can be located on
separate waveform screens.
BCopy ......... Copies the currently selected block into another waveform
area after the selection of a starting vector location.
BMove ......... Moves the currently selected block into another waveform
area after the selection of a starting vector location.
BDel ........... Deletes the currently selected block of vectors. A pop-up
window to confirm the deletion will appear.

The following lists the row or column commands.
DelC ........... Enters a mode which allows the current waveform vector
column to be deleted. Additional clicks will continue to
delete the next vector column. Click-R to exit this mode.
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DelR .......... Enters a mode which allows all the vectors on the selected
waveform vector row to be deleted. Click-A to exit.
lnsC ........... Enters a mode to allow vector columns to be inserted.
The vector column is inserted prior to the selected vector
column (Figure 4-51). Additionally, the signals on the
new column follow the selected vector column.
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Figure 4-51, Inserting a vector column
Drag ........... Enters a mode which allows input or output signals to be
entered or edited. Only four signals are available in the
drag mode: input "0"; input "1 "; output "L"; and output
"H".
Select the waveform vector row and column after you
have entered the "Drag" command. The drag edits will
start from this location. Move the cursor horizontally
across from left to right and click at the selected vector
location to end the current signal. Click again to select
another vector location. To exit the drag mode, click-A or
press the [Esc) key. Note that the drag edits will overwrite the previous vectors.
Selecting the input or output signal
The input signal (blue or normal width) is selected when
the "Drag" command is first selected. To "drag" an output signal, press AX or [Ctrl]-X during the "dragging"
process, I.e. the Input signal Is currently being
dragged. Pressing [Ctrl]·X during the drag process
toggles between dragging an input or an output signal. The output signal is indicated by a yellow or thick
line.
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4.19 Simulation Operation - Organizing Waveforms
All the commands in this section are used to organize the display of the waveform screen for a better understanding of the
PLACE designs. This means that these commands do not affect
the results of the simulation or the actual generation of the
test-vectors for the JEDEC file. In each CFG Simulate file, a
maximum of 99 waveform rows are allowed.
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P20
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Click-LH in the Copy, Dele or Move mode to "block:~:
select" the waveform rows. A block of waveform rows r><>0<><:'.><I
P1?
is selected by clicking and holding the left button of
PL"
the mouse (click-LH). Then, move the mouse down to .
:~~ r~ highlight the waveform rows. Release the mouse left r:o.<><::><><><1
P22 c
button to complete the selection
·
P13

Figure 4-52, Commands for organizing the waveform screen
Note ........... Allows a "Note" row to be inserted for adding comments
to the waveform display. Add the note line by clicking at
the desired line, click-A to exit note command then
select the "Edit" mode. Move the edit cursor to the note
line and click to enter text for the comments.
Copy ........... Copies a waveform vector row or a "block" of selected
waveform rows to another location. This command will
prompt for a source and target selection. Click-A to exit
this mode.
Dele ........... Removes a waveform vector row or a "block" of selected
waveform rows from the current waveform screen. Note
that the unduplicated waveform rows for external pins
and internal nodes will be appended to the bottom of the
CFG file (last screen of the waveform display). All other
waveform rows such as Notes and duplicated rows (i.e.
rows that were copied using the "Copy" command) can
be removed from the CFG file. The CFG file has a minimum number of waveform rows allocated for each device
type that cannot be removed. For instance, the PA7024
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device has 62 waveform signals (22 inputs/outputs + 20
LCC internal outputs + 20 IOC registered nodes) that are
always present in the CFG file.e. Click-A to exit.
Move .......... Allows a waveform vector row or a "block" of selected
waveform rows to be moved from one location into
another location. This command will prompt for a source
and target selection. Click-A to exit.
Swap .......... Allows a waveform vector row to be swapped with another
vector row. This command will prompt for a source and
target selection. Click-A to exit. No "block" swapping is
available.
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4.20 Simulate Operation - Zoom Command
When the "Zoom" command is selected, the waveform screen
displays 170% more vectors than the normal screen. Normally,
the waveform screen is 22 rows by 30 columns. But in the zoom
mode, the screen is 30 rows by 60 columns. With more vectors
being displayed, more waveform vectors can be viewed on a
single screen, which may lead to a better understanding of the
overall design.
The editing and
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Figure 4-53, Mode A of the "Zoom" waveform screen
Within the Zoom mode, there are actually two separate modes
which will be referred to as Zoom Modes A and B. A typical
procedure of using the Zoom mode is:
>-From the normal waveform screen mode, click at the "Zoom"
menu on the right side of the screen to enter Zoom Mode A.
The screen in this mode consists of 30 rows of waveforms
and 60 columns of vectors.
>-In Mode A, almost all commands in the Simulate operation
can be executed. These commands include file read and
save, simulate, capture, or the PSF command (section 4.21 ).
Some of the commands not executable in Mode A are the
Note, Edit, Erase, Copy, Move and Swap commands. If you
click-R in Mode A, you will be returned to the normal
waveform screen mode.

4-63

ICT, Inc.

4.20 Simulate Operation - Zoom Command

4.0 Operation Reference Guide

~To

enter Mode B, click at the "Zoom" menu once again but
this time don't release the left button of the mouse. A rectangular box depicting a window view of the current selected
waveform screen is displayed (Figure 4-54). This rectangular
"view" window can be moved to another location by moving
the mouse. If you wish to return to Mode A at this time, press
the right button of the mouse while the left button is being
pressed. Otherwise, releasing the left button of the mouse
will return you to the normal waveform screen selected via
the rectangular "view" window.

..

l . . . . . . . . . .. . . . . . . .

P2

P3

L1A

L2A
l.2B
L1B
L.1A

"'"
Figure 4-54, Mode B of the "Zoom" waveform screen
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4.21 Simulate Operation - PSF Command
The PSF design file can be displayed on the waveform screen
by selecting the "PSF" command located on the right side of the
screen. With the PLACE design source file displayed, you can
compare the simulation results with the design logic. If a simulation waveform vector error is detected, then the modification can
be done instantly using the "Edit" command. If the error is in the
design logic, then return to Design operation to correct the error
and re-compile the PSF file.
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Figure 4-55, Mode B of the "Zoom" waveform screen
As shown in Figure 4-55, a window will pop-up displaying the
PLACE design source file. The features of this window are
similar to those available for the PSF Text Display windows
found in the Design operation. These features include paging up
and down the display screen and window sizing. An additional
feature not available in the Design operation is the moving of the
display window to another location (Figure 4-57). To close the
PSF window, press the [Esc] key or click-A.

Paging Up and Down
Like in the Design operation, paging within the PSF window is
accomplished by clicking at the PgUp or PgDn markers located
at the top and bottom of the window, or by pressing the PgUp
and PgDn keys. See Figure 4-55.
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Sizing the Display Window
The size of the window can be adjusted by pressing the Up and
Down cursor keys followed by the ENTER key. The Up cursor
key increases the window size while the Down cursor key
decreases the size. A maximum of 19 lines of text can be
displayed on the window.
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4.22 Document Operation - Document Window
In the Document operation, the documents relating to a PLACE
design can be printed via some of the most popular printers,
such as IBM and Epson graphic printers, HP Laserjet II and
postscript laser printers. In addition, the printing of these documents (including the design configuration and simulate
waveform screen images, PSF design file, compiled outputs and
etc.) can be set up in a queue or batch mode.
Batch or Single
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As shown in the Figures 4-58 and 4-59, the current PSF and
CFG files loaded are displayed at the upper-right corner of the
window. If these files exist, they will be loaded automatically
upon boot-up of the Document operation. However if desired, a
different PSF design file or simulation waveform CFG file can
be read from the "File" menu.
After making the print option selections, the printing is initiated
by clicking at the "Print" command located at the lower-right
corner of the window. Remember that a print option can be
de-selected by clicking at the selected (highlighted) option
again. Note that all selected print options can be saved via the
"Save" or "saveAs" command (as a ".PRT" file) in the "File"
menu window.
Print Mode ..... Allows the selection of "Batch" or "Single" printing.
- Single printing allows one graphics screen or text file
to be selected and printed at a time.
- Batch printing allows several screens or text files to be
selected, each printed out sequentially.
Graphics ....... This option is used to select the graphics screens to be
printed, including: Block Diagram Screen "Pin-Block",
PLCC package configuration (if applicable), LCC/IOC
and GBC graphic screens for PEEL Arrays or IOC
graphic screens for PEEL Devices and the CFG
waveform screens. In addition, the logic equations for
the LCC or IOC may be appended to each printed design
configuration graphic screen .
To select a graphic screen, click at the print option box
until it is highlighted. The equation (Y/N) selection includes or excludes the equations for each LCC/IOC or
IOC screen.
- Pin Block: Selects the pin block diagram for printing.
The pinout will be in DIP configuration for all devices
except for the PA7140 device which will be in PLCC
configuration.
- Waveform: Allows waveform screens to be selected
for printing.
All:
Selecting "All" will print all waveforms.
Select: Selecting the "Select" option allows specific
waveform screen to be chosen for printing.
See to section 4.23 for more information.
- LCC / IOC (PEEL Arrays) or IOC (PEEL Devices):
Allows the design cell configuration screens to be
selected for printing. For PEEL Arrays, the LCC/IOC
screens will be printed. If it is a PEEL device, then the
IOC screens will be selected for printing.
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All:

Selects all cells (LCC/IOC for PEEL Arrays and
IOC for PEEL Devices) for printing.
Used:
Selects only used or labeled cells for printing.
Select: Allows specific cell~ to be selected for printing.
Refer to section 4.24 for more information.
- Global Cell (PEEL Arrays only): Selects all global
cells for printing. The equation (YIN) selection includes
or excludes the equations for each Global Cell screen.
Text File ........ Selects the PSF design source file, the RED compiled
reduction file which contains the reduced equations from
the PLACE optimizer, and the JED EC file for printing.
Printer Type .... Selects printer type and set-up. Refer to section 4.25.
Options ........ Selects additional printing options (Figure 4-60).
- Waveform Zoom: Sets whether the waveform screens
to be printed are in the normal or zoom screen mode.
- Print to file: Redirects all printer outputs to a file. The
file name will be prompted for immediately after selecting this option.
- COM Rdy Handshake (Postscript printer only):
If sets to the ON condition, the PLACE software waits
for an end-of-job character (ASCII# 4) from the printer
after sending each graphic screen. If set to the OFF
condition, the PLACE software continues to the next
print job without wailing for an answer from the printer.
The PLACE software utilizes the XON/XOFF handshake signals when communicating with the postscript
via the COM port. It Is recommended to set to the
OFF condition If a printer buffer or spooler Is used.
Print ........... Initiates the printing with the currently selected options.
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4.23 Document Operation - Waveform "Select" Print Option
The waveform "Select" option allows specific waveform screens
to be selected for printing. Figure 4-61 shows the waveform
"Select" screen.

PL

P2
P3
p ..

P5
P6

P7
PS

PS
PL0
PLL

P2L
P20

PLS
PLB
PL7
PL<S

PL5

PL3

Figure 4-61, Waveform "Select" screen
Selecting a
screen ........... A waveform screen can be selected by pressing the
[SPACEBAR] key or clicking at the page number located at the upper-right corner of the screen. Once
selected, the page number of the screen will be highlighted. For a list of selected waveform screen, click at
the "List" command.

Pgl or
Left cursor key .... Pages the screen to the left.
PgR
Right cursor key

Pages the screen to the right.

PgUp or
Up cursor key or
[PgUp] key ....... Pages the screen up.
PgDn or
Down cursor key or
[PgDN] key ....... Pages the screen down.
List .............. Lists all the selected waveform page numbers.
Help ............. Displays the Help screen.
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4.24 Document Operation - LCC/IOC or IOC "Select" Option
In PEEL Arrays, the LCC and IOC "Select" screen allows
specific LCC/IOC pairs to be selected for printing. The selection
is made by clicking at the LCCs or IOCs and the LCC/IOC pairs
will be highlighted. In PEEL devices, the IOCs are selected with
the similar method, i.e. clicking at the IOCs until highlighted.

I

Figure 4-62, LCC/IOC "Select" screen for PA7024
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4.25 Document Operation • Printer Type Selection
Unlike the "Print" command in the "File" menu window of the
Design, Compile, Simulate and Program operations (in which
only the IBM and Epson graphic printers are supported), several
popular printers are supported in the Document operation.
These printers include IBM, Epson, HP Laserjet II and Postscript
laser printers.
If you are setting up the Document operation for the first time,
then you will need to configure the printer type and set-up. Once
configured, the printer type and its set-up will automatically be
loaded each time the Document operation is selected.
ocument

Pt"1 nt Mod••
81"aphi

OSI

(
Pin Block•

l>Sf"l
Cf"B1

J

61 n9le

LCC ll IOC

Cquatlon
I' N

Click inside the
printer type box
to pop-up the
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Figure 4-63, Setting the printer type and set-up
After opening the "Print" window as shown in Figure 4-63, select
the "Type" option to choose your printer type. Note that the
printer type selection also sets the type of interface (parallel or
COM) used. The "Set-up" option sets the parameters of the
selected printer interface.
Type ........... Printer with the type of interface (paraller or COM) used.
- IBM: Sends the printer outputs in IBM printer command format via the parallel port.
- Epson: Sends the printer outputs in Epson printer command format via the parallel port. Both IBM's and
Epson's command format are very similar to each other.
- HPLaser Lpt: Sends the printer outputs in HP Laserjet
II printer command language via the parallel port.
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- HPLaser Ser: Sends the printer outputs in HP Laserjet
II printer command language via the serial communication port (COM port).
- Postscript: Sends the printer outputs in Postscript
printer command language via the serial communication port (COM port). Uses the XON/XOFF handshake
signals. For more information, refer to section 4.22 for
the description of the "Options" menu.

Set-up ......... Allows the printer interface to be configured. To make the
set-up selections, click at the options in the "Printer
Setup" window until the desired selection appears. Then,
press the (Esc] key or click-A to return to the "Print" popup window.
- Parallel port (LPT): Allows the port number LPT1,
LPT2 or LPT3 to be selected.
- COM: Allows the port number COM1 or COM2, baud
rate, data size, stop bits and parity to be selected.
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Figure 4-64, "Printer Setup" window
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4.26 Program Operation - PDS-1 Interface Window
If an ICT PDS-1 programmer is installed in your computer, the
PLACE senses it and automatically sets the PDS-1 Interface
window in the Program operation. This window contains commands specifically used for programming, verification, loading,
applying test vectors and other hardware related operations via
the PDS-1 programmmer.
Click to select commands. These
commands can also be executed
by pressing L, P, V, T and A.

Click here to
toggle between
the PDS-1 and
COM Interface
window

Load

Pragra..,.ing ... Ucc•S.OU Upp•t"l.9U
U•rl,ylng ..... Ucc-S.OU Upp•t"l.9U
Si9nature word fro" device =
T - t Uactors
Checkst.11"11 me:

•. "9cc-S .OU

TIM• t•k•n • 13 ••c

Window displays
the execution
and results of
the commands

Tpp=10-

1'1088
1'1088
Pass.ad

JEDEC fuse number.
In most commands,
this number indicates
the execution
process.

Figure 4-65, PDS-1 Interface window in the Program operation
~

If the JEDEC file with extension ".JED" exists (i.e. successful
compilation of the PSF design file), then it will be loaded into
the memory automatically upon boot-up of the Program operation. Otherwise, the JEDEC file can be read via the "File" menu.
Programmer
Type ........... The "Programmer Type" box allows selecting between two
programmer interfaces, the PDS-1 or COM port. This feature is activated only if a PDS-1 programmer is installed
in the computer.
Load ........... Loads the device and stores the data in JEDEC format in
the memory. The file name is defaulted to DEVICE.JED.
Check sum is calculated and displayed beside the file
name.
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4.26 Program Operation - PDS-1 Interface Window

Program ........ The programming process includes (in the order of execution):
- Bulk erase of the device (similar to the "Erase All" command in the "Auxiliary" menu window).
- Programs the device with the JEDEC file in memory.
- Verification of the programmed data.
- If the "Auto-secure" feature in the "Auxiliary" menu window is turned ON , then the device security bit will be
automatically programmed and verified after device
verification. After the device is secured, its contents
cannot be read out.
- If the JEDEC file has test vectors, then they will be
used to exercise the device.
- The device check sum is re-calculated and compared
with the check sum of the JEDEC file in the memory.
- Time taken for the programming process.
If an error is encountered (such as verification, security bit
or test vector error), the programming process is aborted.
Verify .......... Verifies the device with the current loaded JED EC file in
memory. If the JEDEC file has test vectors, then they will
be used to exercise the device. The device check sum is
re-calculated and compared with the check sum of the
JEDEC file in the memory.
Test ........... Allows application of test-vectors to the device. The test
vectors are applied to the device in a serial manner, i.e.
input signals are applied from pin 1 to 24 (default condition - see "Apply pins" option below). Inputs 0 and 1 are
applied first, then C (clock pulse), then the outputs are
sensed and compared with the current output signal.
- Normal: Applies the test vectors normally. If a test vector error occurs, the testing stops. To continue testing,
press the [SPACEBAR] key or click the mouse button.
To abort testing, press "0".
- Single step: Single step each vector by pressing any
key or clicking the mouse button.
- Capture: Captures the outputs of the device. The captured signals will overwrite the current signals. Note
that only pins (include both input and output pins) with
the signals L, H and X will be captured. The captured
vectors reside only in memory and can be saved by the
"Save" or "saveAs" command. Refer to Figure 4-47 for
information on its applications.
- Begin/End: Sets the Begin and End vectors during the
Normal, Capture or Single step process.
- To file: If set to YES, then the test vectors displayed
during the Normal, Capture or Single step process are
sent to a file. The file name follows the JEDEC file
name but with extension ".VEC".
- Apply pins: This option allows the device test vectors
to be applied starting from pin 1 to 24 (Default condition) or pin 24 to 1. This feature may be useful for testing asynchronous applications. Refer to Figure 4-44.
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Auxiliary ....... Selects Auxiliary functions which include:
- Space Bar: If set to ON, the last command will be executed in the main window. For instance, if the last
command was the Program command, then pressing
the [SPACEBAR] key will repeat this command.
- Auto Secure: If set to ON, the security bit will be
programmed and verified in the Program command.
- Read Signature: Reads the Signature word of the
device.
- Write Signature: Allows the Signature word to be
added into the JEDEC file in the memory. It will then
be written to the device. Restriction is that the signature word must be unprogrammed initially.
- Compute Checksum: Computes the check sum of the
device.
- Secure: Sets the security bit of the device. After the
device is secured, its contents cannot be read out. The
security bit of the device can only be cleared by the
"Erase All" procedure.
- Erase All: Bulk erases the device.
- Write All: Writes the data "O" to all the JED EC fuses in
the device.
ro rall"I

,...----fl F"uncti ons
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~e~~~-=~~
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Read Slgnature
~rlte SiQnatur•

Test
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All
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Figure 4-66, "Auxiliary" menu window
To view the current JEDEC file

The current JEDEC file in the memory can be analyzed using the
"Editor" command in the "Utilities" menu window. Once in the
editor, all the features and functions available in the editor of the
Design or Compile operation are applicable here. Refer to section 4.28. Press the [Esc] key or click·R to return to the
previous screen.
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4.27 Program Operation - Serial Communication Port Window
The "PC Com" Interface window is automatically displayed if the
ICT PDS-1 programmer is not installed in your computer. The
commands in this window allow the JEDEC file to be transmitted
or received via the COM port to or from a third-party programmer
which has a serial communication file transfer utility.
Click to select commands. These
commands can also be executed
by pressing L, P, V, T and A.

•iiliiliiiiiliii~~---------··

Click here to
toggle between
the COM and
PDS-1 Interface
window
vr

Mod•

Window displays
the execution
and results of
the commands

II
Figure 4-67, "PC Com" Interface window

~

If the JEDEC file with extension ".JED" exists (i.e. successful
compilation of the PSF design file), then it will be loaded into
the memory automatically upon boot-up of the Program operation. Otherwise, the JEDEC file can be read via the "File" menu.
Programmer
Type ........... The "Programmer Type" box allows selecting between two
programmer interfaces, the PDS-1 or COM port. This feature is activated only if a PDS-1 programmer is installed
in the computer.
Upload ......... Sets computer to receive JEDEC file from the serial
communication (COM) port.
Download ...... Sends currently loaded JEDEC file to the serial
communication (COM) port.
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VT Mode ....... Sets video terminal emulation mode with current settings.
See "Settings" below.
Settings ........ Allows communication port parameters such as baud rate,
data bits, parity, stop bits, and serial COM port number
to be selected.
Auxiliary ....... Selects Auxiliary functions such as
- Space Bar: If set to ON, the last command will be executed in the main window. For instance, if the last
command was the Program command, then pressing
the [SPACEBAR] key will repeat this command.
- Auto-secure: If set to ON, the JEDEC field "G1" is
added to the JEDEC file in the memory. This field
enables the security bit programming in the PLO
programmer. Note that some programmers will override
this option and require you to turn the security bit
programming manually.
- Read Signature: Reads the Signature word of the
JEDEC file in memory.
- Write Signature: Allows the Signature word to be
added into the JEDEC file in the memory.
- Compute Checksum: Computes the check sum of the
JEDEC file in memory.

To view the current JEDEC file
The current JEDEC file in the memory can be analyzed using the
"Editor" command in the "Utilities" menu window. Once in the
editor, all the features and functions available in the editor of the
Design or Compile operation are applicable here. Refer to section 4.28. Press the [Esc] key or click-R to return to the
previous screen.

ICT, Inc.
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4.28 PLACE Text Editor
Figure 4-68 shows the PLACE text editor (a Wordstar™-like) that
is used in the Design, Compile and Document operations. In the
Design operation, the text editor is primarily used for entering or
modifying the logic descriptions of the design. In the Compile
operation, the editor is interfaced closely with the PLACE compiler. If a compilation syntax error is encountered, the editor
opens automatically and displays the line with the error. If possible, this error can then be analyzed and modified without
returning to the Design operation. In the Document operation,
the editor is mainly used for displaying the JEDEC file.

Click- H to enter the mouse. The mouse menus will
appear at the top of the screen. Release the left
~!~!~=~:;;,~~ mouse button to return to the normal editing mode.
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8ulpu1: ena~ie and direc~ion (in PA~T Model are selected gy CONTROL.

HUMes.

End_Desc;

PA711124

Figure 4-68, PLACE text editor
Using mouse in the editor
The PLACE text editor supports some of the editor commands
via the mouse. As shown in Figure 4-68, press and hold the
middle or right button of the mouse (the button depends on
whether a 2 or 3-button mouse is used) to enter the mouse
mode. Once in the mouse mode, no text editing can be done.
Instead, only screen paging and scrolling, and cursor movement
can be performed (Figure 4-69). To exit the mouse mode,
release the left button of the mouse. The best application of the
mouse is to quickly move the editor cursor to another location.
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Click on this
row to scroll the
text 3 lines up.
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Figure 4-69, Mouse mode in the PLACE Text Editor
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Figure 4-70, Automatic block selection by the editor in the
Design operation
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Figure 4-71, Help screen in the editor

Text Editor Keyboard Commands
Screen and cursor movement
Functions
Character left
Character right
Word left
Word right
Line up
Line down
Scroll up
Scroll down
Page up
Page down
Top of file
End of file
Begin of line
End of line
Top of screen
Bottom of screen
Top of block
Bottom of block
Previous cursor
Jump marker 0 .. 3
Set marker 0 .. 3

4-81

Commands

.11 S or Left arrow key
•11 0 or Right arrow key
A or 11-Left-arrow key
• 11 F or 11 -Right arrow key
.11 E or Up arrow key
• 11 X or Down arrow key
• 11 w or 11 -Up-arrow key
• 11 2 or 11 -Down-arrow key
.11 R or [Pg Up] key
• 11
or [PgDn] key
• 11 0R or 11 -[PgUp] key
• 11 oc or 11 -[PgDn] key
.11 os or [Home] key
• 11 00 or [End] key
• 11 0E or 11 -[Home] key
• 11 ox or 11 -[End] key
.11 0B
• 11

c

.110K

.11op
• 11 00 .. 11 03
• 11

K0 .. 11 K3
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Insert and delete
Functions
New line
Insert line
Tab
Delete current character
Delete character left
Delete word
Delete to end of line
Delete line . . . .

.
.
.
.
.

Commands
"M or [Enter] key
"N
"I or [Tab] key
"G or [Del] key
"H or [Backspace] key

. "T
. "QY

. "Y

Block Functions

In the Design operation, the PLACE software selects and highlights a block of text automatically when the editor is opened via
the PSF Text Display windows. If desired, specific text can be
manually "blocked" via the [F7] and [F8] function keys. This is
done by first moving the editor cursor to the location which
marks the beginning of the block and then press the [F7] key.
Then, move the cursor to the "end" location of the block and
press the [F8] key. A block is selected if it is highlighted.
Functions
Begin block
End Block
Copy block
Move block
Delete block
Hide block .
Mark single word
Read block from file
Write block to file
Print block .

.
.
.
.

Commands
"KB or [F7] key
"KK or [F8] key
"KC
"KV

. "KY
.
.
.
.
.

"KH
"KT
"KR
"KW
"KP

Miscellaneous
Functions
Exit editor . . . . .
Save and Open new file
Toggle insert mode
Toggle autoindent
Toggle fixed tabs/smart tabs
Restore line
. . . . .
Search string . . . . . .
Search and replace string .
Repeat last search operation

ICT, Inc.

Commands
. "KQ or [Esc] key
. "KD
. "V or [Ins] key

. "01
.
.
.
.
.

"OF
"QL
"QF
"QA
"L
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5.0 PLACE Design Language
5.1 Introduction
To simplify the design entry process, the PLACE software allows control of the architectures graphically. This capability
allows the user to better utilize his or her time on the actual
design implementation and not on architectural syntax found in
most other PLD software tools. Underneath the graphics however.the PLACE software incorporates a powerful design language that provides standard behavioral design methods such
as State Diagrams, Truth Tables and Equations.
PLACE Source File Format

Figure 5-1 shows the format of the PLACE Source File (PSF).

Design Description: Title of the design, name of designer, date and detailed
description of the design.
Device type:

PA7024, PEEL 18CVB, PEEL22CV10, and etc.

Special features:

Sets Security-bit, Zero-Power or Signature Word.

Input or Clock Pins: Assigns names to the clock and dedicated input pins.
Cell Configurations: PEEL Arrays:

JOG and LCC Configurations.

PEEL Devices: JOG (Macro Cell) Configurations.
Global

PEEL Array: Group A and B Global Cell Configurations.

Configurations:

PEEL Devices: Asynchronous and Synchronous node
definitions for registered PEEL Devices
(e.g. PEEL 18CVB, PEEL22CV10, etc.).

Comments

Details the description of the design.

Macro Deflnltons:

State diagram assignments, and equation and constant
declarations.

State-diagrams
Truth-tables
Equations

Note:
The format categories in italics are
completely controlled and entered via
the PLACE architectural software.

Figure 5-1, PLACE Source File Format
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Figures 5-2 and 5-3 illustrate the differences between the PSF
formats for the PA7024 and PEEL 18CV8 devices.
~

While reading the PSF file, the PLACE software checks the file
format for incompatibilities. If any format incompatibilites are
found for the selected device type, the PLACE software will
display error messages.

TITLE''
Designer·'
Date''
Description
Enter description here ...
End_Desc;
PA7024

"Device type

"Optional Special Features Identifiers
AUTO_SECURE
"Programs the security bit. If unspecified,
"defaults to Security-bit OFF
SIGNATURE 'A8CDEFGH'
"Programs Signature Word 'A8CDEFGH'
CLK1 PIN 1
CLK2 PIN 13
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC

( 2 "POS 10) <- 1A
( 3 " POS 10 ) <- 2A
( 4 " POS 10 ) <- 3A
( S "POS 10) <- 4A
( 6 " POS 10 ) <- SA
( 7 " POS 10 ) <- 18
( 8 " POS 10 ) <- 28
( 9 " POS 10 ) <- 38
(10" POS 10) <- 48
(11 "POS 10) <- S8
(14" POS 10) <- 1C
(1S" POS 10) <- 2C
(16" POS 10) <- 3C
(17" POS 10) <- 4C
(18" POS 10) <-SC
(19" POS 10) <- 1D
(20 " POS 10 ) <- 2D
(21 " POS 10) <- 3D
(22 " POS 10 ) <- 4D
(23 " POS 10 ) <- SD

"Input or Clock pin declaration

"IOC Declaration

Figure 5-2, PA7024 "ANEW7024.PSF" File Template
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LCC (1A" D
LCC (2A" D
LCC (3A" D
LCC (4A" D
LCC (5A" D
LCC(1B"D
LCC (28" D
LCC (38" D
LCC (48" D
LCC (58" D
LCC(1C"D
LCC (2C "D
LCC (3C "D
LCC (4C "D
LCC (5C "D
LCC (1D" D
LCC (2D "D
LCC (3D "D
LCC (4D "D
LCC (5D "D

POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS
POS

REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG
REG

REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)
REG)

"LCC Declaration

Global= 1
GBC (A Clk1 Clk1)
GBC (B Clk1 Clk1)

"Number of global cells used
"Global Cell A configuration
"Global Cell B configuration

DEFINE

"Macro Definitions

STATE_DIAGRAM SD_name
END;

"State diagram design syntax
"Ends current State diagram syntax

TRUTH TABLE TT_name
END;

"Truth table design syntax
"Ends current State diagram syntax

EQUATIONS

"Logic equation syntax

"Equations for the Global Cell A
RTA= O;
PCLKA = O;
PRES ETA= O;
RESETA = 0;

"Reg-Type Product Term
"IOC Clock Product Term
"Preset Sum Term
"Reset Sum Term

"Equations for the Global Cell B
RTB = O;
PCLKB = O;
PRESETS= O;
PESETB = O;

"Reg-Type Product Term
"IOC Clock Product Term
"Preset Sum Term
"Reset Sum Term

Figure 5-2, PA7024 "ANEW7024.PSF" File Template (Continued)
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TITLE''
DESIGNER''
DATE''
Description
Enter description here ...
End_Desc;
"Device type

PEEL 18CV8

"Optional Special Features Identifiers
AUTO_SECURE
"Programs Security-bit. If unspecified,
" defaults to security-bit OFF
"Input or Clock pin declaration

CLK pin 1
IOC
IOC
IOC
IOC
IOC
IOC
IOC
IOC

(12 " POS
(13 "POS
(14" POS
(15 "POS
(16 " POS
(17 "POS
(18 "POS
(19 "POS

COM
COM
COM
COM
COM
COM
COM
COM

FEED_PIN )
FEED_PIN)
FEED_PIN)
FEED_PIN)
FEED_PIN )
FEED_PIN)
FEED_PIN)
FEED_PIN)

"1/0 or Macro Cell Configuration

AR NODE 21
SP NODE 22

"Global Asynchronous Reset Node
"Global Synchronous Preset Node

DEFINE

"Macro Definitions

STATE_DIAGRAM SD_name
END;

"State diagram design syntax
"Ends current State diagram syntax

TRUTH TABLE TT_name
END;

"Truth table design syntax
"Ends current State diagram syntax

EQUATIONS

"Logic equation syntax

"Equations for the global nodes
AR= O;
SP= O;

"Global Asynchronous Reset Equation
"Global Synchronous Preset Equation

Figure 5-3, PEEL 18CV8 "ANEWV8.PSF" Template File
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5.2 Design Description
The design description section of the PSF format is made up of
four fields. The fields include: Title of the design; Designer's
name; Date of the design; and a detailed description of the
design.
~

In describing the PSF formats for the following sections (including this one), italics will be used to identify fields in which the
user would enter identifiers, such as title and date of the
design, name of the designer, pin names, and etc. The reserved
identifiers will be specified in bold. Most of the examples used
for illustrating the formats (except for the PEEL device formats)
are taken from the Blackjack Machine Application Example
(JACK7024. PSF) illustrated in section 6. 7. All reserved identifiers and labels are not case sensitive.

Title
Format:

Title 'title of design'

Example:

Title 'Blackjack Machine Example'

Only the characters between the ASCII 32 and 127 can be used
in specifying the title of the design. The maximum length of the
title is 69 characters.
~

The characters between the ASCII 32 and 127 are normal
characters. These characters include A .. Z, a .. z, 0 .. 9, space, !,
", $, o/o, &, ', (, ), *, +,,, -, ., /, :, ;, <, =, >, ?, @, (, \, ], ", -' ', {,
I.}, and-.

Designer
Format:

Designer 'name of the designel

Example:

Designer 'Joe Peel'

Like the Title identifier, only characters between the ASCII 32
and 127 can be used. The maximum length of the designer's
string is 47 characters.
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Date
Format:

Date 'date of design'

Example:

Date 'May 10th, 1991'

Characters valid in the date string are between ASCII 32 and
127. The maximum string length is 47 characters.
Description

The Description identifier allows the user to specify in detail the
description of the design. The user specifies his or her description within the reserved identifiers "Description" and
"End_Desc;". These identifiers are automatically inserted by
the PLACE software.
Format:

Description
enter description of design here ...

End_Desc;

Example:

Description
Blackjack Machine Example
This design example was based on C.R. Clare's design
in Designing Logic Systems Using State Machines
(McGraw Hill, 1972). The blackjack machine plays ....
All ASCII characters can be used here.
End_Desc;

All PLACE reserved words except "End_Desc" can be used
within the "Description" and "End_Desc" identifiers. Each line
does not need to begin with a double quotation mark, as required in the Comments field (section 5.9).

5.3 Device Type
The target device of the design is declared by simply entering
the ICT PEEL device name.
Format:
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The following are the device types supported in Version 2.1 of
the PLACE software.
PA7024
PA7140
PA7128

PEEL18CV8
PEEL 173
PEEL273

PEEL22CV10A
PEEL22CV10
PEEL22CV1 OZ
PEEL20CG10
PEEL22CV10A+

5.4 Special Features
The special features such as enabling the Security Bit,
programming the Signature Word, and setting the Zero Power
Bit are available for some of the PEEL devices. These features
are optional, meaning that they are not required to be specified
in the PSF file. If not specified, the default conditions will be
implemented. Refer to the description of each of these features
for their default conditions.
Security Bit

Once the security bit feature is enabled, the programmed data
in the device (except for the Signature Word) is prevented from
being loaded or read, and hence prevents any unauthorized
copying of the design in the PEEL device.
The security bit feature is available for the following devices.
PA7024
PA7140
PA7128

PEEL18CV8
PEEL20CG10
PEEL22CV10

Format:

PEEL22CV1 QA
PEEL22CV1 OZ
PEEL273

AUTO_SECURE

The security bit of the device is enabled via the reserved
identifier AUTO_SECURE. If this identifier is specified in the
PSF file, the PLACE Compiler will create a JEDEC file with the
security bit enabled (sets the G1 field). In most PLO programmers, the G1 field automatically enables the security bit
programming.
11

11

11

11

Default condition: AUTO_SECURE identifier is unspecified.
The JEDEC file generated will not have the G1 field. In most
PLD programmers, the user can enable or disable the security
bit programming.
11
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Signature Word
The signature word of the device allows a user to enter a
design revision number so that the design can be identifed after
the security bit of the PEEL device is enabled. Hence, the
signature word data can still be loaded even after the security
bit of the device is enabled.
The signature word feature is supported in the following
devices. Note that the number of 8-bit bytes in the signature
word is specified within the parenthesis.
PA7024 (8 bytes)
PA7128 (1 byte)
PEEL22CV10A+ (3 bytes)

PA7140 (2 bytes)
PEEL273 (2 bytes)
PEEL22CV1 OZ (3 bytes)

Format:

SIGNATURE 'signature str'

Example:

Signature 'REV. A'

Default condition: SIGNATURE identifier is unspecified,
which means that the signature word in the device JEDEC file
is unused. Note that if the ICT PDS-1 programmer is present,
this signature word can be programmed in the Program operation.
Zero-Power Bit
When the zero-power bit is set, the device can operate at a low
standby power condition ("sleep" mode). The device actually
senses the inputs or feedbacks for signal transitions. If there
are no signal transitions for a certain period, the device automatically goes to "sleep". Please refer to your ICT data book for
more information on the AC and DC device parameters.
The device which support the zero-power bit is:
PEEL22CV10Z
Format:

ZERO_POWER

The zero-power bit is set when the reserved identifier
ZERO_POWER is specified.
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Default condition: The ZERO_POWER identifier is unspecified. Like the signature word feature, the zero-power bit
can be set in the Program operation if the ICT PDS-1 programmer is present.

5.5 Clock and Input Pins
After labelling a clock or a dedicated input pin (pin that is not
associated to an Input Cell or INC) of the device using the
"Label" command in the Design operation, the PLACE software
automatically creates the pin assignment statement.
Format:

pin_label PIN pin_number

Example:

CLK1 pin 13

Please refer to section 5.6 for the pin label format.
Default condition: Unlabeled pin (no pin assignment statement) signifies that the pin is unused.

5.6 Pin and Cell Labels
Format:

First character:
Body of the label:

A .. z, a .. z, -, I, !
A.. z, a .. z, o.. 9, -, _

Examples:

Valid labels:
Invalid labels:

Addr10, -10, /OUT
_Add, 25MHz, /151N

The label is not case sensitive. The maximum length of the
label is 8 characters (including the I or ! character). When a I
or! character is added at the beginning of the label, the pin,
cell or node becomes an active Low signal path. Hence, a
TRUE logic (logic "1 ") is resulted when a Low signal is applied.
Example:
/A pin 1
B pin 2

"Active Low Input
"Active High Input

IOC (12 'C' Pos COM Feed_pin)
IOC (13 'D' Neg COM Feed_pin)
IOC (14 '/E' Pos COM Feed_pin)
IOC (15 '/F' Neg COM Feed_pin)

ICT, Inc.

"Output Polarity = Pos
"Output Polarity = Neg
"Output Polarity = Pos
"Output Polarity = Neg
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EQUATIONS
C.COM =A; "C=TRUE or 1 when A=LOW
D.COM = B; "D=TRUE or 1 when B=HIGH

The I or ! on the pin or cell labels only affect the active level
of the inputs or feedback paths (i.e. variables on the right
side of the equal sign in the equations). The polarity of the
outputs (i.e. outputs routed to the external pins) are not affected because they are controlled by the IOC configuration
statements. In the above example, the feedback active levels
and output polarities of cells C, D, E, and Fare:
Cell

Feedback Active Level

c

Output Polarity

High
High
Low
Low

D
/E
/F

High
Low
High
Low

5. 7 Cell Configurations
The cell configuration format statements are used to specify
the type of configuration of each cell in the selected device. In
most cases, knowledge of the cell configuration formats is not
necessary because the configurations of the IOC and LCC are
automatically modified by the PLACE architectural software.
~

Note that all the configuration statements are necessary for the
operation of the PLACE software. This means that you should
not delete any of these configuration statements including
the configuration statements for unused cells.

Format:
Input Cell in PA7140 and PA7128:
INC (pln_number 'pln_labef lnput_type)

Example:

INC (3 'A1' Reg)

110 Cell in PEEL Arrays:
IOC (pln_number 'pln_labef output_pol pln_type) <· Asslgned_LCC

Example:
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Logic Control Cell in PEEL Arrays only:
LCC (cell_number 'cell_labef fllp-flop_type clock buried_out ext_out)

Example:

LCC (1 A 'ADD1 O' D SumC Reg Reg )

1/0 Cell (or Macro Cell) in PEEL devices:
IOC (pln_number 'pln_labef output_pol pln_type feedback_type)

Example:

IOC (12 'OUT POS COM FEED_PIN)

Default condition: The default cell configurations are set by
the cell configuration statements in the "ANEWxxxx.PSF" files.
If the "New" function under the File menu command in the
Design operation is selected, the PLACE software reads the
ANEW file for the selected device (see Table 5-1) and sets the
default configurations found in the file.

ANEW File

Device

ANEW7024.PSF
ANEW7140.PSF
ANEW7128.PSF
ANEWVS.PSF
ANEW173.PSF
ANEW273.PSF .
ANEWG10.PSF .
ANEWV10.PSF .
ANEWV10A.PSF
ANEWV10P.PSF
ANEWV1 OZ.PSF

PA7024
PA7140
PA7128
PEEL18CV8
PEEL173
PEEL273
PEEL20CG10
PEEL22CV10
PEEL22CV1 OA
PEEL22CV1 OA+
PEEL22CV1 OZ

Table 5-1, PLACE ANEW Template Files

Parameters for the INC Format (PA7140 and PA7128 only)
Pin_Number

ICT, Inc.

The pin number that is assigned to the current Input
cell.
Device

INC Pin Numbers

PA7140 (PLCC)
PA7128

3-5, 19-21, 25-27, 41-43
2-6, 8-14

Pin_Label

See section 5.6 for the format of the pin label.

Input_type

The identifiers for the pin type parameter are:
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Identifier

Function

COM
REG
LAT

Combinatorial input
D-type registered input
D-type latched input

Parameters for the IOC Format (PEEL Arrays only)
Pin_Number

The pin number that is assigned to the current 1/0
cell.
Device

IOC Pin Numbers

PA7024
PA7140 (PLCC)
PA7128

2-11, 14-23
6-16, 18, 28-38, 40
15-20, 22-27

Pin_Label

See section 5.6 for the format of the pin label.

Output__pol

This parameter which refers to the output polarity of
the pin is controlled by the following identifiers:
Identifier

Function

POS
NEG

Positive Polarity for the Output
Negative Polarity for the Output

The output polarity "bubble" in the Design operation
of the PLACE software controls this parameter. In-

serting the I or ! character in the pin_label
does not affect the output (section 5.6).
Pin_type

The identifiers for the pin type parameter are:
Identifier

Function

10
REG
LAT
OUT
INCOM
INREG
INLAT
OUTREG
OUTLAT
DCOM
DREG

110

DLAT

1/0 with D-type registered input
1/0 with D-type latched input
Output only
Input only
Input only with D-type register
Input only with D-type latch
Output only with D-type registered feedback
Output only with D-type latched feedback
Output only with feedback from Sum-D
Output only with D-type registered feedback
fromSum-D
Output only with D-type latched feedback
from Sum-D

The parameters DCOM, DREG and DLAT are only
applicable for PA7140 and PA7128 devices.
Assigned_LCC
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The LCC that is connected to the current IOC.
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Parameters for the LCC Format (PEEL Arrays only)
Cell_number

The cell number that is assigned to the current Logic
Control cell. It ranges from 1A-6A, 1B-68, 1C-6C
and 1D-60. Figure 5-4 illustrates the cell number
organization for the PA7024 device.

~
~
~
~
~

~
~
~
~
~

~
~
~
~

~
~

§1

~
§] ~

Figure 5-4, LCC numbering system in PA7024
Device

LCC Assignments

PA7024
PA7140 (PLCC)
PA7128

1A-5A, 18-58, 1C-5C, 10-50
1A-6A, 18-68, 1C-6C, 10-60
1A-3A, 18-38, 1C-3C, 10-30

Refer to the IOC statement described in the previous
section for the assigned IOC for each LCC.

Ce/Lfabel

Refer to section 5.6 for the cell label format.

Flip-flop type

Specifies the type of register in the LCC. The dynamic
register type setting (RT signal) is also specified in
this parameter. The RT signal which comes from
the Global Cell dynamically changes the register
type in the LCC during normal (5V) operation.
Identifier

Function

D

D-type register (RT mode is disabled)
T-type register (RT mode is disabled)
JK-type register (RT mode is disabled)
D-type register when RT= FALSE,
T-type register when RT= TRUE
D-type register when RT= FALSE,
JK-type register when RT= TRUE
T-type register when RT= FALSE,
D-type register when RT= TRUE
JK-type register when RT= FALSE,
D-type register when RT= TRUE

T
JK
DT
DJK
TD
JKD

ICT, Inc.
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Clock

Controls the type of clock for the current LCC.
Identifier

Function

POS

High speed (system) clock from pin 1 or 13
that triggers the register on the rising edge.
Note: Global cell controls which pin to use
for system clock
Register is triggered on the falling edge of
the system clock
Local clock coming from the Sum C term.
Register is triggered on the rising edge of
the clock signal
Local clock coming from the Sum D term.
Register is triggered on the falling edge of
the clock signal

NEG
SumC
SumD

Buried_Out

Output of the LCC that is fed back internally to the
array.
Identifier

Function

Reg

Internal output from the output of the
register
Internal output from the Sum A term (i.e.
the input of the register)
Internal output from the Sum B term
Internal output from the Sum C term

SumA
SumB
SumC

Ext_Out

Output of the LCC which is connected to the 1/0
cell. This output sends the signal of the device to
the outside world. The final output signal depends
on the output polarity of its assigned IOC.

Parameters for the IOC Format (PEEL Devices)
Pin_Number

5-14

The pin number that is assigned to the current 1/0
cell. Below lists the PEEL 1/0 pin numbers.
Device

110 Pin Numbers

PEEL18CV8
PEEL173,
PEEL273,
PEEL20CG10,
PEEL22CV10,
PEEL22CV1 OA,
PEEL22CV1 OA+,
PEEL22CV1 OZ

12 -19
14- 23

Pin_Label

See section 5.6 for the format of the 1/0 pin label.

Output_pol

This parameter which refers to the output polarity of
the pin is controlled by the following identifiers:
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Identifier

Function

POS
NEG

Positive Polarity for the Output
Negative Polarity for the Output

The output polarity "bubble" in the PLACE
architectural software controls this parameter. Inserting the I or ! character in the pin_label does
not affect the output (section 5.6). Hence, only this
parameter controls the polarity of the output.
Pin_type

The identifiers for the pin type parameter are:
Identifier
COM
REG
OUTCOM
OUT REG
IN

Function
1/0 with combinatorial output

1/0 with D-type registered output
Combinatorial output only
Registered output only
Output disabled (May or may not be an
input depending on the feedback type)

Note that only the PEEL 18CV8, 20CG10, 22CV10,
22CV1 OA, 22CV1 OA+ and 22CV1 OZ have output
registers. The REG and OUTREG are not applicable for PEEL 173 and 273 devices.
Feedback_type

ICT, Inc.

Specifies the type of feedback for the selected
device. This parameter is only applicable for
devices such as PEEL18CV8, 20CG10,
22CV1 OA+ and 22CV1 OZ. The feedback types of
the PEEL22CV1 o and 22CV1 OA are automatically
set to FEED_PIN and FEED_REG for COM and
REG output types respectively. Only FEED_PIN
feedback type is available in the PEEL 173 and
273 devices.
Identifier

Function

FEED_PIN
FEED_REG
FEED_OR

Feedback from the pin
Feedback from the output of the register
Feedback directly from sum term (i.e. prior
to the register)
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PEEL Arrays
The global configurations for PEEL Arrays are used to set up
the global signals for the LCCs, IOCs and INCs.
Format:

Global=
GBC (A
GBC (B
GBC (C

Example:

n
LCC_clock IOC_clock)
LCC_clock IOC_clock)
_
INC_clock)

"n = 1 or 2 cells
"Global Cell A
"Global Cell B
"Global Cell C
"(PA7140 and
"PA7128 only)

Global = 1
GBC (A Clk1 Clk2)
GBC (B Clk1 Clk2)
GBC(C _
Clk1)

Table 5-2 shows the definitions of the Clk1, Clk2 and PClk
terms used in the GBC configuration statements.

Clk1 and Clk2 terms - specify the system clock pin to use.
Device
PA7024
PA7140
(PLCC)
PA7128

Clk1 pin
1
2

Clk2 pin
13
24
28

PClk terms - specify to use the product term for the global clock.
Device
PA7024
PA7140
(PLCC)
PA7128

IOCs by PClkA

2 - 11
6 - 16, 18
15-20,22-27

IOCs by PClkB

INCs by PClkC

14- 23
28 - 38, 40

none
3-4, 19-21,
25-27, 41-44
2-6, 8-16

Table 5-2, Definitions of global clock terms
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Global= n

Then parameter equals 1 or 2. This paramter sets
the number of global cells to be used for the LCCs
and IOCs. If one global cell is used, then global
cell A controls the global signals for all LCCs and
IOCs in the device and global cell B configuration
statement is ignored . If "Global= 2" is specified,
then Global Cell A controls the global signals for
the IOCs and LCCs in which the IOCs are on the
left side of the device. Global Cell B then controls
the global signals for the IOCs and LCCs in which
the IOCs are on the right side of the device. See
Table 5-2.

Below are the descriptions of each parameter in the GBC (GBC
A, B or C) configuration statements.
LCC_clock

Sets the system clock pin for the LCC global clock.
The two options available are the Clk1 and Clk2
pins. Refer to Table 5-2 for the Clk1 and Clk2 pin
numbers for each PEEL Array.

IOC_clock

Sets the system clock pin or product term for the
IOC global clock. The options available are Clk1,
Clk2, and PCLKA or PCLKB. See Table 5-2.

INC_clock

Sets the system clock pin or product term for the
INC global clock. The options available are Clk1,
Clk2 and PCLKC. See Table 5-2.

PEEL Devices
In the registered PEEL devices such as PEEL 18CV8, 20CG10,
22CV10, 22CV1 OA, 22CV1 OA+ and 22CV1 OZ, the global configurations are represented by the global node assignments.
These global nodes control the asynchronous reset and
synchronous preset product terms.

Format:
Example:

ICT, Inc.

node_label NODE node_number

AC node 21

"For PEEL 18CV8 device

node_label

Please refer to section 5.6 for the node label format.

node_number

The node assignment numbers for the selected
device are:
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Device

Node Number

Function

PEEL 18CV8

21
22

Asynchronous Reset
Synchronouse Preset

PEEL20CG10,
PEEL22CV10,
PEEL22CV10A,
PEEL22CV1 OA+,
PEEL22CV1 OZ

25
26

Asynchronous Reset
Synchronous Preset

5.9 Comments
In the PLACE software, comments are available so that each
component of the design which may not be readily apparent
from the source file is explained. Comments do not affect the
design itself. Liberal use of comments can make a PSF design
file easy to understand.
Format:

Example:

" Insert comments here ...

"Enable security bit programming

A comment begins with a double quotation mark (") and ends
with the end of line. A comment can be specified anywhere in
the PSF design file.
~

Note that the double quotation marks are not required if the
comments are specified within the "DESCRIPTION" and
"END_DESC" reserved identifiers.

5.10 Macro Definitions
The macro definitions are used for:
- declaring constants so to make the design easier to understand.
- declaring commonly used equations so that they need
not be repeated throughout the design file.
- assigning the state cells and set variables for state
diagram designs.
- assigning the pins or cells for truth table designs.
The macro definitions in the PSF design file are located after
the reserved identifier DEFINE but prior to one of the following
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reserved identifiers: STATE_DIAGRAMS; TRUTH_TABLE; or
EQUATIONS (whichever is specified first). Macro definitions
that are specified via the "Macro" function in the Design operation are automatically inserted into this location.

Format:

DEFINE
specify macro definitons here...
STATE_DIAGRAMS, TRUTH_TABLE or EQUATIONS

Example:
DEFINE
OSTATE = [ADD10 SU810 02 01 00]
Clear
= 11 800000
ShowHit
= 11 800001
AddCard
= 11 811011
Add_10
= 11 810010
Wait
= 11 800010
Test_17
= 11 80011 o
Test_22
= 11 800111
ShowStand = 11 800101
Show8ust
= 11 800100

"State_Diagram Assignment
"Constant Declaration

is_Ace = !V4 & !V3 & !V2 & !V1 & VO;

"Equation Declaration

SCORE = [S4 S3 S2 S1 SO]
8CD2 = [D5 D4]
8CD1 = [D3 D2 D1 DO]

"Truth table input assignment
"Truth table ouput assignment
"Truth table output assignment

STATE_DIAGRAM OSTATE

"Ends the Macro Definitions

Macro Constants
Const_label

Examples:

Clear = 11 800000
ShowHit = 11 800001

Const_/abel

constant

The format for the label of the constant is similar to
that of the pin or cell label (see section 5.6) with
two exceptions, and they are:
1.
2.

JCT, Inc.

=

Format:

The length of the label can be up to 20
characters long instead of 8.
The I or ! character cannot be used at
the beginning of the label.
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Specifies the value of the constant in decimal,
hexadecimal, octal or binary numbering system.
The format for the constant is:
symbol + number
The symbols for the numbering systems are:
Numbering system

Symbol

Decimal
Hexadecimal
Octal
Binary

none (default)
Hor 11 h
11 0or 11 0
11 Bor 11 b
11

Examples: 15

(decimal)
(hexadecimal)
(octal)
"81111 (binary)

"HF
"017
Macro Equations
Format;
Example:

Eqn_label

= complex_eqn

ls_ACS = !V4 & !V3 & !V2 & !V1 & !VO;

Eqn_label

The label for the equation macro is similar to that for
the label for the macro constant. See previous section.

Comp/ex_eqn

Macro equation can be specified using the logic
operators (), I, &, # and $ (refer to section 5.13).
The input side of a macro equation (i.e. the right
side of the "=" symbol) is made up of pin or cell
labels, or labels from other macro equations.
Below is an example of a macro equation which is
a function of other macro equations.
DEFINE
Mac1 =A&B;
Mac2=C#D;
Mac3 = Mac1 $ Mac2;

"Macro level 1
"Macro level 1
"Macro level 2

If the macro equation uses only pin and/or cell labels,
then it has one macro level. If it uses previously
defined macro equation labels in addition to the
pin and cell labels, then it has multiple macro
levels. The number of macro levels depends on
whether the macro equation labels used in the
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equation are functions of more macro equation
labels themselves.
The number of macro levels is limited by the total
number of characters (maximum of 1024 characters) in the "flattened" macro equation, i.e. the
input side of a flattened macro equation consists
of only pin and/or cell labels. Note that the additional spaces between the input variables in the
macro equation are automatically deleted by the
PLACE Compiler. Example: A maximum of 5
macro levels can be used if each (unflattened)
equation level has less than 200 characters. Typically, the maximum macro level is about ten.
Macro State Cell Assignments for STATE DIAGRAMS

The state cell assignment defines the pin or cell labels to be
used by the state diagram design syntax.
~

The "Allocate" command in the "Design" menu window of the
Design operation automatically generates the state cell assignment definition and STATE_DIAGRAM design syntax. An example is shown below.
DEFINE
OSTATE = [ADD10 SUB10 02 01 00]
STATE_DIAGRAM OSTATE
"enter design here ...
END;
Format:

Example:

ICT, Inc.

state_label

= [Cell1

Cell2 Cell3 ... Celln]

OSTATE = [ADD10 SUB10 02 01 00]

State_label

The state label format is similar to that of the pin or
cell label (section 5.6). The only exception is that
the state label does not allow the use of the I or !
character at the beginning of the label.

Cell(n)

Specifies the cell labels to be used as state cells by
the state diagram. A maximum of 24 cells can be
allocated as state cells. Each state cell label must
be separated by a space. The most and least significant bit of the state cells are the first and last al-
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located cells respectively in the cell assignment
definition, i.e. Cell1 is the Most Significant Bit and
Celln is the Least Significant Bit.
Macro Set Variables in State Diagrams
Outputs in a state diagram can be assigned to a set variable so
that the logic of these outputs can be specified with a numeric
constant. The constant can be specified in a binary, octal,
hexadecimal or decimal (default) numbering system.
Format:
Example:

seLvar

=

[ Ce/11

Ce/12 Ce/13 ... Ce/In)

DEFINE
TEST = [T2 T1]
OUT = (Y3 Y2 Y1 YO]

"State cell assignment
"Set variable assignment

STATE_DIAGRAM TEST
State O:
OUT= O;
"Macro Set variable OUT
"Y3-0 = 0000
Goto 1;
State 1:
OUT="HB;
"Y3-0 = 1011
Goto 2;
State 2:
OUT= 11 B1100;
"Y3-0 = 1100
Goto 3;
State 3:
Gotoo
END;

SeLvar

The format is similar to the state label format used
for the state cell assignments.

Ce/In

Specifies the assigned pin or cell label.

The macro set variable equation feature is only available within
the state diagram design syntax. Also, only one macro level
is avallable in the macro set variable assignment.
Macro Cell Allocation for Truth Tables
The "Allocate" command in the PLACE Design operation can
also be used to allocate the pins and cells for the truth table
design. The pins and cells can be allocated as truth table
inputs, truth table outputs or both. If a cell or pin is allocated as
the truth table input and output, then it is an 1/0. The output of
the 1/0 is then enabled or disabled via the .OE equation.
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The following example shows the allocation of the pins and cells for
the truth table design "TABLE1 ".
Example:

TRUTH_TABLE TABLE1
(14 13 12 11 10 -> Y5 Y4 Y3 Y2 Y1 YO)
END;

Another method of allocating the pins and cells is through the
macro set variable method. The inputs and outputs of the truth
table can be assigned to the macro set variables in the DEFINE
section. The labels of these macro set variables are then used
in the truth table design syntax instead of the pin and cell
labels.
Format:
Example:

table_/abel = [Ce/11 Ce/12 Ce/13 ... Ce/In]
DEFINE
Input= [14 13 12 11 10];
Y_HiBit = [Y5 Y 4];
Y_LoBit = [Y3 Y2 Y1 YO];
TRUTH_TABLE TABLE1
(Input -> Y_HiBit Y_LoBit)
11 H15
11 HA
->
1
"14-o=10101,Y5-0=011010
11 H16
11 HB
->
1
"14-0 = 10110, Y5-0 = 011011
END;

Table_/abel

The format is similar to the state label used for the
state cell assignments.

Ce/In

Specifies the assigned pin or cell label.

Please refer to section 5.12 on "Truth Table Design Syntax" for
more information.

5.11 State Diagrams
The state diagram language is used to implement state
machine designs. In the PLACE software, the state machine
design is specified between the "STATE_DIAGRAM
state_labef' and "END" identifiers. These identifiers together
with the state cell allocation definition (refer to section 5.10)
are automatically created when the LCCs or IOCs are allocated
for the state machine via the "Allocate" command in the
Design operation.

ICT, Inc.
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Format:

DEFINE
State_label = [Cell1 Cell2 ... Celln]
STATE_DIAGRAM State_label
STATE state_o: "usually Reset state
STATE state_ 1:

STATE state_n: "last state
END;
State_label

The state label format is similar to that of the pin or
cell label (see section 5.6). The only exception is
that the state label does not allow the use of the I
or ! character at the beginning of the label.

Celln

Specifies the cell labels to be used as state cells by
the state diagram. A maximum of 24 cells can be
allocated as state cells. Each state cell label must
be separated by a space. The most and least
significant bit of the state cells are the first
and last allocated cells respectively, i.e. Cello
and Celln are MSB and LSB respectively.

State_n

Specifies the state number which can be in the form
of a numeric value or a constant label defined in
the DEFINE section. Refer to "Macro Constants"
in section 5.10.

The PLACE state diagram syntax includes:
•

GOTO

•

IF·THEN-ELSE

•

CASE-ELSE-ENDCASE

•

WITH-ENDWITH;
(used in conjunction with GOTO, IF-THEN-ELSE and
CASE-ELSE-ENDCASE)

GOTO
Format:

GOTO state_num;

Examples: GOTO ShowHit; or
GOTO 11 800001 ;
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State_num

Specifies the state number for the unconditional
jump. A numeric representation of the state or a
constant label defining the numeric value in the
macro definition section can be used to indicate
the state number.

The GOTO statement is used to unconditionally jump to a
different state on the next clock edge.
IF-THEN-ELSE

Unlike the GOTO statement, the IF statement provides a conditional jump to the next state. If the condition is satisfied, the
logic jumps to the state specified after the THEN identifier. If
the condition is not satisfied, the ELSE state will be the next
state.
Format:

Example:

IF condition THEN state_num1
ELSE state_num2;
if (!CARDIN) then AddCard
else ShowHit; "AB00001 can be used
"instead of ShowHit.

Condition

A boolean expression condition which can be in the
form of a macro equation label (see "Macro Equations" in section 5.10).

State_num1

If condition is satisfied, then jump to this state on the
next clock edge.

State_num2

If condition is not satisfied, then jump to the alternate
state.

CASE-ELSE-ENDCASE
Format:

CASE
condition_ 1: state_num;
condition_2: state_num;

condition_N: state_num;

"ELSE is optional

ELSE
state_num;

END_CASE;

JCT, Inc.
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Example:

case
!Bust: ShowStand;
Bust & !Ace: ShowBust;
Bust & Ace: Sub_10;
""B01111 can be used
endcase;
"instead of the constant label
"Sub_10.

Condition_N

The condition must be a boolean expression. It can
also be in the form of an equation label defined in
the macro definition section (see "Equation Declaration" in Macro Definitions).

State_num

The number represents the state for the conditional
jump.

The CASE statement is simply an IF statement with multiple
conditions. It lists a sequence of mutually-exclusive conditions
and their corresponding state numbers. If a condition in the list
is satisfied, the logic jumps to the corresponding state on the
next clock edge. If no conditions are satisfied, then it jumps to
the state number specified after the ELSE reserved identifier.
~

Note that the ELSE identifier is optional. If it is not specified and
the conditions in the CASE list are not satisfied, then the next
state is dependent on the type of flip-flop that is set up in the
state cells. For instance, if the state ce~ls have D-type registers,
then the next state will reset to state 0. If the state cells have
T-type registers, then it will hold at the current state.

WITH-ENDWITH
The WITH statement is used in conjunction with the GOTO,
CASE-ELSE-ENDCASE or IF-THEN-ELSE statements. It allows outputs to be specified so that they use the same clock
edge(rising or falling clock edge dependent on the configuration) that triggers the next state. It is recommended to use
only registered outputs with the WITH statement.
Format:

WITH
registered output equations ...

ENDWITH;
Example:
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if (A & B) then 1 with
C = IN; "C is a D-type registered output
D = 1; "D is a T-type registered output
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endwith;
else 2;
In the above example, when the expression (A & B) is true jump
to state 1 on the next clock edge. Using the same clock edge,
the output C latches the data from the input IN. Also, output D
will toggle (since it is a T-type register) on same clock edge. If
the condition (A & B) is not satisfied, the logic jumps to state 2
without changing the signals on outputs C and D.
Register Types of the "allocated" state cells
Prior to entering your state diagram design syntax, the outputs
of the allocated LCCs and IOCs must be configured as
registered outputs. The type of registers used, whether they
are D, Tor JK type registers, affect the behavior of the state
diagram. An example is shown in Figure 5-5.

DEFINE
ST_TEST= [S2 S1 SO]
STATE_DIAGRAM ST_TEST
state O: goto 1;
state 1 : case
A&B&C: 0;
A&B&/C: 3;
/A&/B&/C: 4;
end;
state 2: goto 5;
state 7: goto O;
END:

All conditions in the case statement of state 1 failed. Hence,
the equations for the state cells
SO, S1 and S2 are:
SO= O; S1 = O; S2 = O;
Question:
What is the next state?

so, s1

If D-type registers are used for
and S3 state cells:

so,

Answer:
Output of a D-type register follows
the input on the next clock edge.
Hence after clocking the SO, S1
and S2 registers, the outputs
equate to O which is the condition
of state 0. So, the state o Is the
next state.

Answer:
Output of a T-type register follows
the previous state on the next clock
edge if the input is FALSE or "O".
Hence after clocking the SO, S1
and S2 registers, the outputs follow
the previous state of each register.
So, the state 1 Is the next state.

If T-type registers are used for
S1 and S3 state cells:

Figure 5-5, State diagrams with D and T type registers
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Outputs of the State Diagram
The two types of outputs in the PLACE state diagram are the
synchronous and asynchronous outputs.

- Synchronous Outputs: These are registered outputs
which use the same clock as the state machine. The
outputs follow the input data on the next clock edge.
- Asynchronous Outputs: These are combinatorial outputs. The outputs follow the input data immediately.
Please refer to Figure 5-6 for the synchronous and
asynchronous output examples.
~

Note that the state diagram outputs must first be configured
using the PLACE architectural software. For instance if a
registered output is required, the type of flip-flop (D,T or JK)
and clock (pin or sum term) must be configured in the LCC/IOC
or IOC screen in the Design operation.
The two classes of state machine designs that can be created
using the PLACE software are the Mealy and Moore machines.
Both of these state machine designs can utilize the
synchronous and asynchronous outputs.

Mealy Machine
A Mealy state machine is defined as having outputs which are
a function of two sets of variables:
- the present input conditions
- the present state of the machine
Examples:

Me_Reg = INPUT;
Me_Com = INPUT;

"Registered output
"Combinatorial output

Moore machine
A Moore state machine is defined as having outputs which are
strictly a function of the state of the machine.
Examples:
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Mo_Reg = O;
Mo_Com = O;

"Registered output
"Combinatorial output
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Outputs are functions
of State and Inputs
Next
State
Decode
Logic

Inputs

Registers

Output
Decode

Registers

Output
Decode

Mealy State Machine

Outputs are functions
of State only
Inputs

Next
State
Decode
Logic

Moore State Machine

Figure 5-6, Mealy and Moore State Machines

How the PLACE State Diagram works

Figure 5-7 shows a state diagram example (SDEXAMPL.PSF)
using the PLACE state diagram language. This example does
not implement any specific application except to illustrate the
usage of the state diagram language. The features that are
illustrated in the example are:
- GOTO, CASE-ELSE-ENDCASE, IF-THEN-ELSE and
WITH-ENDWITH syntax.
- Synchronous and asychronous outputs in Mealy and
Moore state machines
- Set Equations for Moore Machine Applications (refer to
section 5.1 O on "Macro Definitions")
The PLACE Simulate waveforms for the example are shown in
Figure 5-8.

ICT, Inc.
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DEFINE
EXAMPLE= [S1 SO]

"State cell assignment definition

Grp_Out = [OUT3 OUT2 OUT1 OUTO]

"Group outputs assignment

StO = O;

"default - Decimal

St1 = AH1;

" AH

= AQ2;

" AQ

-Octal

St3 = AB11;

" AB

- Binary

lnO = /12 & /11 & /10

"Input conditions for the State Diagram

St2

- Hexadecimal

ln1 = /12 & /11 & 10
ln2 = /12 & 11 & /10
ln3 = /12 & 11 & 10
ln4 = 12 & /11 & /10
ln5 = 12 & /11 & 10
ln6 = 12 & 11 & 110
ln7 = 12 & 11 & 10
ln4T06 = ln4 # ln5 # ln6

STATE_DIAGRAM EXAMPLE
"Goes to STATE StO upon device power-up (all registers reset on power-up)
STATE StO:
Mo_Reg = O;

"Moore registered output

Mo_Com = O;

"Moore combinatorial output

Grp_Out = O;

"Moore group combinatorial output, Outa-o = 0000

Me_Reg = INPUT;

"Mealy register output

Me_Com =INPUT;

"Mealy combinatorial output

IF ln1 THEN St1

"If ln1 =true, then go to STATE St1,

ELSE StO

else remain at STATE StO.

STATE St1:
Grp_Out = ABQ110; "Out3-o = 0110. These combinational outputs will be valid after the
"present state occurs with a single propagation delay (tpd).
Me_Reg = INPUT;

"This registered output will be valid on the next clock edge,
" i.e. clock edge for the NEXT STATE (StO, St1 or St2 depending
"on which CASE condition is satisfied).

Figure 5-7 PLACE State Diagram Language for SDEXAMPL Design Example
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Me_Com= INPUT;

"This combinational output will be valid after the present
"state occurs with a single propagation delay (tpd).

CASE
/12 & 11 & 110: StO
WITH

"Go to StO if (/12&11 &/IO)=ln2=true

Mo_Reg = 1; ''This output equals to 1 on the next clock edge
"only if the NEXT STATE is StO.
ENDWITH;
ln3:

ST2;

"Go to St2 if ln3=true

St1

"If no condition in the CASE list is satisfied, remain at STATE St1.

ELSE
ENDCASE;
STATESt2:
Grp_Out ="HA;

"Outa-o = 1010. These combinational outputs will be valid after the
"present state occurs with a single propagation delay (tpd).

IF (ln4To6)

THEN St3

"If (ln4To6)=true, then go to STATE St3,

WITH
Me_Reg = INPUT;

"This registered output will be valid on the next
"clock edge only if the NEXT STATE is St3.

ENDWITH;
ELSE
St2;

"If (ln4To6)=false, then remain at STATE St2.

STATESt3:
Mo_Reg = 1;

''This output equals to 1 on the next clock edge.

Mo_Com = 1;

"This combinational output will be valid after the present state
"occurs with a single propagation delay (tpd).

Grp_Out = O;
Me_Reg= O;

"Outa-0 = 0000.
"Reset all Mealy outputs

Me_Com= O;
GOTOStO;
END;

"Go to STATE StO unconditionally.
"End of STATE DIAGRAM EXAMPLE

Figure 5-7 PLACE State Diagram Language for SDEXAMPL Design Example
(Continued)
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Figure 5-8 Simulate Waveforms for the SDEXAMPL Design Example

5.12 Truth Tables
In addition to state diagrams and equations, truth tables can be
used to describe the logic designs.

Format 1:

TRUTH_TABLE table_label
(Int ln2 ... lnN ·> Out1 Out2 ... Out/II) or

END;
Format 2:

TRUTH_TABLE table label
( Input ·> Output)

END;
Example 1: TRUTH_TABLE DECODE "3-to-8 Decoder
(C 8 A -> YO Y1 Y2 Y3 Y 4 Y5 Y6 Y7)
0 0 0 -> 1 0 0 0 0 0 0 0

0 0 1 ->
0 1 0 ->

0
0

1
0

0 0
1 0

0
0

0
0

0
0

0
0

.

END;
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Example 2: DEFINE
SCORE= [S4 S3 S2 S1 SO]
8CD2 = [DS D4]
"
8CD1 = [D3 D2 D1 DO)
TRUTH_TA8LE 81N28CD "From JACK7024.PSF
( SCORE -> 8CD2 8CD1)
0
->
0
O;
1
->
0
1;
2
->
0
2;

END;
Table_label

The format for the label is similar to that for the pin
or cell label (section 5.6) with one exception, and
that is the I or ! character is not allowed at the
beginning of the label.

lnN (Format 1)

Specifies the pin or cell labels to be used as truth
table inputs. The inputs can be either registered or
combinatorial. Input data must be in binary (0 or

1) format.
OutN (Format 1)

Specifies the pin or cell labels to be used as truth
table outputs. Like the inputs, truth table outputs
can be either registered or combinatorial. Output

data must be in binary (0 or 1) format.
Inputs (Format 2) Specifies a macro defined group of registered or
combinatorial pins or cells to be used as truth
table inputs. Input data can be in decimal
(default), hexadecimal (11 H or 11 h), octal (11 0 or 11 0)
or binary (11 8 or 11 b) numbering system. Only one
macro level is available for the macro input set.
Outputs (Format 2) Specifies a macro define group of registered or
combinatorial pins or cells to be used as truth
table outputs. Input data can be in a decimal
(default), hexadecimal (11 H or 11 h), octal (11 0 or 11 0)
or binary (11 8 or 11 b) numbering system. Only one
macro level is available for the macro output set.

An additional feature is that both the truth table formats
can be used in a single truth table design.

!CT, Inc.
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Alternate truth table description which uses both formats for
Example 2 is:
TRUTH_TABLE BIN2BCD
( SCORE -> DS D4 BCD1)
0
-> 0 0
O;
1
-> 0 0
1;
2
-> 0 0
2;

END;

5.13 Equations
The boolean logic equations are the primary methods for
specifying logic functions in the PLACE software.
~

The PLACE architectural software automatically creates the
equation for each sum or product term in the cell when it is
labeled via the "Label" command in the "Design" menu of the
Design operation. An example of a newly labeled LCC is shown
below.
A.D = O;
A.AP= O;
A.AR= O;
A.CLK = O;
Format:

Output_label.EXT

=

logic_equation;

(The semicolon at the end of the equation is used by
the PLACE software to mark the end of the equation
when displaying the equation in the Equation Display
window. Refer to "PSF Text Display Windows" in section
4.12)
Examples: C1 .COM= (VO & Add10 & Sub10 & SO);
SO.T =(VO & Add10 & Sub10);
XOR1 .COM= A$ B;
XOR2.COM =(!A & B) +(A & !B);
Output_/abel
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This is the pin or cell label that has been entered via
the "Label" command. Refer to section 5.6 for the
format of the label.
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.EXT

The dot extension of the output is automatically
appended to the output label by the PLACE
software. The type of extension that is appended
on each output label depends on the configuration
of the pin or cell, the specific function of the
product or sum term, and the device type. Refer to
Figure 5-9.

Logic_ equation

This is the boolean logic expression that consists of
inputs, feedbacks and logic operators. Table 5-3
shows the functions and priorities of the logic
operators available in the PLACE software.

O~erator

( )
! or I
& or*
#or+

$

Logic Function
Logical organization
NOT
AND
OR
Exclusive-OR

Priorit)'.
1

2
3
4
5

Table 5-3, Priorities of logic operators in PLACE
~

The output equations can be moved to other locations of the
PSF design file as long as they are specified after the reserved
identifier EQUATIONS. However, the PLACE software operation will be affected if the unused or any other equations
generated by the PLACE software are deleted. This means that
all equations, whether they are used or unused, are continuously referenced by the PLACE software.

Functions of the Dot Extensions in the equation labels
In the PLACE source file, each of the Dot extensions represents a specific function. Figure 5-9 details the functions of all
Dot extensions.

ICT, Inc.
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PEEL Array
Sum Term
Sum A

Dot Extension
.COM

Combinatorial Internal/External Output
D Input of the Register
T Input of the Register
J Input of the Register
Sum A term is unused

.D
.T
.J
.SumA
Sum B

LCC Function (unless stated otherwise)

.COM
.AP
.SumB

Combinatorial Internal/External Output
K Input of the Register
Asynchronous Preset for Register
Sum B term is unused

Sum C

.COM
.CLK
.AR
.SumC

Combinatorial Internal/External Output
Asynchronous Clock for Register
Asynchronous Reset for Register
Sum C term is unused

Sum D

.CLK
.OE
.FB
.Sumo

Asynchronous Clock for Register
External Output Enable Control (IOC)
Buried feedback (PA7140 and PA7128)
Sum D term is unused

.K

PEEL 173/18CV8
PEEL20CG10/22CV10/22CV1 OA/22CV1 OA+/22CV1 OZ
Devices
Prod Term

Dot Extension

AndA

.OE
.AndA or .And

Sum B

.COM

Function
External Output Enable Control
Product (And) A term is unused

Combinatorial External Output
D Input of the Register (not applicable for
PEEL173 device)
.SumB or .Sum Sum B term is unused

.D

PEEL273 Devices
Sum Term

Dot Extension

Function

Sum A

.OE
.SumA

External Output Enable Control
Sum A term is unused

SumB

.COM
.SumB

Combinatorial External Output
Sum B term is unused

Figure 5-9, Functions of the Dot Extensions in the Equation Labels
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Logic Reduction Compiler Directive (For Equations Only)
A compiler directive is available to prevent redundant terms in
the equations from being removed during the logic optimization
process. Sometimes redundant terms are intentionally added to
avoid race or hazard conditions, especially in asynchronous
applications.
Format:

@REDUCE ON or @R+
@REDUCE OFF or @R-

Example:

@R"same as@Reduce Off
G_Latch.COM =
"Gated Latch Application
LAT_EN & LAT_IN
!LAT_EN & G_Latch
LAT_IN & G_Latch; "redundant term to fix hazard
@R+
"same as @Reduce On

@Reduce On

Equations succeeding this directive will be optimized.
Redundant terms will be removed from the equations. This is the default condition.

@Reduce Off

All equations specified after this directive will be flattened (i.e. converted to Sum-of-Product equations
from complex equations) but not optimized.
Redundant terms will be left in the equations.

Equations of the Outputs used for State Diagrams or Truth Tables
Boolean equations are generated for all pins and cells that are
labeled via the "Label" command, including those that are
specifically used for state diagram or truth table designs.
These equations if they are unmodified do not affect the
logic of the state diagrams or truth tables because they
always equate to zero. However, if the equations are modified
and they do not equate to zero, then they will be logically ORed
with the boolean equations that are transformed from the state
diagram or truth table design syntax by the PLACE compiler.

ICT, Inc.
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6.0 PLACE Application Examples
6.1 Overview
There are several PLACE application examples provided with
the PLACE software. All application files included with the
PLACE software are listed in Table 6-1.
Some examples provided are to demonstrate the implementation of a variety of standard logic functions such as gates,
registers, counters, and etc. To learn the most from these
examples, read each file in the Design Operation, review the
description and explore the architecture and design entry
(equations, state-diagrams or truth-tables) of each file.
For more detailed information on any of the application examples, please select the Document operation to print out the
PSF design file or other applicable graphics and text files.

JCT, Inc.
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6.2 DEM01A.PSF - PA7024

File Name

Device

Descri~tlon

DEM01A.PSF

PA7024

Demonstration design for PA7024
which includes Basic Gates and
Registers, 8-bit Down Counter, 2-bit
State Machine, 4-bit Shift Register
and 8-bit Bidirecional 1/0 Port

GATES1 .PSF

PA7024

Basic Gates (part of DEM01 A.

REG1.PSF

PA7024

Basic Registers, 8-bit Down Counter,
2-bit State Machine and 4-bit Shift
Register (all are part of the DEM01 A)

Bl_PORT.PSF

PA7024

8-bit Bidirectional 1/0 Port (part of
DEM01A)

COUNTER1 .PSF

PA7024

8-bit Down Counter with Preset,
Reset and Hold (part of DEM01 A)

TIMER.PSF

PA7024

16-Bit Programmable Clock
Generator/Interrupt Timer

JACK7024.PSF

PA7024

Blackjack Machine Example

TC7140.PSF

PA7140

8-bit Time/Counter

ST7128.PSF

PA7128

4-Bit State-Machine and 8-Bit Counter

V8GATES.PSF

18CV8

Basic Logic Gates

V8REGS.PSF

18CV8

Basic Registers and Latches

V8CLKADD. PSF

18CV8

Clock Divider Address Decoder

V8BUSMUX.PSF

18CV8

Bus Programmable 8-to-1 Multiplexer

V8FCNTR.PSF

18CV8

8-bit Counter with Function Controls

V8CPORT.PSF

18CV8

Change-of-State Input Port with
Interrupt

V8SYNC.PSF

18CV8

Synchronization Circuit.

PRl173.PSF

173

16-to-4 Priority Encoder

V1 OCNT8.PSF

22CV10

8-bit Up/Down Loadable Counter
with Carry-out or Borrow-in

PARV10A

22CV10A 9-bit Even/Odd Parity Generator/
Checker

V10ZPORT

22CV10Z Change-of-State Input Port with
Interrupt

Table 6-1 , PLACE application examples

6-2

ICT, Inc.

6.0 PLACE Application Examples

6.2 DEM01A.PSF - PA7024

6.2 DEM01A.PSF - PA7024
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Figure 6-1, PLACE pin block diagram of DEM01A.PSF
The PLACE design file DEM01 A.PSF incorporates several applications within one design, including: Basic Gates, Basic
Registers and Latches, 8-bit Counter, Bi-Directional 1/0 Port
and a Divide-by-2 Clock design. Figures 6-1 and 6-2 show the
PLACE pin block and equivalent schematic diagrams.
· GATES Basic combinatorial functions including AND, OR,
NOR, NAND, EXOR, Inverter, 4-to-1 mux, and 4-bit comparator.
· REGS Basic registers including D, T and JK flip-flops with
independent clocks, presets and resets, an SR Latch (for
debouncing inputs), a gated-latch (LAT1), a basic storage
register (REG1 ), a 2-bit state machine (SO,S1 ), and a 4bit shift register (SHF0-3).
· COUNTER An 8-bit down counter with Hold, Preset and
Reset.
· PORT An 8-bit bi-directional 1/0 port with registered input.
The mode inputs, MODE1 and MODE2, control application
selection. Pins names A through H are used as inputs and/or
control, pins I through P are used as outputs. The outputs of
each application are selected via eight 4-to-1 muxes. Output
enable and direction (in PORT mode) are selected by CONTROL. Sections 6.3 through 6.6 describe the individual application in the DEM01 A example.
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Figure 6-2, Logic schematic of DEM01A.PSF
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6.3 GATES1.PSF

6.3 GATES1 .PSF
This design is one of four main applications that were integrated into a single PA7024 in the DEM01A application example. As a single application, the basic combinatorial gate
functions can be easily reviewed. Included are:
• AND, OR, NOR, NANO gates with 8 inputs (inputs A to H)
• Exclusive-Or gate (inputs A and B)
• 4 to 1 Multiplexor (inputs A,B,C or D selected by E and F)
• 4-bit Comparator (inputs ABCD are compared with EFGH)
• Inverter (input A)
Outputs are labeled with the gate names. The CONTROL pin
enables and disables the outputs. Note that very little of the
PA7024 is utilized with this example. In fact all 20 buried nodes
(with registers), 4 1/0 pins, and 1 input/clock pin, are still available for use.

c:::J

oo§,,§.,
o o §.. § ..
0 0 § .. § ..
0 0 § .. § ..

DODO
Figure 6-3, PLACE pin block diagram of GATES1 .PSF

MODE:t•O MIJDE2=0

Figure 6-4, Logic schematic of GATES1 .PSF
ICT, Inc.
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6.0 PLACE Application Examples

6.4 REG1 .PSF - PA7024
This design is one of four main applications that were integrated into a single PA7024 in the DEM01 A application example. Basic registers and latches include:
• D, T and JK flip-flops with clock, preset and reset
• SR-latch for de bouncing inputs (SR1)
• Gated-latch (LAT1)
• Basic storage register (REG1)
• 2-bit state machine (S0,51)
• 4-bit shift register (SHF0-3)
In the original DEM01A application these registers and latches
were buried. In this application both the buried path and a direct
path have been provided where applicable. The CONTROL
input enables and disables all outputs with the exception of the
D,T and JK flip-flops.

c:::J

d!.€1~DD
Tl

JICI

ef.. ef..D D
REBID D

O
•TI

lit

DD
SHF2

BHF3

Cf. Cf. Cf.. ~..

Figure 6-5, PLACE pin block diagram of REG1 .PSF

Figure 6-6, Logic schematic of REG1 .PSF
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6.5 Bl PORT.PSF - PA7024

6.5 Bl_PORT.PSF - PA7024
This application example is one of four main applications integrated into a single PA7024 in the DEM01A example. The
bi-directional port application has two eight bit 1/0 ports
grouped as A-H and 1-P inputs. The data flow direction of the
port is controlled by the CONTROL input. When CONTROL=1,
then A-H are inputs and 1-P are outputs. When CONTROL=O,
1-P are inputs and A-H are outputs. The 1-P inputs utilize the
transparent input latches which are clocked by the IN_CLK
input. Using the many features of the PA7024 there are many
alternate ways to design bi-directional 1/0 ports or dual port
interfaces. Note that this application does not use any of the 20
buried nodes or registers, leaving much of the internal PA7024
logic free for use.

Figure 6-7, PLACE pin block diagram of Bl_PORT.PSF

MODEl..1 MODE2-1

Figure 6-8, Logic schematic of Bl_PORT.PSF

ICT, Inc.
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6.6 COUNTER1.PSF - PA7024

6.6 COUNTER1 .PSF - PA7024
This design is one of four main applications that were integrated into a single PA7024 in the DEM01 A application example. The 8-bit down counter includes preset (A), reset (D)
hold (8) and an output enable (Control). The original counter
design in DEM01 A is fully buried from 1/0 pins. In this application both the buried and direct output paths have been
provided. Please note that this application uses only a portion
of the PA7024. In fact up to a 20-bit buried counter can be
implemented.
In addition to the 8-bit counter, a divide-by-2 clock design is
also included in the COUNTER1 .PSF design file.

c:::::J
-rb. ~ ~

0

t!3-23 Lf21 L_t1?

0 0
0 0
0 0

ff,.cr..
~~

LI- LI-••
10

~~

LI-•• LI-··

DODO

Figure 6-9, PLACE pin block diagram of COUNTER1 .PSF

8-blt
Down
Counter
Hold

y

K

Figure 6-10, 8-Bit counter logic schematic of COUNTER1 .PSF
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D

c
t-----iHALF CLK

MDDEl--~

0

SYS CLK

>------------'

Figure 6-11, Logic schematic of a divide-by-2 clock design in
COUNTER1 .PSF

ICT, Inc.

6-9

6.7 TIMER.PSF - PA7024

6.0 PLACE Application Examples

6.7 TIMER.PSF - PA7024
This application uses the PA7024 to implement a 16-bit
programmable clock-generator/interrupt-timer that can be interfaced to a 16-bit microprocessor bus. The CLK input can
operate over 50MHz (five times that of conventional programmable counter/timer ICs). A buried 16-bit reloadable down
counter is used to divide the high speed input clock.
Upon power-up the counter is disabled. To program the counter,
a value must be written into a 16-bit count register from the
DO-D15 1/0 pins and the counter must be enabled (see Table
6-2 for control). The value in the count register will be loaded
into the counter which will count down to 0000 Hex. After
reaching 0000 Hex, it will automatically reload the value from
the count register. This allows the counter to be free running for
clock generation if the value in the count register is maintained.
Note that the "register-type change" feature of the PA7024
global cell is used to dynamically switch the T registers to
D registers for loading when the counter reaches the count
0000 Hex.
If the count register is changed, the new count will be loaded
after the count reaches 0000 Hex. One-shot operation for timer
controlled interrupts can be implemented by setting the count
register to 0000 Hex after the count has been loaded. When
this is done, the counter will stop and hold at 0000 Hex.
The OUT pin will toggle (initially low then high and so on) each
time the counter reaches 0000 Hex. The counter and OUT pin
can be reset, disabled or enabled via a bus command (see
table). The count can be read "on the fly" via the DO-D15 pins.
The count is temporarily held stable until the read is completed.

/CS

/RD

1
0
0
0
0

x
1
0
1
0

/AO

Function.

x

x

0
1
0
1

0
0
1
1

Not selected (Don't Care)
Write Count Register from D0-015
Read Count Register onto DO-D15
Reset/Stop Counter and OUT
Enable and Read Counter onto DO-D15

/WR

Table 6-2, Command table for TIMER.PSF
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!CS

c=i

IRO

DD

II.JR

00

©!&:

OL

~~~~3

02

t!;;I-" t!:;l-s t!:;l-1" t!:;l- •s
~~~ 0 M.r
t!;;l-d t!:;l-1• t!:;1-1cs t!:;l-a

03

01

Mi3~~1~6

015

t!:;I-? t!:;l-11 t!:;l-1? t!:;l-21

06
07
6nd

Figure 6-12, PLACE pin block diagram of TIMER.PSF

AO

/!ID

- - - - M CONlROL
LOGIC

/Yfl-----

/ c s - - - -..

Figure 6-13, Logic schematic of TIMER.PSF

ICT, Inc.
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6.8 JACK7024.PSF- PA7024

6.8 JACK7024.PSF - PA7024
This design example is based on C.R. Clare's design in Designing Logic Systems Using State Machines (McGraw Hill, 1972).
The blackjack machine plays the dealer's hand, using typical
dealer strategies to decide whether to draw another card (hit)
or stand after each round.
The example contains the following logic designs:
A state machine that controls the game logic which includes:
- checking the status of the card reader.
- making the decision of what action to take for a hit,
stand or a bust. An example is to draw a card if the hit
signal is true.
- making the decision of when to use the value 1 or 11 for
an ace card.
A Multiplexer/Comparator which compares the point total
and sends the hit, stand or bust signal to the state
machine. If the point total is greater than 21, it's a bust. If
it is equal or less than 16, then hit else stand.
A 5-Bit Adder that adds the value of the drawn card.
• A Binary-to-BCD converter for converting the 5-bit binary
score and converts it to 2-digit BCD for the digital display.
This design example can also be implemented by using three
PLDs which include a PAL22V1 o for the Multiplexer, Comparator and Adder, a PAL 16L8 for the Binary-to-BCD converter,
and a PAL 16R6 for the state machine.

c:::::J
Ci

SI

Ba.§ .. ~.. "

ff a. § .. df,. "

....
e:r.a. o ~.
Cl2

C2

92

Ql

Cl

S3

er.a.a~
ae

·D

ACE

"

91

~.. ~..

Figure 6-14, PLACE pin block diagram of JACK7024.PSF

6-12

ICT, Inc.

6.0 PLACE Application Examples

6.8 JACK7024.PSF - PA7024

LCC Q0-02

Hit

\{0-3]

State

-

Machine

IDE.

Garn•

I

Contrallr

-

-·
Conl

22

-·
Conl

CLR

CLR

II

!l[G-4]

+10
-10

Adder
Ccny...Jn c:(o-4]

~~~~~~...-"9-(.JCLR

Figure 6-15, Logic block diagram of JACK7024.PSF

ICT, Inc.
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6.9 TC7140.PSF - PA7140

6.9 TC7140.PSF • PA 7140
CLK
RESET
SELECT

DI
DI
D2
D3
D1
DB

D•
D7

Cl
C2
II
II
13
11
8nd

Figure 6-16, PLACE pin block diagram of TC7140.PSF
This example uses a PA7140 device to implement a
timer/counter application which is typically used in a
microprocessor-based computer system. As shown in Figure
6-17, the circuit employs a multiplexer to allow either the imcoming or latched data to be loaded into the counter. The
desired data is then loaded into the counter either by reseting
the counter and the compare register, or by a match between
the counter's state and the value in the compare register.
LCC PO-P7

1[0-7]

0[0-7]

D[0-7]

IOC C1 and C2

PLOAD
SELECT
CLK
RESET
B

RLOAD
LCC RO-R7

Figure 6-17, Logic block diagram of TC7140.PSF
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6.10 ST7128.PSF - PA7128

6.10 ST7128.PSF - PA7128
This example implements a 8-bit counter and a 4-bit state
machine. The LCCs were allocated for the counter (QO - 07)
application. To illustrate the flexibility of the PA7128 1/0 Cell
(IOC), the state machine (AO to A3) was implemented by using
the buried feedback paths of the IOCs.

CLK2

CL.Kl
RE

A3

10

A2

D

11
12

QO

Q3

Al
Q6

D1 D1 D1 o-1
D1 D1 D1 o-1
D1 D1 D1 o-1

13

Q1

vcc
14

Q2

15
16

Q4

Q7

Q5

AO
07
06
GND
05
04

17

03

LOAD

02

SELECT

00

01

Figure 6-18, Pin block diagram of ST7128.PSF
SELECT
CLK1
1[0-7]

Comb

IOC AO-A3...__.._,..._.,-+-...i Logic

RE
CLK2

8-Bit
...__ _ _ _..,_..icounter~-..11

LCCQ0-07

~-------<111R

Figure 6-19, Logic block diagram of ST7128.PSF

ICT, Inc.
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6.11 V8GATES.PSF- PEEL18CV8

6.11 VBGATES.PSF - PEEL 18CV8
This PEEL 18CV8 application example implements several
basic logic gates. The logic gates include:
• an inverter
• four-input AND, OR, NANO, and NOR gates
• a four-input AND-OR- INVERT gate
• a two- input XOR gate
• a high-impedance buffer.
Each gate uses one or more of the (A,B,C and D) inputs.
Additionally, the high-impedance buffer uses the /HZ input for
impedance control. The truth table for these gates can be
examined in the test vectors. Note, the remaining unused input
pins can be used as additional inputs into the gates.

Figure 6-20, PLACE pin block diagram of VSGATES.PSF

AND
NANO
OR

NOR
D

AOI

/OE--------'
Figure 6-21, Logic schematic of VBGATES.PSF
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6.12 VSREGS - PEEL18CV8

6.12 VSREGS - PEEL18CV8
This application example demonstrates the implementation of
several basic registers and latches within a PEEL 18CV8. Four
register types included are the D, T, JK, and SR, all of which are
clocked by the CLK input. All registers can be synchronously
reset, set.and asynchronously reset using the SRES, SSET and
ARES inputs respectively. Besides the registers, an SR latch
and a Gated Latch circuit show how independent asynchronous
storage elements can be implemented. Only the Q outputs of
these registers and latches are provided at the output pins. The
IQ outputs could easily be accessed by inverting the macro cell
output polarity. Truth table operation can be referenced via the
test vectors.

AC

-ID-

SP

-®-

Figure 6-22, PLACE pin block diagram of V8REGS.PSF

SRE!)
(s}l'lch. reset)
SSET----+--.
(s}l'lch. set}
ARES----!~

(as}l'lch. rese~----1--1

K---+-1!.__J
R--.4-1

s --f-t---IL_J

Q_D
(D register)
Q_T
(T register}
Q_JK
(JK register)
Q_SR
(SR register)
Q_SL
(SR latch)

LAT~ Q_GL

(latch in}
LEN
(latch enable)

(Gated latch)

Figure 6-23, Logic schematic of V8REGS.PSF

ICT, Inc.
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6.13 VSCLKADD.PSF- PEEL18CV8

6.13 V8CLKADD.PSF - PEEL 18CV8
This application uses the PEEL 18CV8 for 'two common
microprocessor system functions: a clock divider and a memory
mapped address decoder. The clock divider provides a +2, +4
and +8 clock outputs. The SET input sets all clock outputs high.
The address decoder decodes the processor address lines to
select one of five memory or 1/0 devices. The chip select for
these devices are active low. The memory map over a 64K
boundary is shown below.
Memory Map for Address Decoder
Function
Address
EPROM (32K X 8)
8000-FFFF Hex
EEPROM ( 2K X 8)
5000-5FFF Hex
UART
4100-41 FF Hex
PORT
4000-40FF Hex
SAAM ( 8K X 8)
0000-1 FFF Hex

AC

-ID-

SP

-ID-

Figure 6-24, PLACE pin block diagram of V8CLKADD.PSF
SET

...L
SP

CLOCK
DIVIDE

CLK

8

A8-A15

I

....
,..

ADDRESS
DECODE

CLK2 (+ 2)
CLK4 (+ 4)
CLK8 (+ 8)
EPROM
EE PROM
UART
PORT
SRAM

Figure 6-25, Block diagram of V8CLKADD.PSF
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6.14 V8BUSMUX.PSF - PEEL 18CV8

6.14 V8BUSMUX.PSF - PEEL 18CV8
This application implements an 8 to 1 multiplexer that can be
interfaced to a µP bus. Any one of the 8 inputs (10-7) can be
selectively routed to the output (OUT) by writing (/WR and /CS
=0) a 3-bit binary value to the data inputs (DI0-2). The value is
stored into a 3-bit latch that controls the multiplexer selection.
Because the latch utilizes internal asynchronous feedback
(configuration #8 of the macro cell), the value can also be
enabled onto the data outputs D0[0-2]. The DI and D0[0-2]
pins should be tied together for write/read bus operation.

SP

-ID-

Figure 6-26, PLACE pin block diagram of V8BUSMUX.PSF
0

8 Mux. Inputs

Mux. Output

0

PEEL18CV8

cs

000-2 010-2

MICROPROCESSOR

Figure 6-27, Logic schematic of V8BUSMUX.PSF

ICT, Inc.
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6.15 VSFCNTR.PSF - PEEL 18CV8
This application uses the PEEL 18CV8 as an 8 bit counter with
four control functions: hold, reset, repeat and output enable.
The Synchronous Preset term was utilized to free-up a product
term from the eighth bit of the counter. This allows the hold
function to be implemented.
• SRES (Synchronous Reset): When SRES is set High, the
outputs (Q0-7) will go Low after the next clock. When
SRES is Low, the counter will start counting up with each
clock.
• HOLD (Hold Count): When HOLD is set High the count
will hold the present state. When HOLD is Low the
counter will resume.
• REP (Repeat Count): When REP is set High, the counter
repeats the count after reaching FF Hex. When REP is
Low, the counter will stop after one complete count.
• OE (Output Enable): When OE is High, the outputs are
disabled (High-Z). When Low, the outputs are enabled.
• (TEST): This input is used to preload the registers to
simplify test vector operation.

Figure 6-28, PLACE pin block diagram of V8FCNTR.PSF
CLOCK
(TEST)
HOLD
SYNC. RESET
REPEAT COUNT
OUTPUT ENABLE

Figure 6-29, Block diagram of VBFCNTR.PSF
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6.16 VBCPORT.PSF - PEEL 18CV8

6.16 VSCPORT.PSF - PEEL 18CV8
This application uses the PEEL 18CV8 as an 8-bit input port of
which 4 of its inputs can detect a change-of-state. When
detected, the INTR output is set for interrupting a CPU. The
state change is latched by four pseudo-buried registers which
can be read by the CPU on 00-03 as listed in the address table
below. Once read, unless another change has occurred, the
INTR will be reset. The 04 output can be used for status polling
of any remaining state change. The 14-7 inputs do not detect
state changes but can be read as a standard input port.
Address
AO CS RD
X
1
X
X
X
1
O
O
O
1
0
0

Data Outputs D[0-4]
D0-3
04
Hi-Z
Hi-Z
Hi-Z
Hi-Z
Read 10-13 Change 10-13 Pending Change Status
Read 14-17 Inputs
Don't care

AC

--{8)-

SP

--©--

Figure 6-30, PLACE pin block diagram of V8CPORT.PSF

ICT, Inc.
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STANDARD CHANGE-OF-STATE
INPUTS
INPUTS

7 6 5 4

3 2 1 0

PEEL 18CV8

CLK

INTR
AO D0-4 RD

cs

INTR
MICROPROCESSOR

ADDRESS
DECODE

...

..~

DATA BUS
...................
~
ADDRESS BUS

Figure 6-31, System interface block diagram of V8CPORT.PSF

STANDARD
INPUTS 14-7

QUAD
SELECT

4

2:1

D0-3

MUX

CHANGEOF-STATE 10-3
INPUTS

RD

cs

AO

Figure 6-32, Logic schematic of V8CPORT.PSF
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6.17 VSSYNC.PSF - PEEL 18CV8

6.17 V8SYNC.PSF - PEEL 18CV8
Digital systems often require synchronization of asynchronous
inputs to avoid the potential metastability problems caused by
set-up time violation. A common synchronization method uses
two rippled 74LS74-type flip-flops (Figure 6-33).

-----~ootD

Asynchronous
Input

t

Q11--------.i D

Synchronize cl
Input
Q21------

t
SysteM clock

Q2

Figure 6-33, A common synchronizer circuit
In this PLACE design example, the PEEL 18CV8 utilizes the
macro cell configuration #6 (configuration #5 can also be used
instead) to implement eight synchronizer circuits as shown in
Figure 6-34. In each synchronizer circuit, the gated-latch internally latches the asynchronous input on the falling edge of the
clock, generating the signal 01. AN Ding the input 01 through
the internal feedback path eliminates a possible hazard condition during the clock's High-to-Low transition time. The latch
then holds 01 stable to ensure meeting the set-up time requirement of the subsequent D flip-flop which, as before, registers
the signal on the next rising edge of the system clock edge. If
by chance the input pulse width violates the set-up time of the
gated-latch, the clock's Low time will give more time for settling.

ICT, Inc.
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Synchronized
Input

D

Asynchronous
Input

Q21-----

SysteM clock
SysteM clock
Asynchronous
input
QI
Q2

Figure 6-34, Synchronizer circuit in V8SYNC.PSF design

CLK
[l

llC

--[8)-

Uoo
SYNC1

[2

S'r'NC2

[3

S\'NC3

H

S'r'NC-+

[5

S'l'NC5

[6

S\'NC6

[7

SYNC7

[8
6nd

BP

--[D-

S'r'NCB

RESET

Figure 6-35, PLACE pin block diagram of V8SYNC.PSF
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6.18 PRl173.PSF- PEEL173

6.18 PRl173.PSF - PEEL 173
This PEEL 173 application implements a 16 to 4 priority encoder
with high-impedance outputs. If any DO-DF input goes low, the
GS (group strobe) output will go high and the binary value of
the highest priority input will be placed on the EO-E3 (Encoded)
outputs when enabled by OE (output enable). The DO input is
highest priority and DF lowest. When the EO-E3 outputs are
disabled (a function of OE or !GS) they assume a high-impedance state. This makes it possible to interface the encoded
outputs onto a system bus where GS might serve as an interrupt line to a uP and OE as the chip select. The high-impedance
control also allows multiple PEEL 173 priority encoders to be
bussed together for creating wider (32, 48 or 64 bit etc.) priority
encoders. To add additional encoders, the highest priority OE
must be tied low, and the GS must control the next highest
priority OE. The multiple GS can be further encoded to identify
which device is driving the EO-E3 lines.

Figure 6-36, PLACE pin block diagram of PRl173.PSF

16

DO-DF--~ 16 TO 4 - - - G S

/OE---..

PRIORITY
ENCODER

(group strobe)
4
EO-E3
(encoded output)

Figure 6-37, Block diagram of PRl173.PSF
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6.19 V1 OCNT8.PSF - PEEL22CV1 OZ
This application uses the PEEL22CV1 O as an 8-bit Up/Down
Loadable counter. The four controls are:
• CLR (Synchronous Clear)-When CLR is set to High, all
outputs (07-00 and CO_BI) will be set to Low on next
clock.
• UP (Up/Down control)-When UP is set to High, outputs
07-00 will count up on each clock. When UP is set to
Low, outputs 07-00 will count down.
• LOAD (Load data)-When LOAD is set High, outputs 0700 will follow the data of D7-DO on next clock and the
output CO_BI will be set to Low.
• !OE (Output Enable)-When OE is set to High, all outputs
(07-00 and CO_BI) will be High Impedance. When OE is
set Low, all outputs will be enabled.
Note: After counting up 255, the count will go to O and the
CO_BI will be set High on next clock. The High will remain on
the CO_BI pin until LOAD or CLR goes High.

Operation Table
CLK CLR UP LOAD !OE

c
c
c
c
c
c
x

1
0
0
0
0
0

x

x

x

1
1
0
0

0
0
0
0
1

x
x

x

0
0
0
0
0
0
1

D[7-0]

0[7-0)

x
x
x
x
x

LOW
Count up
255-0
Count down
0- 255
DATA IN
3-STATE

DATA IN

x

CO Bl
0
0
1 carry-out
0
1 borrow-in
0
0

Figure 6-38, PLACE pin block diagram of V1 OCNT8.PSF
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CLK
l>
8..L ........
81 .....
DO-D7 7 -,..
8-BIT
-,.. Q0-07
7
UP/DOWN
CLR
COUNTER
CO Bl
LOAD
(car ry-out/borrow-in)
/OE
Figure 6-39, Block diagram of V1 OCNT8.PSF
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6.20 PARV1 OA.PSF - PEEL22CV1 OA

6.20 PARV1 OA.PSF - PEEL22CV1 OA
This application uses the PEEL22CV1 OA as a 9-bit even/odd
parity generator/checker.

Operation Table
Number of high
inputs A- H
Even
Odd
Even
Odd
Even
Odd
Even
Odd

Parity_!

Even_Odd

Parity_O

I

I

1.

1
1
0
0
1
1
0
0

0
0
0
0
1
1
1
1

I

H
L
L
H
L
H
H
L

The parity function is commonly implemented via the utilization
of the exclusive-OR operation. To build a N-bit parity generator/checker, the number of 2-input exclusive-OR gates required is N-1. A N-bit parity function can also be implemented
via the AND-OR logic operation but it requires 2N- 1 product
terms. For instance, a 9-bit parity function will require 256
product terms. Though the PEEL22CV1 OA device has only 132
product terms, a 9-bit parity function can still be implemented
by using two macro cells to implement two 4-bit parity generators. Then, both the outputs of the macro cells are fed back
and XORed with the 9th bit (Parity_ln). With this method, there
is an additional delay due to the feedback of the 4-bit parity
generator outputs. If it is implemented in the PEEL22CV1 OA
device, then the delay would be about 3 ns less than if it was
implemented in a standard 22V10 device. This is because the
outputs in the 22V1 O device are fed back from the pin, whereas
in the PEEL22CV1 OA the outputs can be configured to feedback directly from the OR gate (before the output buffer).

Figure 6-40, PLACE pin block diagram of PARV1 OA.PSF
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6.21 V10ZPORT.PSF - PEEL22CV10Z

6.21 V1 OZPORT.PSF - PEEL22CV1 OZ
This application uses the PEEL22CV1 OZ as an 8-bit input port
of which all of its inputs can detect a change-of-state. When
detected, the INTR output is set for interrupting a CPU. The
state change is latched by eight pseudo-buried registers which
can be read by the CPU on 00-07 as listed in the address table
below. Once read, unless another change has occurred, the
INTR will be reset. The NEQ output can be used for status
polling of any remaining state change. To reduce the average
power consumption, the ZERO-POWER mode is used.

Address
AO
X
X
O

CS
1
X
O

Data Outputs
RD
X
1
O

NEQ
Hi-Z
Hi-Z
10-17 Pending Change Status

D0-7
Hi-Z
Hi-Z
Read 10-17 Change

Figure 6-41, PLACE pin block diagram of V10ZPORT.PSF
CHANGE-OF-STAlE
INPUTS

76543210

INTR
MICROPROCESSOR

Figure 6-42, System interface block diagram of V10ZPORT.PSF
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6.21 V10ZPORT.PSF - PEEL22CV10Z

PEEL22CV1 OZ

i--.----NEQ

--.i-=:::.J
RD

cs

AO

Figure 6-43, Logic schematic of V10ZPORT.PSF
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